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About
1 About

1.1 This Manual
User and Service

This manual is planned for use by the service engineer in the installation of the device or acces-
sory, and for the user in performing existing experiments and for the setup of new experiments.

This manual is an integral part of the device, and must be kept in close proximity to the device
where it is permanently accessible to personnel. In addition, instructions concerning labor pro-
tection laws, operator regulations tools and supplies must be available and adhered to.

Before starting any work, personnel must read the manual thoroughly and understood its
contents. Compliance with all specified safety and operating instructions, as well as local acci-
dent prevention regulations, are vital to ensure safe operation.

The figures shown in this manual are designed to be general and informative and may not rep-
resent the specific Bruker model, component or software/firmware version you are working with.
Options and accessories may or may not be illustrated in each figure.

1.2 Policy Statement

It is the policy of Bruker to improve products as new techniques and components become avail-
able. Bruker reserves the right to change specifications at any time. 

Every effort has been made to avoid errors in text and figure presentation in this publication. In
order to produce useful and appropriate documentation, we welcome your comments on this
publication. Support engineers are advised to regularly check with Bruker for updated informa-
tion.

Bruker is committed to providing customers with inventive, high quality products and services
that are environmentally sound.

1.3 Symbols and Conventions

Safety instructions in this manual are marked with symbols. The safety instructions are intro-
duced using indicative words which express the extent of the hazard.

In order to avoid accidents, personal injury or damage to property, always observe safety in-
structions and proceed with care.
Danger

DANGER

Danger indicates a hazardous situation which, if not avoided, will result in
death or serious injury.

This is the consequence of not following the warning.

 This is the safety condition.

1. This is the safety instruction.
Z33075_00_001 9
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Warning

Caution

Notice

Note

WARNING

Warning indicates a hazardous situation, which, if not avoided, could result in
death or serious injury.

This is the consequence of not following the warning.

 This is the safety condition.

1. This is the safety instruction.

CAUTION

Warning indicates a hazardous situation, which, if not avoided, may result in
minor or moderate injury.

This is the consequence of not following the warning.

 This is the safety condition.

1. This is the safety instruction.

NOTICE

NOTICE indicates a property damage message.

This is the consequence of not following the notice.

 This is a safety condition.

1. This is a safety instruction.

This symbol highlights useful tips and recommendations as well as information
designed to ensure efficient and smooth operation.
10 Z33075_00_001
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2 Introduction

2.1 Concept

This manual is planned for use by the engineer in the installation of the imaging accessory, and
for the user in performing existing experiments and for the setup of new experiments.

Due to the similarity of the imaging and diffusion hard and software, this manual overlaps the
AVANCE diffusion manual in parts. Therefore the reference to “diffusion” will appear, but can be
used interchangeably with “imaging”.

2.2 Limitation of Liability

All specifications and instructions in this manual have been compiled taking account of applica-
ble standards and regulations, the current state of technology and the experience and insights
we have gained over the years.

The manufacturer accepts no liability for damage due to:

▪ Failure to observe this manual.

▪ Improper use.

▪ Deployment of untrained personnel.

▪ Unauthorized modifications.

▪ Technical modifications.

▪ Use of unauthorized spare parts.

The actual scope of supply may differ from the explanations and depictions in this manual in the
case of special designs, take-up of additional ordering options, or as a result of the latest tech-
nical modifications.

The undertakings agreed in the supply contract, as well as the manufacturer's Terms and Con-
ditions and Terms of Delivery, and the legal regulations applicable at the time of the conclusion
of the contract shall apply.

2.3 Copyright

This manual is protected by copyright and intended solely for internal use.

This manual must not be made available to third parties, duplicated in any manner or form –
whether in whole or in part – and the content must not be used and/or communicated, except
for internal purposes, without the written consent of the manufacturer.

Violation of the copyright will result in legal action for damages. We reserve the right to assert
further claims.

This manual is a work in progress, and may not reflect the actual stand, as new developments
and applications are expanding rapidly.
Z33075_00_001 11



Introduction
2.4 Warranty Terms

The warranty terms are included in the manufacturer's Terms and Conditions.

2.5 Customer Service

Our customer service division is available to provide technical information. See the chapter Con-
tact for contact information.

In addition, our employees are always interested in acquiring new information and experience
gained from practical application; such information and experience may help improve our prod-
ucts.
12 Z33075_00_001



Safety
3 Safety

This section provides an overview of all the main safety aspects involved in ensuring optimal
personnel protection and safe and smooth operation.

Non-compliance with the action guidelines and safety instructions contained in this manual may
result in serious hazards.

3.1 General

The micro-imaging Accessory for AVANCE III (AV3) systems is made up of a variety of products.
Refer to the corresponding product manuals for safety issues concerning the safe use of these
products. Where deemed appropriate, additional safety notices have been added within this
manual to draw attention to important safety issues.

Note: "Device" is used interchangeable to refer to the micro-imaging accessory as a whole, or
to individual components, based on the context of the subjects discussed throughout this man-
ual.

3.2 Intended Use

The imaging accessory should only be used for its intended purpose as described in this man-
ual. Use of the unit for any purpose other than that for which it is intended is taken only at the
users own risk and invalidates any and all manufacturer warranties.

Service or maintenance work on the diffusion accessory must be carried out by qualified per-
sonnel.

Only those persons schooled in the operation of the diffusion accessory should operate the unit.

Read this manual before operating the unit. Pay particular attention to any safety related infor-
mation.

3.3 Owner's Responsibility

Owner

The term 'owner' refers to the person who himself operates the device for trade or commercial
purposes, or who surrenders the device to a third party for use/application, and who bears the
legal product liability for protecting the user, the personnel or third parties during the operation.

Owner‘s Obligations

The device is used in the industrial sector, universities and research laboratories. The owner of
the device must therefore comply with statutory occupational safety requirements.

In addition to the safety instructions in this manual, the safety, accident prevention and environ-
mental protection regulations governing the operating area of the device must be observed.

In this regard, the following requirements should be particularly observed:
Z33075_00_001 13
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▪ The owner must obtain information about the applicable occupational safety regulations,
and - in the context of a risk assessment - must determine any additional dangers resulting
from the specific working conditions at the usage location of the device. The owner must
then implement this information in a set of operating instructions governing operation of the
device.

▪ During the complete operating time of the device, the owner must assess whether the oper-
ating instructions issued comply with the current status of regulations, and must update the
operating instructions if necessary.

▪ The owner must clearly lay down and specify responsibilities with respect to installation, op-
eration, troubleshooting, maintenance and cleaning.

▪ The owner must ensure that all personnel dealing with the device have read and understood
this manual. In addition, the owner must provide personnel with training and hazards infor-
mation at regular intervals.

▪ The owner must provide the personnel with the necessary protective equipment.

▪ The owner must warrant that the device is operated by trained and authorised personnel as
well as all other work, such as transportation, mounting, start-up, the installation, mainte-
nance, cleaning, service, repair and shutdown, that is carried out on the device.

▪ All personnel who work with, or in the close proximity of the device, need to be informed of
all safety issues and emergency procedures as outlined in this user manual.

▪ The owner must document the information about all safety issues and emergency proce-
dures in a laboratory SOP (Standard Operating Procedure). Routine briefings and briefings
for new personnel must take place.

▪ The owner must ensure that new personnel are supervised by experienced personnel. It is
highly recommended to implement a company training program for new personnel on all as-
pects of product safety and operation.

▪ The owner must ensure that personnel are regularly informed of the potential hazards within
the laboratory. This is all personnel that work in the area, but in particular laboratory person-
nel and external personnel such as cleaning and service personnel.

▪ The owner is responsible for taking measures to avoid inherent risks in the handling of dan-
gerous substances, preventing industrial disease, and providing medical first aid in emer-
gencies.

▪ The owner is responsible for providing facilities according to the local regulations for the pre-
vention of industrial accidents and generally accepted safety regulations according to the
rules of occupational medicine.

▪ All substances needed for operating and cleaning the device samples, solvents, cleaning
agents, gases, etc. have to be handled with care and disposed of appropriately. All hints and
warnings on storage containers must be read and adhered to.

▪ The owner must ensure that the work area is sufficiently illuminated to avoid reading errors
and faulty operation.

▪ The owner must ensure that the laboratory is equipped with an oxygen warning device, in
case the device is operated with nitrogen.

Furthermore, the owner is responsible for ensuring that the device is always in a technically
faultless condition. Therefore, the following applies:

▪ The owner must ensure that the maintenance intervals described in this manual are ob-
served.

▪ The owner must ensure that all safety devices are regularly checked to ensure full function-
ality and completeness.
14 Z33075_00_001
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3.4 Personnel Requirements

Note: Only Trained Bruker Personnel 

3.4.1 Qualifications

This manual specifies the personnel qualifications required for the different areas of work, listed
below:

Laboratory Personnel

Laboratory personnel are health care professionals, technicians, and assistants staffing a re-
search or health care facility where specimens are grown, tested, or evaluated and the results
of such measures are recorded. Laboratory personnel are able to carry out assigned work and
to recognize and prevent possible dangers self-reliant due to their professional training, knowl-
edge and experience as well as profound knowledge of applicable regulations.

The workforce must only consist of persons who can be expected to carry out their work reliably.
Persons with impaired reactions due to, for example, the consumption of drugs, alcohol, or med-
ication are prohibited from carrying out work on the device.

When selecting personnel, the age-related and occupation-related regulations governing the
usage location must be observed.

3.4.2 Unauthorized Persons
Warning: Risk to Life for Unauthorized Personnel due to Hazards in the Danger and Working Zone!

3.4.3 Instruction

Personnel must receive regular instruction from the owner. The instruction must be documented
to facilitate improved verification.

Only trained Bruker personnel are allowed to mount, retrofit, repair, adjust and dismantle the
unit!

WARNING

Risk to life for unauthorized personnel due to hazards in the danger and work-
ing zone!

Unauthorized personnel who do not meet the requirements described in this manual will not
be familiar with the dangers in the working zone. Therefore, unauthorized persons face the
risk of serious injury or death.

1. Unauthorized persons must be kept away from the danger and working zone.

2. If in doubt, address the persons in question and ask them to leave the danger and working
zone.

3. Cease work while unauthorized persons are in the danger and working zone.
Z33075_00_001 15
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3.5 Personal Protective Equipment

Personal protective equipment is used to protect the personnel from dangers which could affect
their safety or health while working.

Personnel must wear personal protective equipment while carrying out the different operations
at and with the device.

This equipment will be defined by the head of the laboratory. Always comply with the instructions
governing personal protective equipment posted in the work area.

3.6 Basic Dangers

The following section specifies residual risks which may result from using the device and have
been established by means of a risk assessment. 

In order to minimize health hazards and avoid dangerous situations, follow the safety instruc-
tions specified here as well as in the following chapters of this manual.

3.6.1 General Workplace Dangers
Warning: Danger to Life from Nonfunctional Safety Devices

Caution: Tripping over Dirt and Scattered Objects

Date Name Type of Instruc-
tion

Instruction Pro-
vided By

Signature

WARNING

Danger to life from nonfunctional safety devices!

If safety devices are not functioning or are disabled, there is a danger of serious injury or
death.

1. Check that all safety devices are fully functional and correctly installed before starting
work.

2. Never disable or bypass safety devices.

3. Ensure that all safety devices are always accessible.

CAUTION

Danger of injury from tripping over dirt and scattered objects!

Dirt and scattered objects may cause people to slip or trip, resulting in personal injuries.

1. Always keep the work area clean.

2. Remove objects which are no longer required from the work area and particularly from the
floor.

3. Indicate unavoidable hazards using marking tape.
16 Z33075_00_001
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3.6.2 Dangers from Magnetic Fields
Warning: Danger to Life from Strong Magnetic Fields

Note: The Magnetic Field of the Device does not Cause any Personal Injuries

3.7 Signage

The following symbols and information signs can be found in the work area. They refer to their
immediate surroundings.

Electrical Voltage

WARNING

Danger to life from strong magnetic fields!

Strong magnetic fields may cause serious injuries or death and significant damage to proper-
ty.

1. Persons fitted with heart pacemakers must be kept away from the device. The function-
ality of the heart pacemaker could be compromised.

2. Persons with metal implants must be kept away from the device. Implants may heat up or
be subject to magnetic attraction.

3. Ferromagnetic materials and electromagnets must be kept away from the magnetic
source. Such materials could be subject to magnetic attraction and may fly around the
room, injuring or killing people. Minimum distance 3 meters.

4. Remove magnetic items (jewelry, watches, pens etc.) before carrying out maintenance
work.

5. Keep electronic equipment away from the magnetic source. Such equipment could be
damaged.

6. Keep storage media, credit cards etc. away from the magnetic source. Data could be
erased.

The magnetic field of the device does not cause any personal injuries or property damage. For
further information see the manual of the magnet used.

The identification and placement of warning labels are included in the manual. The laboratory
supervisor is responsible for ensuring that all the warning labels are maintained in their proper
place any time that the device is used.

Only qualified electricians are permitted to work in a work 
room marked by this sign. Unauthorized persons must not en-
ter the workplaces thus marked and must not open the 
marked cabinet.
Z33075_00_001 17
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Danger Spot

Warning indicating a danger spot in work rooms.

The warning label may be ordered using Bruker Part Number 
67470.
18 Z33075_00_001



Imaging Rack (HMIMAG)
4 Imaging Rack (HMIMAG)

The AVANCE III compatible micro-imaging system is based on 3 Great gradient amplifiers
(Great1/40 or Great1/60), a Master Unit (BGMUI-E), and optionally a B0 compensation unit (B0-
2). The components are installed in a single bay stainless steel rack, called an imaging rack.

Additionally, all micro-imaging systems are equipped with a so called DPP board (Digital Pre-
emphasis P/N H12513F1 or H12513F2), which modifies the gradient shapes by numerically
adding pre-emphasis terms to compensate for eddy currents. The DPP board is located inside
the IPSO 19” rack, connected to the systems internal PCI bus and to the gradient controller.

4.1 Master Unit BGMUI-E (W1522066)

The Master Unit BGMUI-E is a dedicated unit to interface the Great1/40 or Great1/60 amplifiers
to the AVANCE III system. In addition to the main function of distributing the digital signals to the
Great amplifiers, the Master Unit contains a PT100 temperature and an external enable security
feature. A DSP based feedback structure is implemented which allows calculating the applied
power rate and comparing it with maximum values for coil protection.
Master Unit BGMUI-E Front Panel

Figure 4.1: Master Unit BGMUI-E Front Panel

The Master Unit must be the last device which is switched on in the imaging rack since it detects
the connected amplifiers only during the boot process. During the boot process, the Master Unit
will stop and display a ‘C01’ message in the 7 segment LED display, whereas in normal opera-
tion mode the LED‘s show the coils PT100 temperature (11). The message ‘C01’ means, that
safety parameters for the coil protection need to be loaded, refer to the section Hardware ON/
OFF Procedures [143] for details about this procedure. This LED display is also used for nu-
merous error messages, which are indicated as ‘Exx’, where xx is an error code that can be
found in the web interface of the unit (accessible by the ‘ha’ command in TopSpin). If the source
for the error message is eliminated, the unit can be reset to normal operation mode by pressing
the red reset button (1).

4.1.1 Master Unit In/Out Data Connection

The Master Unit can be connected to either a DPP (Digital Pre-emphasis board), or directly to
the GCtrl (gradient controller) of the IPSO board via the LVDS (48 bit wide and 80 MHz bus
clock) (5). The maximum allowed cable length for this connection is 5 meters. The internal logic
distributes the incoming digital signals to the desired gradient/B0 output connectors (10), where
the Great amplifiers or B0-2 compensation unit can be directly connected. The communication
between Master Unit and the mentioned amplifiers is via a unidirectional parallel bus for the gra-
dient shape data and a bidirectional I2C bus for the communication between the units.
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The Master Unit can be controlled via the Web interface. Therefore, the unit is connected directly
to the systems Ethernet switch (3) to allow any browser to access the service pages, e.g. for
firmware updates.

4.1.2 Security Features

The Master Unit includes 3 security features: 

▪ A PT100 temperature check,

▪ a check of the external enable signal e.g. from the gradient cooling water chiller,

▪ and a DSP based power calculation.

A PT100 can be connected directly to the PT100 connector (6). If the PT100 shows a resistance
indicating a temperature below 5 °C (101.95Ω) or above 50°C (119.4Ω), the Master Unit will
switch the Great 60 amplifiers off. Temperatures between 5 °C and 50 °C are valid temperatures
for the Great operation. The PT100 is measured in 4-wire mode, to eliminate cable resistances.
This guarantees an accuracy of ±1 °C from the actual value.
Pin Layout of the Pt100 Connector

Figure 4.2: Pin Layout of the Pt100 Connector

The external enable connector (7) is used to check the state of the BCU20 cooling unit. In case
the BCU20 is switched off, or no water is flowing, the BCU20 opens a short between 2 pins. This
is detected at the Master Unit by the external enable connector. If the short is missing, the Mas-
ter Unit switches the Great amplifiers off.
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Pin Layout of the ‘External Enable’ Connector

Figure 4.3: Pin Layout of the ‘External Enable’ Connector

The DSP security feature uses the 6 analog monitor output signals of the Great amplifiers to cal-
culate the power dissipation in the gradient coil on the fly. From each amplifier the current signal
and the voltage signal is feed back to the ‘U mon’ (8) and ‘I mon’ (9) input connectors of the Mas-
ter Unit. A 10V U-monitor voltage corresponds to the max. voltage (100V for Great 1/40 and
Great 1/60). The I-monitor voltage displays the output current; where 10 V corresponds to 60A
(as a result the max. output voltage on a Great 40 is 6.66V at 40A). The analog signal is AD-
converted within a 25 µsec dwell time, and the power applied to each individual gradient coil is
calculated by the formula:
Power Calculation for an Individual Gradient Channel

Figure 4.4: Power Calculation for an Individual Gradient Channel

where Rch is the DC-resistance (stored in the safety parameters in setpre) of the gradient coil,

ich is the current detected by the ‘I-mon’ input and T is the time in which the energy is integrated.

Plimch is the maximum power value, which is specific for each channel of each gradient system.

On triple axis gradient coils, the power sum of all 3 channels must be less than 3 times the max.
power for one channel.
Calculation for the Gradient System (sum of all gradient directions)

Figure 4.5: Calculation for the Gradient System (sum of all gradient directions)
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The Master Unit checks the power on 2 different time bases. One time base is fixed to 1 second,
which checks for the average power applied to the gradient coil. Another time base is configu-
rable between 25 µsec and 1 second and is mandatory for detecting short (msec range) gradient
pulses with high currents, which might burn the coil in less than 1 second. Refer to the section
Typical Gradient-Setpre Parameters [179] for typical values for different coils.

4.1.3 Blanking Pulses

The Master Unit BGMUI-E delivers 3 blanking output signals (4), which can be directly connect-
ed to the gating input of the Great 1/40 and Great 1/60 amplifiers. The blanking pulses are TTL
level, TTL-low (0V), which forces the amplifiers to switch on (unblank) its output, and TTL-high
(5V) which disables (blank) the amplifiers output.

The blanking output of the BGMUI-E is so called ‘soft-blanking’. In contrast to the ‘hard-blanking’
which was used in previous imaging systems, the ‘soft-blanking’ takes care of residual amplifier
output currents. The blanking is switched off by a command in the pulse program (refer to Gra-
dient Amplifier Blanking Modes [123]), and stays off until a second command is executed in the
pulse program and until the digital input signal to the individual Great amplifier is 0. As result,
the blanking takes care of pre-emphasis adjustments and keeps the Great output enabled, until
the added pre-emphasis terms are fully decayed. The previously used ‘hard-blanking’ switches
off the Great output immediately when the particular command is executed in the pulse program
without taking care of any residual currents.

4.1.4 Control LEDs 

The Master Unit has 3 LED groups (12, 13, 14), which show the status of the connected ampli-
fiers. If an “Error” LED is illuminated, the connected amplifier is switched off due to an error or
because it is not initialized. If the amplifiers are fully operable, the “Enable” LED is switched on.
If an amplifier delivers a current, the “Pulse”-LED shows this by flickering. The pulse LED is only
switched on for currents >3% of the maximum amplifier current, for lower currents the LED re-
mains off. A second mode can be selected in the Master Units web interface which displays dig-
ital input data at the Master Unit LVDS input instead of the amplifier output current. If a B0-2
compensation unit is connected to the Master Unit and the “Field” value of the BSMS-2 is not 0,
the B0 “Enable” LED is always on, since the B0-2 unit has to deliver a DC current.

4.2 Great 1/40 (W1211690 or W1215322) and Great 1/60 (W1209612 
or W1215323)

The Great 1/40 and Great 1/60 are current regulated amplifiers used to provide the gradient cur-
rent to the gradient coils at dedicated times. Both amplifiers are basically identical; the only dif-
ference is the maximum output current, which is 40A for a Great 1/40 and 60A for a Great 1/60.
The signal input of the amplifiers is digital. The digital to analog converter is located inside the
amplifiers to avoid ground loops from non-ideal analog cable wiring.

For AVANCE III systems the following ECL‘s are required:

▪ W1211690 or W1209612: All ECL are supported. The coarse offset needs to be adjusted in
setpre for ECL <= 8; set the coarse offset to 0 for ECL9.

▪ W1215322 or W1215323: ≥ ECL 01 (ECL 0 causes spikes).
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Great Amplifier Front View

Figure 4.6: Great Amplifier Front View

4.2.1 Gate Input: Blanking

The Gate input (1) of the Great amplifiers enables an external signal to enable or disable the
output of the Great amplifier. In case the output is disabled, the amplifier output is disconnected
from the gradient coil, so that no amplifier noise is introduced to the sample spin system. The
gate pulse must be TTL level, where TTL-LOW enables the amplifier output and TTL-HIGH dis-
ables the output. If nothing is connected to this input, the amplifier is always enabled.

The gating pulse is delivered by default from the BGMUI-E Master Unit (output 4 of the Master
Unit) or alternatively from the IPSO T0 connector (see Trigger Signals at the T0 Connector
[149] for the pin numbers).

4.2.2 Data Input

The data input (3) of the Great amplifier is directly connected to the Master Unit. The gradient
data are delivered in a parallel way, whereas the bidirectional communication between the Mas-
ter Unit and the Great amplifier is handled by an I2C bus. Both communication protocols can be
found on the data input connector and are distributed via a single cable (P/N HZ10202).

4.2.3 Signal Output

The gradient coil current is provided at the red and black clamps (2). Typically, the gradient filter
cable with ring cable lugs is connected to the output clamps, which lead to the gradient filter (see
Gradient Filter (W1212109) [28]). The output can have a maximum of ± 100V/± 40A at the
Great 1/40, or ± 100V/± 60A at the Great 1/60.
Z33075_00_001 23



Imaging Rack (HMIMAG)
4.2.4 Monitor Output 

Both Great amplifiers have a monitor output for the output current, labelled “Monitor I” (5) and a
monitor output for the output voltage, labelled “Monitor U”. Both can be used to control the output
current on an oscilloscope, e.g. to adapt the amplifiers regulator to the connected load.

The scaling for the outputs is 1V/10V for the voltage monitor of both Great amplifiers, 1V/4A at
the current monitor output of the Great 1/40, and 1V/6A at the current monitor output of the Great
1/60. The maximum monitor voltage is 10V at each monitor output. If an externally connected
device like an oscilloscope or a voltage meter is not ground free, it can lead to ground loops
which disturb the output stability of the amplifier and thus the NMR signal.

During routine work, these monitor outputs have to be connected to the ‘U mon’ and ‘I mon’ in-
puts of the BGMUI-E Master Unit (see Security Features [20]). Only when this connection is
established, can the Master Unit calculate the power dissipation to the gradient coils and protect
them from a power surge.

4.2.5 LED Bar

The LED bar on the bottom right (6) of the Great amplifier is an easy way to control the output
current during an experiment. The bar shows the output current of the amplifier in 10% steps,
so currents below 10% cannot be seen, but for typical experiments the resolution is sufficient.

4.2.6 Fuses

The Great amplifier itself has 2 different fuses.

▪ Line fuse.

▪ Power supply output fuse.

The line fuse is located directly in the housing of the mains adapter. If this fuse is blown, nothing
will work on the amplifier anymore, even the illumination of the mains switch will be missing. Af-
ter removal of the mains connector, an insert can be pulled out of the mains plug (1 in the figure
below) with the help of a little screwdriver. The fuses are 20 mm x 5 mm in size and have values
of 6.3A (Great 1/40) or 10A (Great 1/60).

If the mains switch illumination is still working but nothing else on the amplifier, the power supply
output fuses may be blown. These fuses are located below or to the right of the mains connector
(depends on the hardware revision, 2 in the figure below). There are 2 separate fuse housings
that can be opened manually or by the help of a screwdriver, which contain 32 mm x 6 mm fuses
in size with a value of 20A.

WARNING

Electrical hazard from electrical shock!

 A life threatening shock may result when the output clamps or the connected cables are
manipulated.

1. Be sure to switch off (7) the amplifier before manipulation the output clamps or the con-
nected cables.
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Back Side View of the Great Amplifier Showing the Location of the Fuses

Figure 4.7: Back Side View of the Great Amplifier Showing the Location of the Fuses

4.3 B0-2 Compensation Unit (W1214106)

The B0-2 compensation unit is the fourth amplifier, which can be connected to the Master Unit.
A B0-2 compensation unit is required to compensate for zero order field distortions resulting
from gradient switching of poorly shielded gradient systems. In this case, a current is introduced
in the surrounding conductive material, which leads to a shift in the B0 field and thus in the be-
havior of the samples spin system. To eliminate these effects, a current which causes an oppo-
site field shift is introduced to the field coil of the shim system. This coil is usually used to control
the field stability (Lock), to shift the field by a static value or the automatic drift compensation.
Front Plate of the B0-2 Compensation Unit

Figure 4.8: Front Plate of the B0-2 Compensation Unit
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4.3.1 Digital Data Input 

The digital data is handled via the connector “To Master Unit B0-2 Comp” (4). The communica-
tion between B0-2 unit and the Master Unit BGMUI-E is via unidirectional parallel bus for the B0
compensation current data and a bidirectional I2C bus for the communication between these
units. The digital input data for the B0 current is already fully calculated including all direct and
cross terms by the DPP. This means, as opposed to the Great gradient amplifiers, that the B0-
2 unit will not work without DPP in the ISPO (if the Master Unit is connected directly to the GCtrl).

4.3.2 Analog Signal Input/Output 

The analog B0 current is provided by the connector “H0 Output” (4). Through this connector the
B0-2 unit is directly connected to the “Field” coil of the BOSS shim system, which is used by the
BSMS to stabilize the magnetic field (Lock), and to shift the field by a static value or for the au-
tomatic drift compensation. Since the BSMS-2 functionality must still be operable, the output sig-
nal from the BSMS-2 (ELCB board) is fed into the B0-2 compensation unit through connector
(4) as well, and added to the B0 compensation terms. The output signal of the B0-2 unit is then
the B0 compensation + BSMS-2 output, which includes all the required signals. Since this is an
active summation by analog devices, the B0-2 unit might introduce a bit of noise to the BSMS-
2 signals.

When the B0-2 compensation unit is switched off, an internal relay is set in a way that the BSMS-
2 signals are passively passed through the unit, without any modification and without any addi-
tional noise or hum.

The maximum output voltage of the B0-2 compensation unit is ± 100V, the maximum output cur-
rent is ± 200 mA.
Pin Layout of the Analog Input/output Connector at the B0-2 Front Plate

Figure 4.9: Pin Layout of the Analog Input/output Connector at the B0-2 Front Plate

4.3.3 Monitor Output 

The analog monitor outputs (3) of the B0-2 unit can be used to check the field coil current since
it shows the sum of the BSMS-2 output current plus the B0 compensation terms. The ratio is 1V/
10V of the voltage monitor and 1V/20 mA on the current monitor. During routine work, these con-
nectors are not connected and it care has to be taken that no grounded devices are connected
to them, since they can create ground loops.
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4.3.4 Link to the BSMS-2 

To connect the B0-2 unit to an existing BSMS-2/BOSS system, an adaptor board (part number
Z108181) is required. This board is mounted on the right most SCB20 board in the BSMS-2 be-
tween the output of the board and the cable leading to the shim system (see the figure below).
It is basically a 1 to 1 connection of the shim connections, but the connection going to the field
coil is cut and wired to the connector on the lower part of the adaptor board.

At this connector, a cable (P/N HZ12200) from the analog signal input/output of the B0-2 unit
has to be connected. This connector provides the ‘Field’ output current of the BSMS-2. This field
current reaches the B0-2 unit via the cable, is summed up with the B0 current or shifted through,
and then returned via the cable to the BSMS-2 adaptor board, where it is directly connected to
the field coil of the BOSS shim system. As a result, when the adapter board is installed, but no
cable to the B02 unit is connected, the lock, field shift and field drift compensation are in active.
BSMS-2 to B0-2 Adaptor Board, Mounted on the Most Right SCB20 Module

Figure 4.10: BSMS-2 to B0-2 Adaptor Board, Mounted on the Most Right SCB20 Module
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4.4 Gradient Filter (W1212109)

The gradient filter is integrated in the gradient cable, which is connected between the Great out-
puts and the gradient coil. Its basic function is to eliminate high frequency distortions, which can
be introduced to the gradient cable itself. Additionally, the filter has some standard car fuses in-
cluded, to protect the gradient coil from any gradient amplifier failure or programmer errors. The
fuses are accessible after removal of a small metal cover, fixed by 4 screws. There are 5 fuses
in the filter box, where only fuse 1, 3, and 5 are in the gradient lines. Fuses 2 and 4 are spare
parts. Each fuse has a value of 15A.
Gradient Filter and Fuses

Figure 4.11: Gradient Filter and Fuses

Since the gradient filter should remove high frequency noise from the gradient cables, ground
conditions are important. The filter must have a good ground connection to the gradient body.
This is established on new gradient bodies, but on older bodies the connection might be missing.
To check this, the probe body can be controlled. There must be a pin in position G of the Burndy
gradient connector, which leads to a ring cable lug checked to the metal of the probe base. If
this connection is missing, it has to be established to provide full shielding performance.
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Location of Pin G at the Probe Base Connector (left) and Grounding of the Pin (right image)

Figure 4.12: Location of Pin G at the Probe Base Connector (left) and Grounding of the Pin (right image)

For AVANCE III systems, filter cables with part number W1212109 and ECL≥2 have to be used.
If a lower ECL or a different filter cable exists, it needs to be upgraded. With filter cables
W1212109/ECL≥2 2-wire and 4-wire gradient probe bodies can be driven by the AVANCE III im-
aging rack.
Pin Layout of the 12 Pin Burndy Connector (front view of the plug at the probe base)

Figure 4.13: Pin Layout of the 12 Pin Burndy Connector (front view of the plug at the probe base)

Burndy Connector Signal

C +X Gradient

D -X Gradient

E +Y Gradient

F -Y Gradient

A +Z Gradient

B -Z Gradient
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4.5 Cooling Unit BCU20 (W1210722)

The standard cooling unit for the water cooled micro-imaging and diffusion gradient systems is
called BCU20. The BCU20 is a closed loop chiller unit, with a water volume of about 3.5 liters,
which can actively heat and cool the water with a power of approximately 250W. Thus the water
temperature can be set to values between 5°C and 50°C, at standard flow rates of up to 1 liter/
minute at 0.35 bar.

In addition to this basic functionality, the BCU20 provides more features such as a 3 way valve
to blow out the water of the gradient before removal, manual and software controlled tempera-
ture control, a flow control, a water filter and noise optimized air-bubble free operation. The fig-
ure below shows the schematic of the cooler.
BCU20 Schematic Diagram

Figure 4.14: BCU20 Schematic Diagram

L PT100 Current

M PT100 Current

H PT100 Sense

J PT100 Sense

G Ground
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4.5.1 Installation of the BCU20

During the installation of the BCU20, the flow needs to be adjusted to its maximum. The steps
on how to do this are described in this section, refer to the following figure for the location of the
connections.
Backside View of the BCU20

Figure 4.15: Backside View of the BCU20

1. Open the top cover of the BCU20.

2. Turn the flow needle (1) as far down as possible.

3. Fill the water level with distilled water until it reaches the maximum mark. To prevent the
growth of algae, use a water conditioner. The recommended concentration is 0.5 ml water
conditioner (Art. 9025.1 ROTH) for 3.5 liters of water.

4. Connect the 8 mm water hose and filter to the left most connector (1) of the BCU20 and the
other end to the gradient coil. The filter prevents small particles from entering the gradient
coil. Since they may block the water flow after a while and thus destroy the gradient coil. The
filter element needs to be checked from time to time and if its color of the exchangeable filter
element is not white anymore it has to be replaced.

5. Connect the 8 mm return water hose from the gradient coil to the “Water In” (2) connector
on the BCU20.

6. Connect one end of the air hose to the “Draining” connector (3) and the other end to the
available compressed air or nitrogen supply of the system. This enables to blow out the wa-
ter from the gradient coil before it has to be disconnected from the chiller unit.

7. Connect the cable from the “Ext. Enable” connector (4) the Master Unit. The cable delivers
a signal to the master unit when the BCU20 is operating correctly. When the water level is
too low, the BCU20 stops the water flow and gives an alarm. When no water is flowing
through the gradient coil, or when the BCU20 is turned off, the enable signal is not delivered
to the Master Unit and the unit switches off the amplifiers to protect the gradient coil from
overheating.

8. Connect the cable from the “PT100 to Great Master Unit” (5) connector to the connector on
the Master Unit. Since the PT100 thermo-resistor of the gradient probe is not directly con-
nected to the Master Unit but to the BCU20, the Master Unit needs a signal which indicates
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a temperature between 5...50°C to enable the Great amplifiers. This signal is delivered by
this output (5). See also the section Operation of the BCU20 [32] for the difference in sig-
nals in different BCU20 operation modes.

9. Connect the cable from the “PT100 to Probe” connector (6) to the PT100 connector on the
gradient coil. Since its cable is in the gradient filter cable, the connection has to be estab-
lished by an extension cable from the imaging rack to the BCU20. As a consequence, the
BCU20 receives the temperature information from the gradient coil and has to remit it to the
Master Unit.

10.Connect the serial cable from the “RS232” connector (7) to the IPSO unit. This allows the
BCU20 temperature to be set and controlled using the command ‘edtg’ in TopSpin. The com-
mand ‘edtg’ behaves identical to the BVT control program ‘edte’ for which a manual can be
found under TopSpin help. The configuration to which TTY the unit is connected (default is
TTY04) has to be entered during ‘cf’.

4.5.2 Operation of the BCU20

During normal operation the BCU20 is switched on and runs without any user interaction. Only
a few settings have to be checked or set.
BCU20 Top View with Opened Cover

Figure 4.16: BCU20 Top View with Opened Cover
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Most important is that the 3 way valve (2) is set to flow during gradient operation. This position
lets the cooling water flow through the gradient coil. In case the gradient coil needs to be dis-
connected, the water can be blown out of the coil by switching the valve to “Draining”. After a
few seconds air bubbles in the water reservoir (3) can be observed. This is an indication that the
gradient and the water hoses are empty. The 3 way valve can be rotated 90 degrees (pointing
downward in the figure above, in this position the output is disabled and the gradient coil can be
removed.

The BCU20 can regulate the temperature in 2 different ways:

▪ The BCU20 uses its internal PT100 to regulate the temperature of the water in the water
reservoir. In this case the switch (4) has to be set to “PT100 BCU20”. In this operation mode,
the water can heat up or cool down during its flow to the gradient coil, so the gradient coil
might see a slightly different water temperature. The PT100 of the gradient coil is looped
through the BCU20 to the Master Unit in this mode, so the real gradient coil temperature can
be read at the Master Unit temperature display. This is the default mode for imaging, since
it is often helpful to control the gradients temperature in high duty cycle experiments.

▪ The BCU20 uses the PT100 of the gradient coil to regulate the temperature of the water. In
this case switch (4) has to be set to “PT100 Probe”. In this operation mode, the BCU20‘s
regulator regulates the temperature of the gradient coil, so the water itself can have a differ-
ent temperature. The temperature of the gradient coil is visible in the upper line of the Euro-
therm temperature regulator unit (number 1 in the figure below) on the front of the BCU20.
The temperature value which is forwarded to the Master Unit is only a dummy value (due to
technical reasons). So the Master Unit only shows a temperature value between 5...50 °C
which is not related to the real gradient coil temperature. This operation mode is the default
mode for diffusion applications, since here the temperature of the gradient coil (and much
more important the temperature of the sample) is a critical parameter for precise measure-
ments.
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Front View of the BCU20

Figure 4.17: Front View of the BCU20

The above mentioned temperatures can be set manually at the Eurotherm (1) with the up and
down arrows, or controlled by the ‘edtg’ program in TopSpin. The set temperature is displayed
in the lower line of the Eurotherm, the upper line shows the temperature of the water in the res-
ervoir (“PT100-BCU20”), or the temperature of the gradient coil (“PT100-Probe”).
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4.6 Imaging Accessory Wiring

The imaging rack is internally wired, so there should be no need to change any wiring. External-
ly, 7 cables need to be connected, refer to the figures below for details.
External Imaging Rack Cables

Figure 4.18: External Imaging Rack Cables

1. Connect the mains cable to the mains connector (1) and to 240V/32A socket.

2. Connect he control cable (2) to the connection on the rear of console. This connection
switches off the rack in case the console is switched off.

3. Connect the LVDS-in cable (3) to the DPP-Out connector of the DPP board.

4. Connect the Ethernet connection (4) to the switch.

5. If available, connect the B0-Out cable to BSMS-2 adapter board on the right most SCB20
board in the BSMS-2.

6. When required, (typically it is not connected at AVANCE III systems) connect the external
blanking cable (6) to the T0 interface of the IPSO board.

7. Connect the gradient filter (7) to the gradient coil.

The following drawing includes the full wiring of the imaging rack, including the BCU20:
Z33075_00_001 35



Imaging Rack (HMIMAG)
Imaging Accessory Wiring

Figure 4.19: Imaging Accessory Wiring
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5 Gradient Systems and RF Probes

Different gradient systems and RF probes are available to guarantee an optimum adaptation of
the hardware to the application. Gradient coils with narrow inner diameters can have huge gra-
dient strength but a limited sample space. Gradients with larger inner diameter offer more space
for the sample but a weaker gradient strength.

There are 3 families of gradient probes and RF components. Within the families the building
block principle is applied as far as possible. Parts cannot be interchanged between the families.
A list of compatible components is shown in the table below.

The diffusion systems (Diff) are listed for the sake of completeness since they are equipped only
with a Z-gradient and cannot be used for imaging.

Gradient System and RF Coil Compatibility Matrix

Table 5.1: Gradient System and RF Coil Compatibility Matrix

The best RF coil for an application is the smallest RF coil where the sample just fits in. Likewise,
the best gradient system is the one with the narrowest diameter where the selected RF coil fits
in. The table below shows the diameters for the different RF coils and gradient systems.

Diff 30
Gradient
SB-System

Diff 50
Gradient
WB-Sys-
tem

Diff 60
Gradient
WB-Sys-
tem

Micro 5
Gradient
SB-System

Micro 2.5
Gradient
WB-Sys-
tem

Mini 0.75
Gradient
WB-Sys-
tem

Mini 0.5
Gradient
WB-Sys-
tem

RF Diff 30 • • • •

RF Diff 50 • • • •

RF Diff 60 • • • •

RF Micro 5 • • • •

RF Micro 2.5 •

MICWB 40 •

RF Mini 0.75 • •

RF Mini 0.5 • •
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Gradient Systems and Available RF Coils

Table 5.2: Gradient Systems and Available RF Coils

(1) Refer to Micro 2.5 System, Discontinued [45] for details
(2) Refer to Micro 2.5: MICWB40 System [54] for details
(3) Refer to Mini 0.5/0.75 System [65] for details

Single 
Tuned Lin-
ear Coil

Double 
Tuned Lin-
ear Coil

Single 
Tuned 
Quadrature 
Coil

Single 
Tuned Sole-
noid Coil

Single 
Tuned Sur-
face Coil

Diff 30
Gradient
ID=19 mm
OD=40 mm

5-10 mm 5-8 mm 2.5-5 mm

Diff 50
Gradient
ID=19 mm
OD=72 mm

5-10 mm 5-8 mm 2.5-5 mm

Diff 60
Gradient
ID=19 mm
OD=72 mm

5-10 mm 5-8 mm 2.5-5 mm Discontin-
ued Type

Micro 5
Gradient
ID=19 mm
OD=40 mm

5-10 mm 5-8 mm 2.5-5 mm

Micro 2.5
Gradient
ID=40 mm
OD=72 mm

5-30 mm 5-30 mm(1) 2-5 mm 10-15 mm Discontin-
ued Type

Micro 2.5
Gradient
ID=40 mm
OD=72 mm

1H: 
5-15 mm
X: 
5-30 mm

5-30 mm(2) 1H: 
20-30 mm

2-5 mm 10-15 mm New 
MICWB40 
Type

Mini 0.75
Gradient
ID=57 mm
OD=72 mm

5-38 mm 5-38 mm(3) 10-15 mm

Mini 0.5
Gradient
ID=57 mm
OD=72 mm

5-38 mm 5-38 mm(3) 10-15 mm
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5.1 Micro 5 System

The Micro 5 is the only triple axis imaging gradient system which fits in a standard bore (52 mm)
magnet. The Micro 5 probe has one body, where RF coils and gradient coils are mounted which
is equipped with a thermocouple (Type T). The body and the RF coils are fully compatible to the
diffusion gradient coils (Diff 30, Diff 50, Diff 60), so replacing the Micro 5 gradient coil can turn
the system into a spectroscopic diffusion system with a Z-gradient.

The gradient coil is water cooled and the standard RF saddle coils with an inner diameter of 5
to 10 mm can be temperature controlled in a range between -40°C to +80°C. In addition to the
saddle coils, small solenoid coils are available, but the temperature control of the solenoids is
rather difficult. Where a large temperature range between -100°C to +200°C is required, special
single tuned EVT (Enhanced Variable Temperature) RF inserts (5 mm only) can be used with
the standard Micro 5, Diff 30, Diff 50 and Diff 60 gradient coils.

For detailed setup parameters for the Micro 5 gradient system refer to chapter “Typical Gradient-
Setpre Parameters [179]”. For maximum duty cycles refer to chapter Typical Gradient Coil Pa-
rameters  [178].
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Application Relevant Parameters of the Micro 5 System

Table 5.3: Application Relevant Parameters of the Micro 5 System

ParaVision System Status: S019

Gradient Inner Diameter. 19 mm

Gradient Outer Diameter. 40 mm

Gradient Cooling. Water cooled.

RF Shield. Included in gradient system.

Linearity.
(±1.6% peak-peak)

19 mm sphere.

Max. Gradient Current. 60A

Max. Gradient Voltage. 120V

Max. Gradient Strength. 3T/m @ 60 Amp = 300G/cm @ 60 Amp [5G/(cm*A)].

RF Coil. Version with exchangeable insert: From 2.5 mm (solenoid) to 10 mm single 
frequency or 8 mm double frequency saddle coil. 
Planar micro-coils with diameters of 20 to 1000 µm.
Micro-solenoid coils with diameters down to 350 µm.

Version with non-exchangeable coil: 5 mm or 8 mm double frequency saddle
coil with additional 2H Lock.

Temperature Control. Build in thermo couple type T.

Dewar with heater and cable set to BVT available.

Temperature Range. -20°C to +60°C standard or -100°C to +200°C with EVT insert.

Tuning and Matching. Tuning and matching trimmers in the probe body.

Typical Applications. Plants, insects, biopsies, materials, soil/bore/stone samples, flow and diffu-
sion experiments.

Advantages Sample lift can be used (HR-Sample Lift).
EVT Inserts available.
High gradient strength.
Good temperature control of the sample.
Gradient and RF stays in the magnet during sample change.
Very good shim performance.
Tolerant against high gradient duty cycles.

Drawback Sample sizes max. 10 mm.
Gradient coil needs to be unmounted for RF insert exchange.
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5.1.1 Assembly/Disassembly of the Micro 5 System

The assembly of the Micro 5 system is relatively simple, however there are a few points, which
require careful consideration and handling.

Saddle Coil

1. Place the system base on a table.

2. Slip the RF insert onto the base. The inserts are very sensitive, especially the ones without
a quartz glass tube where the coil wires can be touched. Avoid touching or bending these
wires. If the insert is in the right position, it simply slips on the probe base pins.

Mounted Mirco5 RF Insert (Saddle Coil)

Figure 5.1: Mounted Mirco5 RF Insert (Saddle Coil)

Solenoid Coil

1. Remove the RF pin shown in the left image of the figure below. The pin has a special collar,
which can be screwed out using a small pair of pliers (middle image).

2. Push the solenoid onto the four remaining pins.

3. Fix the solenoid by screwing a RF screw into the thread of the previously removed pin (right
image).
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Micro 5 RF Insert (Solenoid Coil)

Figure 5.2: Micro 5 RF Insert (Solenoid Coil)

4. Mount the gradient coil by shifting it down over the RF insert until it reaches the gradient cur-
rent and water pins. Be very careful not to tilt the gradient coil against the RF coil. Since the
RF coil is only stabilized by a thin walled quartz tube, it is extremely easy to break.

5. When the gradient coil reaches the probe pins, rotate the gradient coil in order to match the
position of the water sockets in the gradient coil to the water connectors on the probe body.

6. Push down the gradient coil using moderate force so that the pins slip into the coils sockets.
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Mounting of the Micro 5 Gradient

Figure 5.3: Mounting of the Micro 5 Gradient

7. Fasten the gradient coil using the lock nut on the probe base. Hold the black gradient coil
(not the probe base!) in one hand and fix the gradient coil using the lock nut. The lock nut
will pull down the gradient coil. The inner diameter of the gradient coil is reduced about 10
mm down from the top. This edge pushes down the RF insert while the gradient coil is fixed,
so that a good RF connection and (if mounted) a good thermal junction to the dewar is guar-
anteed.
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Final Assembly of the Micro 5

Figure 5.4: Final Assembly of the Micro 5

After all the parts are assembled the complete Micro 5 can be mounted in a standard bore or a
wide bore shim system using the gold-colored screws on the bottom plate, or by using the bay-
onet lock.

Disassembly

To disassemble the system to change the RF insert follow the steps in reverse order. Again, it
is extremely important to hold the gradient coil and not the body while unscrewing the lock nut
and not to tilt the gradient coil while pulling it over the RF coil. The first few millimeters may be
difficult, since the O-rings of the water cooling stick to the gradient coil. A good tip is to push a
screw driver into the gap between gradient coil and body and rotate it carefully to shift the gra-
dient coil up (see the figure below).
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Removal of the Gradient Coil from the Probe Base

Figure 5.5: Removal of the Gradient Coil from the Probe Base

5.2 Micro 2.5 System, Discontinued

The Micro 2.5 is a water cooled triple axis wide bore imaging system which only fits into wide
bore magnets (89 mm) or larger. The gradient coil and the RF part are mounted separately in
the magnet, the gradient coil by means of a separate holder adapting it to the individual magnet.
The RF part is mounted afterwards inside the gradient system. The Micro 2.5 system is only
compatible to Micro 2.5 parts, not to any other micro-imaging probe types. The big advantage
of this system is its high flexibility. Three different RF probes can be combined with the same
gradient system to adapt the system optimal to the application.

Micro 2.5 Probe

This is the most flexible RF probe for the Micro 2.5 imaging system. It consists of a probe body
which is designed for 2 RF channels. The exchangeable RF inserts cover a wide range from 2.5
to 5 mm solenoid coils, 5 to 10 mm saddle coils and 15 to 30 mm birdcage coils, which can be
built as single frequency, dual frequency or quadrature (birdcage) inserts. In addition to these
insets, an EVT (Enhanced Variable Temperature) insert with an inner diameter of 15 mm is avail-
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able which covers temperatures from -100 °C to +200 °C. The probe is fully compatible to the
BVT temperature control unit, has an internal thermocouple (Type T) and an optional dewar with
heater.

Micro 2.5 AHS-RF Probe

This probe is dedicated to animal work. The exchangeable inserts are not mounted on top of the
2 channel probe, but a bit further down. This allows installation of exchangeable RF inserts from
2.5 to 5 mm solenoid coils, 5 to 10 mm saddle coils and 15 to 25 mm birdcage coils that can be
built as single frequency, and dual frequency or quadrature (15 to 25 mm birdcage) inserts. Ad-
ditionally, this probe offers the possibility of plugging in surface coils that can be directly attached
to the animal to increase the signal to noise of the experiment (currently no cross coil operation
is supported). The probe provides the advantage of full animal support with an animal bed to fix
and position the animal, anesthesia support (breathing gas), and plug and play support for the
SA-Instruments animal monitor system (supporting respiration, ECG and temperature control),
see chapter Digital Data Filtering and Analog Sampling [127].

MicroMouse (2.5) Probe

This probe is also dedicated to animal work. The big difference to the Micro 2.5 AHS-RF probe
is the non-exchangeable 30 mm RF coil which is mounted on top of the 2 channel probe. The
30 mm birdcage RF coil allows full body work with a mouse (30 g) and can be a single frequency
coil, dual frequency coil, or a quadrature coil. This probe also offers the possibility of mounting
X frequency surface coils that can be directly attached to the animal to increase the signal to
noise of the experiment (currently no cross coil operation is supported). The surface coil is
mounted as a third channel add on with its own RF cable and tuning unit. The probe has the
advantage of full animal support with an animal bed to fix and position the animal, anesthesia
support (breathing gas), and plug and play support for the SA-Instruments animal monitor sys-
tem (supporting respiration, ECG and temperature control), see chapter Digital Data Filtering
and Analog Sampling [127].
Micro 2.5 RF Probes.

Figure 5.6: Micro 2.5 RF Probes.
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The Micro 2.5 probe on the left in the figure above is with a mounted 30 mm insert. The upper
right picture shows the MicroMouse probe, the lower right the Micro 2.5 AHS-RF probe, both
equipped with an animal bed.

For detailed setup parameters for the Micro 2.5 gradient system refer to chapter “Typical Gradi-
ent-Setpre Parameters [179]”. For maximum duty cycles refer to chapter Typical Gradient Coil
Parameters  [178].
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Application Relevant Parameters of the Micro 2.5 System

Table 5.4: Application Relevant Parameters of the Micro 2.5 System

ParaVision System Status S040

Gradient Inner Diameter 40 mm

Gradient Outer Diameter 72 mm

Gradient Cooling Water Cooled

RF Shield Each RF Coil is separately shielded.

Linearity 
(±1.8% peak-peak)

36 mm sphere.

Max. Gradient Current 60 A

Max. Gradient Voltage 120 V

Max. Gradient Strength 1.5 T/m @ 60Amp = 150 G/cm @ 60Amp [2.5 G/(cm*A)]

RF Probes 

Micro 2.5 Micro 2.5 AHS RF MicroMouse (2.5)

RF Coils Exchangeable Insert

2.5-5 mm Solenoid
5-10 mm Saddle Coil
15-30 mm Birdcage C

All coils can be single or 

double frequency(1) tuned, 
birdcages can be quadra-
ture probes.

Exchangeable Insert

2.5-5 mm Solenoid
5-10 mm Saddle Coil
15-25 mm Birdcage C
5-15 mm Surface Coil

All coils can be single or 
double frequency tuned, 
birdcages can be quadra-
ture probes.

Fixed Coil

30 mm Birdcage Coil
5-15 mm Surface Coil

The 30 mm coil can be a sin-
gle, double or quadrature 
probe; the add-on surface 
coil is single frequency for X 
only.

Temperature Con-
trol

Thermocouple and dewar. 
Compatible to BVT unit.

Animal temperature control 
by gradient cooling water.

Animal temperature control 
by gradient cooling water.

Temperature 
Range

10°C to +50°C or 
-100°C to +200°C with EVT 
Insert

Typical Applications Plants, Insects, Biopsies, 
Materials, Soil/Bore/Stone 
Samples, Flow Experi-
ments, Rheology.

Mouse Extremities or Head 
Application
Whole Body Mouse Appli-
cations up to ~20g.

Whole Body Mouse Applica-
tions up to ~30g.

Advantages - High flexibility for all kind 
of samples.
- Temperature Control.
- EVT Inserts.
- Minimum 15 mm free ac-
cess inner diameter.

- Flexibility for all kinds of 
mouse and non in vivo ap-
plications.
- Animal Support.
- Surface Coils.
- Easy base for home build 
coils.

- Full body mouse applica-
tions.
- Animal Support.
- X-Surface Coils.

The Micro 2.5 gradient system offers a high flexibility and a sufficient gradient strength 
for almost all micro-imaging applications. The gradient coil remains in the magnet during
probe/sample exchange. There is no need to disconnect it.

Drawback - No in-vivo applications - Ex-vivo samples harder to 
handle.

- Only non exchangeable 30 
mm ID RF coil available.

The RF probe needs to be taken out from the magnet for sample replacement.
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(1) 30 mm double tuned exchangeable inserts are not recommended due to their limited perfor-
mance, caused by restricted space for the coil design. Wherever possible, 25 mm inserts are
recommended.

5.2.1 Assembly/Disassembly of the Micro 2.5 System
Assembly/Disassembly of the Micro 2.5 System

The assembly of the Micro 2.5 system consists of 2 basic parts, the gradient and the RF probe. 

The gradient probe is typically assembled only once during the installation. It consists of the gra-
dient coil and the gradient base, which adapts the coil to the correct length for the different mag-
nets. The assembly is very easy and done in a few minutes. 

1. Place the gradient coil on the table in such a way, that the brass ring points upwards.

2. Take the gradient base and lubricate the O-rings with some grease.

3. Place the base on the gradient coil and push it down with a moderate force, so that there is
no gap between the brass ring and the probe base. 

4. Fasten the gradient coil to the probe base using the 3 retaining screws.
Mounting the Micro 2.5 Gradient to its Base

Figure 5.7: Mounting the Micro 2.5 Gradient to its Base

5. Fasten the gradient to the bottom part of the shim system in the magnet using the four spe-
cial screws. The screws are tightened manually at the outer 4 holes of the gradient probe
base.
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6. Screw the lock nuts upwards to fix the probe base properly.

7. Connect the water hoses and gradient cable.
Mounted Micro 2.5 Gradient, Fixed with 4 Brass Screws with Lock Nuts 

Figure 5.8: Mounted Micro 2.5 Gradient, Fixed with 4 Brass Screws with Lock Nuts 

The RF probe needs to be adapted for different sample sizes. The smaller the inner diameter of
the RF coil, the higher the signal to noise ratio at a given sample. Saddle coils (5 or 10 mm)
improve the signal to noise and the shim performance compared to a birdcage. Solenoid coils
(2.5 to 5 mm) improve the signal to noise compared to a birdcage, or saddle coil even more, but
with the drawback that they can not be shimmed as good as saddle coils.

The exchangeable inserts of the Micro 2.5 and the Micro 2.5 AHS-RF RF probes need to be in-
stalled very carefully, since the tune and match trimmers are very sensitive.

Micro 2.5

1. Place the probe base on a table with the RF connections pointing upward.

There are 2 RF connections (gold-colored connectors) visible and four spring born bushings
to adapt the tune and match trimmer rods of the individual insert. The trimmer rods are half
cut off and used to align the rods of the insert with the bushings of the probe base.

2. Align the rods of the insert with the busings of the probe base and lightly press the rods into
the bushings until a click is heard. If the rods don‘t slide easily into the bushing, rotate the
tuning and matching rods a little forward and backward until the rods slide in.

3. Once the rods are inserted, fix the insert using the thumb wheels.

Note: The capacitors for tuning and matching can be rotated only to a certain range. Applying
to much force will break the capacitors, if they have reached the end points.
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Schematic of a Micro 2.5 Probe Base and RF Insert

Figure 5.9: Schematic of a Micro 2.5 Probe Base and RF Insert

Micro 2.5 AHS-RF

The mounting of the Micro 2.5 AHS-RF inserts is even simpler compared to the mounting of a
Micro 2.5 insert, since there are no thumb wheels to fix the insert. 

1. Align the trimmer rods and the bushings as described in the previous section.

2. Lightly press the rods into the bushings until a click is heard. If the rods don‘t slight easily
into the bushing, rotate the tuning and matching rods a little forward and backward until the
rods slide in.

3. Once the click is heard, the insert must be pushed down until there is no remaining gap be-
tween the flange and the insert.

5.2.2 Installation of the Dewar with Heater in the Micro 2.5 RF Probe

The installation of the dewar including the heater to the Micro 2.5 RF probe is very easy. Unfor-
tunately, there is currently no mechanical support for the fixation of the heater connector.

1. Mount the slotted closure head on top of the Micro 2.5 RF probe base, if not already done.

In the figure below, 2 wires below the head form the thermocouple for the temperature mea-
surement.
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Closure Head. 

Figure 5.10: Closure Head. 

2. As soon as the closured head is at its position, shift the glass dewar in from the bottom of
the RF probe. 

The bottom mount must have a spring to press the glass dewar to closure head and a Teflon
ring to protect the glass from the metal spring.
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Bottom Mount with Spring and Teflon Ring to Protect the Glass Dewar.

Figure 5.11: Bottom Mount with Spring and Teflon Ring to Protect the Glass Dewar.

3. Fasten the bottom mount with the 2 screws.

4. Shift the dewar in and fasten it with a bayonet lock.
Bottom Mount Fastened with 2 Screws.

Figure 5.12: Bottom Mount Fastened with 2 Screws.

In the figure above the heater is shifted in and fixed by the bayonet lock.

For the installation of EVT inserts on the Micro 2.5 probe base refer to the “Micro2.5-EVT Man-
ual”.
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5.3 Micro 2.5: MICWB40 System

The Micro 2.5 is a water cooled triple axis wide bore imaging system which only fits into wide
bore magnets (89 mm) or larger. The gradient coil and the MICWB40 RF part are mounted sep-
arately in the magnet, the gradient coil by means of a separate holder adapting it to the individual
magnet. The RF part is mounted afterwards inside the gradient system. The Micro 2.5 system
is only compatible to the discontinued Micro 2.5 and the MICWB40 parts, not to any other micro-
imaging probe types. The big advantage of this system is its high flexibility at a high gradient
strength. Two types of RF probes with exchangeable RF inserts adapt the system optimal to the
application.

MICWB40 Probe BASIC

This is the basic probe for non in-vivo applications. It consists of a probe body which is designed
for 2 RF channels. The exchangeable RF inserts cover a wide range from 2.5 to 5 mm solenoid
coils, 5-30 mm linear coils (5-15 mm for 1H), 5-30 mm double tuned coils, 20-30 mm quadrature
coils (1H) and 10-15mm surface coils (fixed housing or flexible wire). In addition to these inserts,
an EVT (Enhanced Variable Temperature) insert with an inner diameter of 15 mm is available

CAUTION

Risk of burn from hot surfaces.

Coming in contact with the inner surface of volume coils may result in serious burns.

 The application of the maximum allowed CW RF power for long durations increases the
temperature of the inner surface of volume coils.

 The maximum allowed CW RF power is a technical limitation of the coil and can be con-
siderable higher than the maximum dose that can be applied to living samples.

1. Wait until the RF coil cooled down before removing it from the scanner.

2. Always monitor the temperature of living samples during the examination to avoid injury
or death of the animal.

CAUTION

Risk of personal injury from coming in contact with active coils.

Coming in contact with active coils may result in personal injury or damage to the device.

 Active coils may contain hot parts or provide other dangers to personal or devices.

1. Never come in contact with a active MRI coil.

2. Stop a running experiment before connecting or disconnecting a MRI coil.

3. Never remove the cover from the coil.

4. Never connect a damaged coil to the scanner.

5. Never operate an MRI coil outside the magnet.

6. When using anesthetic gases ensure correct functioning of the exhaust system for the
magnet bore.

7. Always monitor the body temperature of the animal to avoid a dangerous increase of the
temperature of the animal due to increased RF dissipation.

8. Avoid wire loops inside the transmitter coil.
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which covers temperatures from -100 °C to +200 °C. The probe is fully compatible with the BVT
temperature control unit (with the optional VT Kit that includes heater and thermocouple Type T,
Option Number PH2504).

MICWB40 Probe IN-VIVO

In addition to the features of the “MICWB40 Probe BASIC”, this probe also includes animal sup-
port. The probe body is equipped with wiring and hoses to control the animal physiology (anes-
thesia, temperature and respiration measurement, ECG), as well as an animal bed for
convenient animal handling (25 mm and 30 mm RF inserts). With experience, whole body ex-
periments of mice up to about 30 grams can be investigated in the 30 mm resonator. The inter-
facing of the probe directly supports the SA-Instruments animal monitoring system (respiration,
ECG and temperature control), see Digital Data Filtering and Analog Sampling [127].
In combination with the VT Kit, the probe can be temperature controlled as with the MICWB40
Probe BASIC, but only for non in-vivo experiments.
MICWB40 Probes.

Figure 5.13: MICWB40 Probes.

The left side of the image above shows a MICWB40 configuration with installed VT Kit, the right
image shows the IN-VIVO version with animal bed. 

For detailed setup parameters for the Micro 2.5 gradient system refer to chapter “Typical Gradi-
ent-Setpre Parameters [179]”. For maximum duty cycles refer to chapter Typical Gradient Coil
Parameters  [178].
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Application Relevant Parameters of the Micro2.5 System

Table 5.5: Application Relevant Parameters of the Micro2.5 System

ParaVision System Status: S040

Gradient Inner Diameter. 40 mm

Gradient Outer Diameter. 72 mm

Gradient Cooling. Water cooled

RF Shield. Each RF coil is separately shielded.

Linearity.
(±1.8% peak-peak)

36 mm sphere

Max. Gradient Current: 60 A

Max. Gradient Voltage: 120 V

Max. Gradient Strength: 1.5 T/m @ 60Amp = 150 G/cm @ 60Amp [2.5 G/(cm*A)]

RF Probes:

MICWB40 BASIC MICWB40 IN-VIVO

RF Coils: - Exchangeable Insert.

- 2.5-5 mm solenoid coils.

- 5-15 mm linear coils (1H).

- 20-30 mm quadrature coils (1H).

- 5-30 mm double tuned coils(1).

- 10-15 mm surface coils (fixed hous-
ing or flexible wire).

- Exchangeable insert.

- 2.5-5 mm solenoid coils.

- 5-15 mm linear coils (1H).

- 20-30 mm quadrature coils (1H).

- 5-30 mm double tuned coils(1).

- 10-15 mm surface coils (fixed housing 
or flexible wire).

- Animal beds are only available for 25 
mm and 30 mm ID coils.

Temperature Con-
trol:

VT kit, thermocouple and dewar. Com-
patible to BVT unit.

Animal temperature control by gradient 
cooling water.

VT kit, thermocouple and dewar. Com-
patible to BVT unit (ex-vivo)

Temperature 
Range:

-10 °C to +50 °C, or,

-100 °C to +200 °C with EVT insert and 
VT-kit.

-10 °C to +50°C, or,

-100 °C to +200 °C with EVT Insert and 
VT-Kit

Typical Applica-
tions:

Plants, insects, biopsies, materials, 
soil/bore/stone samples, flow experi-
ments, rheology

Mouse whole body or head applications
plants, insects, biopsies, materials, soil/
bore/stone samples, flow experiments, 
rheology

Advantages: - High flexibility for all kind of ex-vivo 
samples.

- Temperature control.

- EVT Inserts.

- Minimum 19 mm free access inner di-
ameter.

- Flexibility for all kinds of mouse and non 
in vivo applications.

- High flexibility for all kind of samples

- Temperature control.

- EVT Inserts.

- Minimum 19 mm free access inner di-
ameter

The Micro 2.5 gradient system offers a high flexibility and a sufficient gradient 
strength for almost all micro-imaging applications. The gradient coil remains in the 
magnet during probe/sample exchange. There is no need to disconnect it.

Drawback: - No in-vivo applications.

The RF probe needs to be taken out from the magnet for sample replacement.
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(1) 30 mm double tuned exchangeable inserts are not recommended due to their limited perfor-
mance, caused by restricted space for the coil design. Wherever possible, 25 mm inserts are
recommended.

5.3.1 Assembly/Disassembly of the Micro 2.5 System
Assembly/Disassembly of the Micro 2.5 System

The assembly of the Micro 2.5 system consists of 2 basic parts, the gradient and the RF probe. 

The gradient probe is typically assembled only once during the installation. It consists of the gra-
dient coil and the gradient base, which adapts the coil to the correct length for the different mag-
nets. The assembly is very easy and done in a few minutes. 

1. Place the gradient coil on the table in such a way, that the brass ring points upwards.

2. Take the gradient base and lubricate the O-rings with some grease.

3. Place the base on the gradient coil and push it down with a moderate force, so that there is
no gap between the brass ring and the probe base. 

4. Fasten the gradient coil to the probe base using the 3 retaining screws.
Mounting the Micro 2.5 Gradient to its Base

Figure 5.14: Mounting the Micro 2.5 Gradient to its Base

5. Fasten the gradient to the bottom part of the shim system in the magnet using the four spe-
cial screws. The screws are tightened manually at the outer 4 holes of the gradient probe
base.
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6. Screw the lock nuts upwards to fix the probe base properly.

7. Connect the water hoses and gradient cable.
Mounted Micro 2.5 Gradient, Fixed with 4 Brass Screws with Lock Nuts 

Figure 5.15: Mounted Micro 2.5 Gradient, Fixed with 4 Brass Screws with Lock Nuts 

The RF probe needs to be adapted for different sample sizes. The smaller the inner diameter of
the RF coil, the higher the signal to noise ratio at a given sample. Saddle coils (5 or 10 mm)
improve the signal to noise and the shim performance compared to a birdcage. Solenoid coils
(2.5 to 5 mm) improve the signal to noise compared to a birdcage, or saddle coil even more, but
with the drawback that they can not be shimmed as good as saddle coils.

The exchangeable inserts of the Micro 2.5 and the Micro 2.5 AHS-RF RF probes need to be in-
stalled very carefully, since the tune and match trimmers are very sensitive.

Micro 2.5

1. Place the probe base on a table with the RF connections pointing upward.

There are 2 RF connections (gold-colored connectors) visible and four spring born bushings
to adapt the tune and match trimmer rods of the individual insert. The trimmer rods are half
cut off and used to align the rods of the insert with the bushings of the probe base.

2. Align the rods of the insert with the busings of the probe base and lightly press the rods into
the bushings until a click is heard. If the rods don‘t slide easily into the bushing, rotate the
tuning and matching rods a little forward and backward until the rods slide in.

3. Once the rods are inserted, fix the insert using the thumb wheels.

Since the alignment of probe base and insert is a bit tricky, a small mounting tool was developed.
refer to the following figure and follow the instructions below.

Note: The capacitors for tuning and matching can be rotated only to a certain range. Applying
to much force will break the capacitors, if they have reached the end points.
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Mounting a MICWB40 Insert with the Help of the Small Mounting Tool

Figure 5.16: Mounting a MICWB40 Insert with the Help of the Small Mounting Tool

1. Place the mounting tool below the RF coil in the half shell of the insert (a).

2. Shift it towards the RF coil into the closed protecting tube (b).
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3. Shift the probe base into the insert (or the insert on the base), holding the mounting tool with
the thumb (c) until the probe base slips below the mounting tool and connects to the insert
(d).

4. Remove the mounting tool and fix the insert to the probe base using the included screws
and screwdriver.

Fixing the MICWB40 Insert

Figure 5.17: Fixing the MICWB40 Insert

5.3.2 Installation and Usage of the Quadrature Combiner

When 20-30 mm 1H quadrature probes should be used, an RF combiner is required to drive the
quadrature coil. This combiner is actually a phase shifter which shifts the phase of the transmit
signal for one channel of the quadrature probe to +90° and to -90° during the acquisition of the
signal from this channel before the signals of both channels are combined. This indicates, that
the combiner is a frequency depended device.
Combiner for MICWB40 Quadrature Probes

Figure 5.18: Combiner for MICWB40 Quadrature Probes
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The combiner is controlled by the RGP send and receive signals of the preamplifiers. Thus the
combiner needs to be connected to a free connector on the preamplifier flat cable. The combiner
receives its power through this cable.

Connection of the Combiner to the Preamplifier Flat Band Cable

Figure 5.19: Connection of the Combiner to the Preamplifier Flat Band Cable

The RF output of the preamplifier needs to be connected to the combiner input (RF Power IN),
not directly to the probe. The probe must be connected to the TX-90°/RX90° and TX/RX 0° con-
nector using two equal length N connector RF cables, whereas the correct wiring is essential. If
the signal to noise in the NMR experiment is very low, the two cables between combiner and
probe may have been swapped.

To wobble/tune the two RF channels in the quadrature probe, directly connect each channel of
the probe to the preamplifier and wobble/tune each channel individually, before reconnecting the
combiner.

CAUTION

Material Damage Hazard due to Static Electricity

Failure to switch off the preamplifier prior to connecting the combiner to the flat band cable
may result in damage to the cover module.

1. Be sure to disconnect the power cable or switch off the rack before connecting the com-
biner to the flat band cable.
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5.3.3 Installation of the MICWB40 VT Kit

The installation of the VT Kit (Option No. PH2504) including the dewar, heater and thermocouple
is easy and can be done within a few minutes.

1. Mount the guide for the dewar to the insert below the coil.
Dewar Guide Fixed with 3 Screws below the RF Coil and Dewar Shifted in from Probe Bottom

Figure 5.20: Dewar Guide Fixed with 3 Screws below the RF Coil and Dewar Shifted in from Probe Bottom

2. Shift the glass dewar in from the bottom of the RF probe. Do not fasten the dewar to the
probe base!
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Bottom Mount with Spring and Teflon Ring to Protect the Glass Dewar

Figure 5.21: Bottom Mount with Spring and Teflon Ring to Protect the Glass Dewar

3. Insert the spring into the fixation, then the teflon ring to protect the glass dewar from the met-
al spring.

4. Screw the fixation with 2 screws from the bottom of the probe to fix the dewar.

5. Shift the heater/thermocouple in and fasten them using a bayonet lock.
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The Heater/thermocouple Shifted in and Fixed Using the Bayonet Lock.

Figure 5.22: The Heater/thermocouple Shifted in and Fixed Using the Bayonet Lock.

6. Depending on the magnets height, the probe may need to be mounted in the magnet before
the heater can be plugged in.
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Probe with Heater Mounted in the Magnet and Connected to the BVT 

Figure 5.23: Probe with Heater Mounted in the Magnet and Connected to the BVT 

For information on the installation of EVT inserts on the MICWB40 probe base, refer to the
“MICWB40-EVT Manual”.

5.4 Mini 0.5/0.75 System

The Mini 0.5/0.75 is a water cooled triple axis wide bore system which only fits into wide bore
magnets (89 mm) or larger. The gradient coil and the RF part are mounted separately in the
magnet, the gradient coil by means of a separate holder adapting it to the individual magnet.
The RF part is mounted afterwards inside the gradient system. The Mini 0.5 and the Mini 0.75
gradient system have the same dimensions and only differ in the maximum reachable gradient
strength. All parts of the Mini 0.5 and Mini 0.75 systems are compatible with each other, but not
to any other micro-imaging system. The advantage of this system, compared to the Micro 2.5
and Micro 5 systems, is the larger sample space (up to 38 mm) and the flexibility for in-vivo and
ex-vivo work, thus there are 2 different RF probes available to optimally adapt the system to the
application.
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Mini 0.5/0.75 RF Probes.

Figure 5.24: Mini 0.5/0.75 RF Probes.

On the left hand side of the figure above, a “Mini 0.5/0.75” is equipped with a 38 mm insert. The
right image shows the “Mini 0.5/0.75 AHS-RF” probe equipped with an animal bed.

Micro 0.5/0.75 RF Probe

This is the most flexible RF probe for the Mini imaging system and enables in-vivo and ex-vivo
work. It consists of a probe body which is designed for 2 RF channels. The exchangeable RF
inserts cover a wide range of up to 38 mm ID double tuned RF inserts, which can be built as
single frequency, dual frequency, or quadrature (bird cage) inserts. The Mini 0.5/0.75 RF system
is equipped with a separate animal bed (for 38 mm RF inserts only), which can be pulled out of
the RF probe from the bottom side. This allows the RF probe to stay in the magnet, while another
animal is prepared in the animal bed outside of the magnet. It also allows repositioning of the
animal in the RF probe from outside the magnet. The has the advantage of full animal support,
with an animal bed to fix and position the animal, anesthesia support (breathing gas), and plug
and play support for the SA-Instruments animal monitor system (supporting respiration, ECG
and temperature control), see Digital Data Filtering and Analog Sampling [127].

Mini 0.5/0.75 AHS-RF Probe

This probe is dedicated to animal work. The exchangeable inserts are not mounted on top of the
2 channel probe, rather a bit further down. This allows to install exchangeable birdcage inserts
up to 34 mm inner diameter that can be single frequency, dual frequency, or quadrature inserts.
Additionally, this probe offers the possibility of plugging in surface coils that can be directly at-
tached to the animal to increase the signal to noise of the experiment (currently no cross coil
operation is supported). The probe offers the advantage of full animal support with an animal
bed to fix and position the animal, anesthesia support (breathing gas), and plug and play support
for the SA-Instruments animal monitor system (supporting respiration, ECG and temperature
control), see chapter Digital Data Filtering and Analog Sampling [127].

For detailed setup parameters for the Mini 0.5/0.75 gradient system refer to chapter “Typical
Gradient-Setpre Parameters [179]”. For maximum duty cycles refer to chapter Typical Gradient
Coil Parameters  [178].
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Application Relevant Parameters of the Mini0.5/0.75 System

ParaVision System Status: S057

Gradient Inner Diameter: 57 mm

Gradient Outer Diameter: 72 mm

Gradient Cooling: Water cooled.

RF Shield: Each RF Coil is separately shielded.

Linearity:
(±2% peak-peak)

XY: 43 mm

Z: 30 mm sphere.

Max. Gradient Current: 60 A

Max. Gradient Voltage: 120 V

Max. Gradient Strength: Mini 0.5: 0.3T/m@60A = 30 G/cm@60A [0.5 G/(cm*A)]
Mini 0.75: 0.45T/m@60A = 45 G/cm@60A [0.75 G/(cm*A)]

RF Probes:

Mini0.5/0.75 Mini0.5/0.75 AHS-RF

RF Coils: - Exchangeable Inserts.

- 2.5-5 mm Solenoid.

- 5-10 mm Saddle Coil.

- 15-38 mm Birdcage Coil.

All coils can be single or double fre-

quency(1) tuned, birdcages can be 
quadrature probes.

- Exchangeable Inserts.

- 2.5-5 mm Solenoid.

- 5-10 mm Saddle Coil.

- 15-34 mm Birdcage Coil.

- 5-15 mm Surface Coil.

All coils can be single or double fre-
quency tuned, birdcages can be 
quadrature probes.

Temperature Con-
trol:

Animal temperature control by gradient cooling water temperature adjustment.

Temperature 
Range:

10 °C to +50 °C by gradient cooling water temperature.

Typical Applica-
tions:

Materials, Soil/Bore/Stone Samples, 
Flow Experiments, Mouse whole body 
or rat brain (Rats <190g).

Materials, Soil/Bore/Stone Samples, 
Flow Experiments, Mouse whole body 
or rat brain (Rats <190g), Surface coil 
applications.
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Table 5.6: Application Relevant Parameters of the Mini0.5/0.75 System

5.4.1 Assembly/Disassembly of the Mini 0.5/0.75 System

The assembly of the Mini 0.5/0.75 system consists of 2 basic parts, the gradient probe and the
RF probe.

The gradient probe is typically assembled only once during the installation. The gradient probe
consists of the gradient coil and the gradient base, which adapts the coil to the correct length for
the systems magnet. The assembly is very easy and done in a few minutes. 

1. Place the gradient coil on the table in such a way, that the brass ring points upwards.

2. Take the gradient base and lubricate the o-rings with some grease.

3. Place the base on the gradient coil and push it down with a moderate force, so that there is
no gap between the brass ring and the probe base.

4. Fasten the gradient coil to the probe base using the 3 retaining screws.

Advantages: - High flexibility for all kind of samples 
with big (38 mm) diameter, in-vivo and 
ex-vivo.

- Sample positioning from outside the 
magnet.

- Minimum 25 mm free access inner di-
ameter.

- Plug and play animal support.

-All kind of samples, in-vivo and ex-vivo.
-Minimum 25 mm free access inner di-
ameter.

-Plug and play animal support.

-Surface coils.

The Micro 0.5/0.75 gradient systems provide a sufficient gradient strength for all 
applications where not the absolutely highest resolution is required. The advan-
tages are in the possibility to investigate larger samples and the easier animal 
handling, compared to the smaller systems.

The gradient coil remains in the magnet during probe/sample exchange. There is 
no need to disconnect it.

Drawback: - Animal bed support only with 38 mm 
RF insert.

- Non in-vivo samples more difficult to 
handle.

- RF probe needs to be taken out from 
the magnet for sample exchange.
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Mounting the Mini0.5/0.75 Gradient to the Base

Figure 5.25: Mounting the Mini0.5/0.75 Gradient to the Base

5. Fasten the gradient to the bottom part of the shim system in the magnet using the four spe-
cial screws. The screws need to be tightened using a non-magnetic screwdriver on the outer
holes of the gradient probe base.

6. Connect the water hoses and gradient cable.
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Mini 05/0.75 Gradient Mounted to a Magnet. 

Figure 5.26: Mini 05/0.75 Gradient Mounted to a Magnet. 

Note: In the figure above the image is the old gradient base. The new base has 4 additional
screws arranged in a rectangular shape to fix the base without removing screws from the shim
system. The image will be updated as soon as it is available.

The RF probe needs to be adapted, and as a consequence, changed for different sample sizes.
The smaller the inner diameter of the RF coil, the higher the signal to noise ratio at a given sam-
ple.

The exchangeable inserts of the two Mini 0.5/0.75 probes RF probes need to be installed very
carefully, since the tune and match trimmer are very sensitive.

Mini 0.5/0.75

1. Place the probe base on a table with the RF connections pointing upward.

There are 2 RF connections (gold-colored connectors) visible and four spring born bushings
to adapt the tune and match trimmer rods of the individual insert. The trimmer rods are half
cut off and used to align the rods of the insert with the bushings of the probe base.

2. Align the rods of the insert with the busings of the probe base and lightly press the rods into
the bushings until a click is heard. If the rods don‘t slide easily into the bushing, rotate the
tuning and matching rods a little forward and backward until the rods slide in.

3. Once the rods are inserted, fix the insert using the plastic screws.
70 Z33075_00_001



Gradient Systems and RF Probes
Schematic of a Mini 0.5/0.75 Probe Base and RF Insert

Figure 5.27: Schematic of a Mini 0.5/0.75 Probe Base and RF Insert

Mini 0.5/0.75 AHS-RF

The mounting of the Mini 0.5/0.75 AHS-RF inserts is even simpler compared to the mounting of
a Mini 0.5/0.75 insert, since there are no screws to fix the insert.

1. Align the trimmer rods and the bushings as described in the previous section.

2. Lightly press the rods into the bushings until a click is heard. If the rods don‘t slight easily
into the bushing, rotate the tuning and matching rods a little forward and backward until the
rods slide in.

3. Once the click is heard, the insert must be pushed down until there is no remaining gap be-
tween the flange and the insert.
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5.5 Mini SWB90 System

5.5.1 Overview

Several versions of SWB probes are available in combination with the BGA9SHP gradient/shim
system.

The version of the probe is described on the label at the bottom of the probe.
Probe Version Information

Figure 5.28: Probe Version Information

Nucleus Type Inner Diameter

1H Quadrature 66 mm and 40 mm

X Linear 66 mm and 40 mm

1H/X Linear 66 mm and 40 mm

others On request On request

Temperature Range: -20°C to + 80° C
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The 66 mm 1H Quadrature Probe

Figure 5.29: The 66 mm 1H Quadrature Probe

Bottom Plate of the SWB90 Probe

Figure 5.30: Bottom Plate of the SWB90 Probe
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Knobs for the Tuning and Matching the two RF Channels

Figure 5.31: Knobs for the Tuning and Matching the two RF Channels

Knobs for the Tuning and Matching the two RF Channels

Figure 5.32: Knobs for the Tuning and Matching the two RF Channels

The bottom plate of the probe houses two N-connectors for two RF channels, a Lemo connector
for the hardware information chip (HWIDS) and a clamping mechanics for the fixation of tubes
and samples holders (not included in the probe delivery). Two other N-connectors ate mounted,
but not used and not connected.

Single frequency quadrature probes:

The two RF channels are used to connect the 0° and the 90° RF signals to the quadrature com-
biner/splitter.

Single frequency linear probes

Only the 1H channel is used for the RF connection to the preamplifier.

Double frequency probes

The 1H channel is used for the 1H connection, the X channel is used for the X nucleus.
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5.5.2 Installation and Usage of the Quadrature Combiner

When 1H quadrature probes are used a frequency dependent RF combiner is required to drive
the quadrature coil. This combiner has two different functions during the transmit and receive
modes respectively.

In the transmit mode the unit splits the transmitter excitation pulse into two signals of equal in-
tensity and shifts the phase of one signal by 90°. The two signals are connected to the probe to
channel 0° and 90°. In the receive mode one of the NMR signals is shifted back by -90° and
combined with the NMR signal of 0° phase shift before it is reaching the preamplifier.

Combiner for MICWB40 Quadrature Probes

Figure 5.33: Combiner for MICWB40 Quadrature Probes

The combiner is controlled by the RGP send and receive signals of the preamplifiers. Thus the
combiner needs to be connected to a free connector on the preamplifier flat cable. The combiner
receives its power through this cable.

Note: Incorrect wiring, e.g. swapping the channels leads to a poor signal to noise ratio.
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Connection of the Combiner to the Preamplifiers Flat Band Cable

Figure 5.34: Connection of the Combiner to the Preamplifiers Flat Band Cable

Wobble Mode

To wobble/tune the two RF channels in the quadrature probe, directly connect each channel of
the probe to the preamplifier and wobble/tune each channel individually, before reconnecting the
combiner.

Operation Mode

The RF output of the preamplifier needs to be connected to the combiner input (RF Power IN),
instead of directly to the probe. The probe must be connected to the 0° and 90° connector using
two N connector RF cables of the same length, whereas the correct wiring is essential. Swapped
wiring of the two channels leads to a poor signal intensity.

5.5.3 Cleaning

The cover of the probe can be damaged by some cleaning solutions.

Dry clean whenever possible.

Use mild cleaning solution in small quantities (i.e. ethanol).

Do not use aggressive cleaning solutions, e.g., acetone.

CAUTION

Material Damage Hazard due to Static Electricity

Failure to switch off the preamplifier prior to connecting the combiner to the flat band cable
may result in damage to the cover module.

1. Be sure to disconnect the power cable or switch off the rack before connecting the com-
biner to the flat band cable.
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5.6 Mounting of the SWB Probe

1. Mount the SWB probe at the flange as shown in the picture below.
The 66 mm 1H Quadrature Probe

Figure 5.35: The 66 mm 1H Quadrature Probe

Fixation of the SWB Probes (part 1)

Figure 5.36: Fixation of the SWB Probes (part 1)
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Fixation of the SWB Probes (part 2)

Figure 5.37: Fixation of the SWB Probes (part 2)

2. Mount the sample into the plastic tube and fix it with the brass screws.
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6 ParaVision 5 Software Setup

This chapter only focuses on the micro-imaging dedicated points of the ParaVision 5 software
installation. For general information refer to the set up document ‘PvInstGuide50.pdf’ found in
the root directory of the ParaVision 5 DVD.

6.1 Installation of the ParaVision 5 Software

After mounting the ParaVision 5 DVD, the software installation can be started using the script
‘install’. The standard ‘MRI with acquisition, processing and automation’ option can be selected
for the installation. During the installation only two points need special attention:

▪ ParaVision 5 should always be installed in a ‘ParaVision’ directory, never in a ‘TopSpin’ di-
rectory. This allows ParaVision 5 and TopSpin to be installed parallel on a system, without
any interferences between both.

▪ The NMR super user must not be ‘root’. Always select ‘nmrsu’ as NMR Super User.

After the software installation has finished, typically a reboot of the computer is required. It’s also
a good idea to reboot the console at this time.

6.1.1 Setup of ParaVision 5

ParaVision 5 should be started the first time as NMR super user using the command
<$PvHome>/paravision, where <$PvHome> is the selected installation path. 

cf

ParaVision recognizes that it is being started the first time and automatically opens a dialog,
whereas ‘cf’ (the TopSpin configuration) should be started. This ‘cf’ routine is identical to the orig-
inal TopSpin routine, the only point which is special for micro-imaging is that the BCU20 should
be connected to tty04 in the window, where the serial connections are specified. After ‘cf’ is fin-
ished verify in the protocol created by the ‘cf’ command that the DPP was found connected to
the gradient controller.

expinstall

During ‘expinstall’ (refer to the next figure) be sure to select in the upcoming window:

▪ High Resolution Systems.

▪ Micro-Imaging Systems (installs the TopSpin imaging and diffusion programs).

▪ Biospec/Pharmascan Systems (these are the ParaVision imaging programs).

Leave everything else unaffected and only select ‘OK’ or ‘Next’.
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The expinstall Selection for Micro-imaging Systems

Figure 6.1: The expinstall Selection for Micro-imaging Systems

Creation of standard coil configurations’

In this dialog (accessible after the uxnmr.info window showed up) click ‘Create’ to generate de-
fault coil configurations for single tuned 1H and X probes.

Edit & Save Config

For the ParaVision specific parameters refer to the figure below. On AVANCE III systems typi-
cally only the institute name needs to be changed and the system status adapted to the installed
gradient system (Micro 5 = S019, Micro 2.5 = S040, Mini 0.5/0.75 = S057).
Typical ‘Edit & Save Config’ for Micro-Imaging AVANCE III Systems

Figure 6.2: Typical ‘Edit & Save Config’ for Micro-Imaging AVANCE III Systems
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6.1.2 Setup of the Gradient Timing Resolution

The gradient timing resolution needs to be set up manually. As default, every 10 µsec a new
gradient value is calculated by the DPP and transferred to the Master Unit. This value is used
on BioSpec systems, but on micro-imaging systems, 8 µsec are required due to technical rea-
sons. To change the timing resolution edit the file <$PvHome> /conf /instr /spect /uxnmr.par as
nmrsu and set:

##$GRADRES=8

At the same time the DPPFAC factor in the same file can be set to 1 (not used with the BGMUI-
E/Great hardware).

##$DPPFAC=1

Restart TopSpin/ParaVision and type “ii restart” in the TopSpin command line to restart the DPP.

6.1.3 Micro-imaging Add-on CD

The ‘Micro-imaging Add-on CD’ contains continuously updated features like gradient default
files, additional macros, methods, or au programs. If this CD is not available send an e-mail to
micdiff@bruker.de to receive the CD or a tar file by e-mail.

To install the add-ons:

1. Shutdown ParaVision 5 and be sure to be logged in as NMR-Super User. 

2. Mount the CD.

3. Start the script <$CDROM>/PV5/m_install (or unpack the tar file in e.g. /tmp by the com-
mand ‘tar –xvzf pv5adds.tar.gz /tmp’ and start /tmp/PV5/m_install).

4. Follow the screen instructions.

This will install the additional methods (all additional method names start with mic_), au pro-
grams, macros, protocols, gradient coil default files and the newest diffusion scripts.

The Add-on CD contains the following features:

▪ ParaVision Add-ons [81]

▪ TopSpin Add-ons [83]

6.1.3.1 ParaVision Add-ons

ParaVision Updates (for PV5.0 only)

MapShim: Update for MapShim on BSMS systems.

Routing: Update for the routing editor for systems with QNP switch.

ipsoserver: Fixes a CORBA problem during ‘ii restart’.
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Extra Manuals:

Fast Map, micro-imaging manual and HWIDS manual.

Firmware:

Recommended BGMUI Master Unit and HWIDS firmware.

Methods:

mic_chess: Chemical shift selective spin echo imaging, based on MSME.

mic_flash: Like the original FLASH but with MinEchoTime mode.

mic_msme: Like the original MSME but with MinEchoTime mode.

mic_rare: Like the original RARE but with MinEchoTime mode.

mic_seflow: Spin Echo velocity imaging (see FLOWMAP manual for details).

mic_gradcalc: Calculation of the gradient calibration.

mic_inverse: Cyclic cross polarization 13C imaging/spectroscopy.

mic_jpress: J-resolved 2D localized spectroscopy.

mic_lcosy: 2D localized COSY spectroscopy.

mic_preemp: Traditional preemphasis adjustment method.

Protocols:

mic_chess: Chemical shift selective imaging protocol.

mic_flash_3D: 3D gradient echo imaging protocol.

mic_flash_ortho: 3 orthogonal slice, gradient echo.

mic_flash_ortho_multislice: 5 parallel slices from 3 ortho. Planes, gradient echo.

mic_msme_1e_ortho: 3 orthogonal slice, single spin echo.

mic_msme_8e_ortho: 3 orthogonal slice, 8 spin echoes from each slice.

mic_rare_32e_3D: 3D RARE protocol, 32 echoes per scan.

mic_rare_32e_ortho: 3 orthogonal slices, RARE sequence 32 echoes per scan.

mic_spinecho_3D: 3D spin echo protocol.

POSITION_Z_40mm: Positioning protocol, FOV is 40 mm in Z direction.

Shim_SWH_30k_td4k: Shim protocol, bandwidth 30 kHz, 4096 points per FID.

snapshot_FISP_cine_16fr: Cine protocol based on FISP, 16 cine cycles.

snapshot_FISP_T1inv: T1 Inv. Rec. protocol based on FISP in FID mode.

True_FISP_T1inv: T1 Inv. Rec. protocol based on FISP in TRUEFISP mode.

Macros:

mic_CalcRFAmp: Calculate the pulse power for shaped pulses from a hard pulse.

mic_convert_2dseq2csv_multi: Convert all slices of a data set to cvs.

mic_convert_2dseq2csv_scale: Convert a parameter image to float csv.

mic_Derive_X: Derivation of an image along X.

mic_Derive_Y: Derivation of an image along Y.

mic_multigop: Start multiple experiments (clone or prepared data sets).

mic_rheo: Control for the Rheo controller.
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mic_setpre: Start Setpre in hardware mode, not in cache mode (default in PV).

mic_rfTest: SNR and z B1 calculation for the standard SNR procedure.

AU programs:

CreateScaledCSV: Used by the macro mic_convert_2dseq2csv_scale.

m_teready: Used by the macro mic_multigop.

Lock Up tables:

mic_flow_black: LUT optimized for flow imaging, velocity 0 is black.

mic_flow_white: LUT optimized for flow imaging, velocity 0 is white.

mic_grey_nonLin20: Non linear grey LUT to improve contrast.

mic_grey_nonLin50: Non linear grey LUT to improve contrast.

mic_grey_nonLin80: Non linear grey LUT to improve contrast.

mic_ParameterImg: LUT for parameter images, e.g. T2 maps.

6.1.3.2 TopSpin Add-ons

TopSpin AU Imaging Programs:

Imadd; imcti; imflow; imft3d; imftms; imge3d; imgess; imgrad; impoff; impoff3d; impon; improve;
imse3d; imsems; imsesshs; imslice: AU programs for imaging experiments in TopSpin.

6.1.4 Installation of RF Inserts Specific Parameters

For each MicWB40, insert a CD containing routing and power limit information for this individual
coil (HWIDS) is delivered. All CD‘s need to be installed on the system to allow the user, to select
the RF insert in use from the software dialog.

The procedure to install the parameters is described in the document
‘Microimaging_RFInsert_Installation.pdf’, which can be found on every CD.
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HWIDS Data File CD for Each Individual MicWB40 Insert

Figure 6.3: HWIDS Data File CD for Each Individual MicWB40 Insert

6.1.5 License File Installation and Troubleshooting

ParaVision 5 needs a floating license for ParaVision 5 and for TopSpin 2 to run properly. This
requires the correct entries in the license file and 2 license daemons running. The installation is
described in the ParaVision 5 manual, thus here only the most important issues and a few tips
about troubleshooting will be presented.

The license file is installed in /usr/local/flexlm/Bruker/licenses/license.dat. The following lines
are an example of some lines of a ParaVision 5 license file.

1

2

3

4

5

6

7

8

9

10

11

12

SERVER image501 001018142992 1700

DAEMON bruker_ls /usr/local/flexlm/Bruker

DAEMON bbmri_ls /usr/local/flexlm/Bruker

INCREMENT PVSTARTUP bbmri_ls 5.000 15-oct-2010 1 \

ISSUER=00304870aa811e1fIIIoImCFgjjZIIoIoHoSPjjF4E6QK5Qw4i \

SIGN="00E2 128C 12FB 664E FE52 400A 8C3B F400 13F0 8936 AFB7 \

D229 22D4 8D0C B98E"

INCREMENT PVDATMAN bbmri_ls 5.000 15-oct-2010 1 \

ISSUER=00304870aa811e1fIIIoImCFgjjZIIoIoHoSPjjF4ExKQ9K3i \

SIGN="0016 3A78 39C8 133F 6E50 77D1 5D73 4500 4384 3942 A58F \

AC94 FADE 335D 0BB6"

…
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1st Line: The entry ‘image501’ must be the name of the computer, identical to the output of the
command ‘hostname’. ‘hostname –f’ must deliver the full qualified domain name, e.g.
‘image501.service.bruker.de’. If this behavior is different on the computer, check the network
setup. Be sure that the case of the computers name is correct. The best solution is to keep ev-
erything in lower case letters, since some Windows based DHCP servers only return the name
in lower case.

1st Line: The entry after the computer name must be the eth0 MAC address of the computer.
This MAC address is in the output of the command ‘/sbin/ifconfig eth0’ and can be found after
the key word ‘HWaddr’ (i.e. HWaddr 00:10:18:14:29:92). The network port where the license is
accessed is 1700.

2nd and 3rd Line: The license daemons and where they can be found. These 2 daemons always
need to run, otherwise the licenses are not activated. To check if they are running enter ‘ps -ef
| grep _ls’, and the output should be like:

flexlm 2811 2805 0 Mar20 00:00:00 bruker_ls -T image501 9.2 3 -c /usr/local/flexlm/Bruker/li-
censes/license.dat -p --lmgrd_start 47e23a1a
flexlm 2812 2805 0 Mar20 00:00:00 bbmri_ls -T image501 9.2 3 -c /usr/local/flexlm/Bruker/li-
censes/license.dat -p --lmgrd_start 47e23a1a

If one or both processes are missing, check if the daemon executable‘s are in the correct direc-
tory and have the correct attributes:

/usr/local/flexlm/Bruker/bbmri_ls  r-xr-xr-x 
/usr/local/flexlm/Bruker/bruker_ls  r-xr-xr-x

If this is the case, try to restart the daemons using the command ‘/etc/init.d/bruker_lmgr restart’,
and check the log file /usr/local/flexlm/Bruker/licenses/flexlm.log for possible problems.

5th Line: This is the license part for a feature, in this case ‘PVSTARTUP’. The next entry
‘bbmri_ls’ indicates that this feature needs the ‘bbmri_ls’ license daemon to run. The following
number ‘5.000’ is the ParaVision version, for which this license feature is valid, and hereafter
the date of expiry can be found (‘15-oct-2010’). The final ‘1’ indicates, that this is a floating li-
cense (node locked licenses are no longer generated).
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7 Gradient System and Amplifier 
Setup

The exact setup of the gradient systems and gradient amplifiers are prerequisite for distortion
free and geometrically precise images, as well as correct diffusion values. Since the Great gra-
dient amplifier is a current regulated amplifier, its regulation parameters need to be adapted to
each individual coil. The gradient coil is assembled extremely precisely, however even the
smallest misalignment of individual gradient coil parts causes unwanted distortions in the sys-
tem, which need to be compensated. Finally, the correct absolute gradient strength at a given
current is mandatory for the display of the exact dimensions of an object. Thus the setup of the
gradient amplifiers and the gradient coils are split into different parts. Each part must be repeat-
ed for every available gradient system/gradient amplifier combination. The complete setup must
be performed, even for different maximum current output stages of the Great amplifiers.

The retrieved parameters for a gradient amplifier/coil combination are entered in ‘setpre’, the
gradient parameter program and stored in a gradient coil specific file in <$PvHome>/exp/stan/
nmr/lists/preemp/<SystemStatus>/default. <SystemStatus> is the status, which is selected in
“Edit&Save Config”, see Setup of ParaVision 5 [79]. As a consequence, whenever the gradient
coil is changed the ‘System Status’ in “Edit&Save Config” must be set to the corresponding val-
ue, to enable ParaVision to load the correct coil specific gradient amplifier/ coil parameters.

The ‘setpre’ is the same in ParaVision and TopSpin, however it behaves differently in each
mode, which often results in confusion. Here are the main differences between the TopSpin and
ParaVision Mode:
Different ‘setpre’ Behavior in ParaVision and TopSpin Mode.

Table 7.1: Different ‘setpre’ Behavior in ParaVision and TopSpin Mode.

ParaVision Mode TopSpin Mode

Parameters dis-
played at ‘setpre’ 
Startup:

Always be sure to select File->Read Default’ 
when entering the PV mode.

The parameters which are currently set in 
the hardware, not the values in the ‘default’ 
file.

Displayed System 
Status:

‘System Status’ from ‘Edit&Save Config’. The ‘edhead’ number of the selected probe.

Location for the 
file storage:

<$PvHome> /exp /stan /nmr /lists /preemp /
<SystemStatus> /default

<$PvHome> /exp /stan /nmr /lists /preemp /
<#edhead> /default

Parameter Upload 
to the Hardware:

When the arrow ‘Upload into Hardware’ in 
the ‘setpre’ GUI is clicked.

If a ParaVision experiment runs and the pa-
rameter ‘GS_typ’ is set to ’Preemphasis’, 
ParaVision automatically loads the ‘setpre’ 
values to the hardware whenever neces-
sary.

Immediately when a parameter is changed.

‘setpre’ Start: Spectrometer Control Tool->Tools Preem-
phasis or TopSpin Command Line:

‘setpre –cache –system SystemStatus [-de-
bug]’

[-debug] option for more info in 
<$PvHome>/prog/log/setpre.log

TopSpin Command Line:

setpre [-debug]

[-debug] option for more info in 
<$PvHome>/prog/log/setpre.log
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Before the adjustments can be started, the desired current output stage for the Great Amplifiers
must be set. The stage defines the max. output current at 100% input signal. Typically in imaging
the highest possible stage is set (40 A for the Great 40 or 60 A for the Great 60), but for diffusion
probes or to operate HR gradient probes, it might be necessary to lower the maximum output
current of the amplifiers.

To set the output stage: Open ‘setpre’ by selecting ‘SpectrometerControlTool →Tools →Adjust
Preemphasis Values’. For this procedure, any data set can be selected. Since ‘setpre’ is the
same piece of software in ParaVision and in TopSpin, the ‘setpre’ window opens in the TopSpin
window.

At the current stage drop down selection, select the desired output stage (blue mark in the figure
below) and store the setting by ‘SetPre->File->Write default’ before closing ‘setpre’.
Setpre in TopSpin Window, the Output Current Stage Selector Marked in Blue.

Figure 7.1: Setpre in TopSpin Window, the Output Current Stage Selector Marked in Blue.
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7.1 Gradient Safety Parameters

In order to avoid hardware damages to the gradient coil from too much gradient power, the ap-
plied electrical energy is monitored and compared with coil specific values. The monitoring is
performed by the Master Unit using the current and voltage monitoring signals from the GREAT
amplifiers which are AD converted (25 µsec dwell time) and used by a DSP for the power cal-
culations.

Since this security is essential, the master unit stops its booting process and displays a ‘C01’
message, while it waits for the power limits for the selected system status.

These parameters have to be entered in the ‘setpre’ program and downloaded into the Master
Unit each time the gradient system is changed or the Master Unit was switched off. 

To enter the values open ‘setpre’ by clicking ‘SpectrometerControlTool →Tools →Adjust Preem-
phasis Values’. The ‘setpre’ opens in the TopSpin window. Note the additional ‘SetPre’ menu en-
try in the TopSpin Window which allows accessing the setpre parameters (red mark in the figure
below).

To open the dialog for the safety parameters (gradsafe) select ‘SetPre →Edit →Gradient safety
parameters’.
GradSafe Dialog to Enter the Gradient Safety Parameters

Figure 7.2: GradSafe Dialog to Enter the Gradient Safety Parameters
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Parameters

Table 7.2: Parameters

The parameters for the individual gradient systems can be found in chapter Typical Gradient-
Setpre Parameters [179]. These values must not be exceeded! Typically the same power limits
are used on all three gradient channels.

If the “micro-imaging Add-on CD” is installed as described in the sectionMicro-imaging Add-on
CD [81], the safety parameters already have the default values. If the parameters are changed
be sure to save the values with ‘SetPre →File →Write default’ before closing ‘setpre’.

As described above, the master unit stops with the boot process and displays a ‘C01’ message,
until the ‘gradsafe’ parameters are loaded. There are several possibilities to load these param-
eters:

See also

 Loop Regulation Adaptation [92]

Max. Voltage [V]: Maximum output voltage of the amplifier

Max. Current [I]: Maximum current for the selected gradient system.

Coil Resist. [Ω]: DC resistance of the individual gradient coil.

Power Sum [W]: Maximum power applied to the complete gradient sys-
tem within 1 second (Eq. 2‑1 [20] on page 2-3 [20]).

Mean Sum [W]: Maximum power applied to one gradient direction within 
1 second (Eq. 2‑2 [20] on page 2-3 [20]).

Adj. Integ. Time [ms]: Time interval for a short term power monitoring.

Integ. Time Power Sum [W]: Maximum power applied to the complete gradient sys-
tem within ‘Adj. Integ. Time’ (Eq. 2‑1 [20] on page 2-3 
[20]).

Integ. Time Mean Pow. [W]: Maximum power sum applied to one gradient direction 
within ‘Adj. Integ. Time’ (Eq. 2‑2 [20] on page 2-3 
[20]).

Note: 

The equations for determining these parameters can be found in Security Features [20].

In ParaVision: a) ParaVision automatically downloads the ‘gradsafe’ parameters from 
the default file at each experiment start (GSP/GOP/TrafficLight).

b) A manual download is possible when ‘setpre’ is opened and the ‘Up-
load into Hardware’ arrow is clicked, or when ‘Apply’ in the ‘gradsafe’ di-
alog is selected.

In TopSpin: a) Only the manual download is possible. Open ‘setpre’ and select ‘Ap-
ply’ in the ‘gradsafe’ dialog.
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7.2 Great Offset Adjustment

Each gradient amplifier has a small DC offset, which should be compensated. This can be done
under software control with the Great 1/40 and Great 1/60.

To compensate the offset, open ‘setpre’ in the TopSpin window, by clicking Spectrometer Control
Tool →Tools →Adjust Preemphasis Values. Please recognize the additional ‘SetPre’ menu entry
in the TopSpin menu bar which allows accessing the setpre parameters (red mark in the figure
below).
Setpre in TopSpin with Marked Offset Adjustment Features.

Figure 7.3: Setpre in TopSpin with Marked Offset Adjustment Features.

For Great 1/60 amplifiers W1209612 ECL≥9 or W1215323 ECL≥0, and for Great 1/40 amplifiers
W1211690 ECL≥5, or W1215322 ECL≥0 the offset adjustment is very simple. If the internal
blanking is used (gating for the Greats from the master unit) nothing has to be rewired. When
the external blanking is used (gating of the Greats from the IPSO T0 connector), the BNC cables
at the Great gating inputs need to be disconnected temporarily. The ‘Coarse Offset’ for the
above mentioned amplifier generation is always 0, so after selecting the desired amplifier by the
channel pull down menu (blue mark in figure above) (x/y/z-Preemphasis) the offset can be au-
tomatically adjusted by clicking the ‘Auto’ button. The offset must be adjusted for each gradient
direction individually.

If the ECL of the amplifiers is lower than the above mentioned, the ‘coarse offset’ must be ad-
justed before the ‘Fine Offset’ can be adjusted. For this reason, a data set needs to be set up.
Refer to the ParaVision Manual ‘System Control Tool -> Help -> Getting Started’ for details about
the data set creation.
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Parameters Setup for the Great Offset Adjustment

Table 7.3: Parameters Setup for the Great Offset Adjustment

1. Disable the Great amplifiers by disconnecting the gradient cable from the gradient probe.

2. Shim the sample as good as possible in GSP mode. The easiest way to shim is to observe
the integral of the FID and note this value, when the shimming is finished.

3. Reconnect the gradient probe and be sure that the master unit enables the Great amplifiers
(Reset button…).

4. Restart the GSP, the FID will decay faster and the integral of the FID will be smaller due to
the DC offset of the amplifiers, which acts as linear shims.

5. Adjust the coarse offset of all channels. Select the desired amplifier by the channel pull down
menu (blue mark in the previous figure, x/y/z-Preemphasis) and change the coarse offset
for the selected amplifier until the FID integral becomes maximal (like shimming). 

Typically these ‘Coarse Offset’ values are between -4 and -6. If the coarse offset adjustment
is performed for all amplifiers, the experiment can be stopped.

6. Adjust the fine offset by selecting the desired amplifier by the channel pull down menu (blue
mark in the previous figure) (x/y/z-Preemphasis) and automatically adjust the offset by click-
ing the ‘Auto’ button for each individual gradient direction.

7. As soon as the adjustment is finished for all directions are sure to save all the values with
‘SetPre->File->Write default’ before closing ‘setpre’.

7.3 Loop Regulation Adaptation

Create a new data set. The recommended setup parameters for the Great loop adaptation are
listed in the table below.
Parameters Setup for the Great Loop Adaptation

Table 7.4: Parameters Setup for the Great Loop Adaptation

NMR Sample: 5 or 10 mm NMR Tube filled with 20% H2O 
80% D2O and 1g/l CuSO4 or another T1 
shortening relaxant. Filling height 40...50 mm.

Data Set Name: GreatSetup

Protocol Name: m_installation/mic_ampoffset

Recommended Coil Routing: "Transceiver 1H 100W"

Frequency BF1: On resonance.

Shim: Line width <20 Hz at 50% amplitude, Greats 
disabled.

RF Gain: <<90°

Receiver Gain: ---

NMR Sample: ---

Data Set Name: GreatSetup

Protocol Name: m_installation/mic_blankcheck

Recommended Coil Routing: "Transceiver 1H 100W"

Frequency BF1: ---

Shim: ---

RF Gain: ---

Receiver Gain: ---
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Be sure to have the correct system status selected in ‘Edit & Save Config’.

The protocol will load a parameter set, which runs a 1 msec gradient with equal polarity on all 3
gradient channels every 450 msec.

It is recommended to check the currently set parameters before the adjustment is started.

1. Open ‘setpre’ by selecting SpectrometerControlTool →Tools →Preemphasis Adjustment.

2. Verify that the system status in setpre is the same as the select system status in ‘Edit&Save
Config’ (green mark in the figure below).

The setpre’ in TopSpin for the Loop Adaptation

Figure 7.4: The setpre’ in TopSpin for the Loop Adaptation

3. Check the ramp time and rise time for the selected gradient coil by opening SetPre →Edit
→Ramp parameters. The values should be set to those listed in the table Typical Gradient-
Setpre Parameters [179].

4. When the values need to be modified, be sure to select SetPre →File →Write default.

When the “micro-imaging Add-on CD” is installed as described in Micro-imaging Add-on CD
[81], the parameters already have their default values.
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Ramp Parameter Dialog. The Parameter ‘Time’ is the Ramp Time

Figure 7.5: Ramp Parameter Dialog. The Parameter ‘Time’ is the Ramp Time

5. Check the loop values in the last 2 lines of the ‘setpre window’ (see yellow mark in the setpre
figure). These lines are only visible in ‘setpre’ after they are enabled under ‘SetPre →Op-
tions →Loop Parameters when logged-in using the NMR super user password. There are 3
parameters which are responsible for the adaptation, whereas one, the Impedance, is al-
ways set to ‘HIGH’.

6. Check the ‘Resistors’ and ‘Capacitors’ parameters, which are derived from an analog PID
regulator. The values, which are displayed for the selected gradient system, should not differ
too much from the default values in the table Typical Gradient-Setpre Parameters [179],
since they are tested for a long time. Small changes might be necessary for the individual
gradient system.

7. Find the optimum adaptation by selecting a gradient direction in the blue marked pull down
menu (x/y/z Preemphasis) and connect an oscilloscope to the ’I-Mon’ current monitor of the
selected amplifier (be sure not to connect the scope to the ‘U-Mon’ voltage monitor), which
triggers in ‘Norm’ mode.

8. As soon as everything is set up as described, the experiment can be started by the ‘GSP’
button in the spectrometer Control Tool. 

The shape of the gradient must be checked on the oscilloscope, while the resistors and capac-
itors sliders are manipulated. Going to higher values for resistors and capacitors leads to longer
current rise times (see the following figure), the desired current might not even be reached.

NOTICE

Material Damage Hazard Due to Amplifier Oscillation

Be aware that too small values for the ‘Resistors’ and ‘Capacitors’ might cause the amplifier
to oscillate, which kills the gradient coil within milliseconds. If you have an unknown gradient
system be sure to start from high values for ‘Resistors’ and ‘Capacitors’, going down to find
the optimum adaptation
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Gradient Pulse with High “Resistors/Capacitors” Values, Leading to a Slow Regulation Behavior.

Figure 7.6: Gradient Pulse with High “Resistors/Capacitors” Values, Leading to a Slow Regulation Behav-
ior.

Going to smaller values decreases the rise time of the gradient shape, which may lead to an
overshoot of the current (see the next figure). If the values are lowered even more, the amplifier
might start to oscillate!
Gradient Pulse with low “Resistors/Capacitors” Values, Leading to a Current Overshoot

Figure 7.7: Gradient Pulse with low “Resistors/Capacitors” Values, Leading to a Current Overshoot

The best regulation values are those, where the overshoot just begins. With these values, no
overshoot appears and on the other hand the values guarantee the fastest possible rise time.
Optimal adaptation is shown in the next figure.
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Optimal Adjusted Loop Values Leading to the Fastest Raise Time without Current Overshoot

Figure 7.8: Optimal Adjusted Loop Values Leading to the Fastest Raise Time without Current Overshoot

The optimal values have to be adjusted for all gradient amplifiers and all gradient systems. How-
ever, for one gradient system the values for x, y, and z will not differ much. If the adaptation is
finished for each individual direction of a gradient system, be sure to save all the values with
‘SetPre →File →Write default’ before closing ‘setpre’.

7.4 Preemphasis Adjustment

The preemphasis of each individual direction of a gradient system needs to be setup carefully
to acquire distortion free images with the highest possible signal to noise ratio. Preemphasis dis-
tortions can result in stripes in multi echo images, ghosts in multi gradient echo images or broad
lines in NMR spectra.

To adjust the preemphasis of a gradient system, create a new data set. The recommended setup
parameters for the preemphasis adjustment can be found in the table below.

Be sure to have the correct system status selected in ‘Edit & Save Config’.
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Parameters Setup for the Great Preemphasis Adjustment

Table 7.5: Parameters Setup for the Great Preemphasis Adjustment

The protocol will load a parameter set, which runs a 50 msec gradient with 33% of the maximum
current on the X/Y/Z gradient channels every 450 msec. The time between the gradient and RF
is incremented 8 times from 300 µsec to 300 msec to visualize the effect of residual magnetic
fields by eddy currents on the FID. As a consequence, it takes 8*450 msec to shows the result
of the measurement.
Preemphasis Experiment with Varying Delays Between Gradient and RF Detection.

Figure 7.9: Preemphasis Experiment with Varying Delays Between Gradient and RF Detection.

As a prerequisite, the loop parameter of the gradient system/amplifier must be set correctly for
the Preemphasis Adjustment [96].
1. Open ‘setpre’ select Spectrometer Control Tool →Tools →Adjust Preemphasis Values’.

2. Check the ‘System Status’ in ‘setpre’ to be the same as the select system status in ‘Edit &
Save Config’ (green mark in the figure below).

NMR Sample: 5 or 10 mm NMR tube filled with 20% H2O, 80% 
D2O, and 1g/l CuSO4 or another T1 shortening 
relaxant. Filling height 40...50 mm.

Data Set Name: Great setup

Protocol Name: m_installation/ mic_preemp_50msec_33pc_X/
Y/Z

Recommended Coil Routing: Transceiver 1H 100W.

Frequency BF1: 1000 Hz offset from resonance frequency.

Shim: Line width <20 Hz at 50% amplitude.

RF Gain: <<90°

Receiver Gain: ---
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The setpre in TopSpin for the Preemphasis Adjustment

Figure 7.10: The setpre in TopSpin for the Preemphasis Adjustment

3. Check and modify the preemphasis values as necessary in the first 6 lines of the ‘setpre win-
dow’ (see yellow mark in the figure above). 

The parameters are always formed from 2 lines that describe an exponential current decay,
which is added to the actual gradient shape (see the following figure). In this configuration, three
exponentially decaying currents (if GRADRES is ≥10.0 µsec (see Setup of the Gradient Timing
Resolution [81]), 6 time constants are available) with individual amplitudes and time constants
can be added to the gradient shape, to compensate for eddy currents with different amplitude
and decay behavior. The ‘Time Base’ in front of each amplitude/current slider pair limits the lon-
gest possible time constant for this exponential decay. For example, a compensation term with
“Time=1msec” and “Gain=10%” adds an exponentially decaying current with an amplitude of
10% of the gradient amplitude. The 10% amplitude is decayed to 1/e (approx. 36%) after 1
msec.
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A Gradient Shape (black) with 1 Preemphasis Term (red) 

Figure 7.11: A Gradient Shape (black) with 1 Preemphasis Term (red) 

The goal of this adjustment is to have all 8 FID‘s acquired with the above preemphasis protocol
look the same, and respectively to have the same FID integral. It can be said, that after 300
msec no eddy current is present any longer. So the most right FID is the reference to which all
other FID‘s need to be adapted.

1. Select a channel to adjust in the blue marked (see the setpre figure) pull down menu (x/y/Z-
Preemphasis).

2. Be sure to have the protocol with the same gradient direction loaded and start the setup pro-
cedure using the GSP button.

Since all FID‘s are acquired at different delays after the gradient, the influence of the residual
eddy currents on the FID‘s after different times can be observed. In this protocol, the FID‘s are
acquired after exponentially increasing delays which are 0.3 ms, 0.8 ms, 2.15 ms, 5.8 ms, 15.5
ms, 41.7 ms, 111.8 ms, and 300 ms. So if for example, the first 4 FID‘s show a different shape/
integral compared to the FID acquired after 300 msec, the compensation term might need a
‘Time’ of about 4-5 msec. To find the correct amplitude of the compensation term, the ‘Gain’ val-
ue is modified in small steps and the influence of the term to the FID‘s is observed (even small
steps can make a huge effect on the signal). Be aware that the new preemphasis values are
only uploaded into the hardware, all 8 FID‘s have been acquired.

One criterion on how good a preemphasis adjustment is, can be the difference of the integrals
of the 8 individual FID‘s. To check the integrals, increase the information area under the acqui-
sition display of ParaVision by dragging & dropping the line between the signal display and the
info display. The difference in the integrals should be <15% for a well adjusted gradient system.

At the beginning of the adjustment, the differences in the integral might be much larger (see the
next figure), but on very good gradient systems it is already in this range.
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Preemphasis Experiment without Preemphasis Compensation

Figure 7.12: Preemphasis Experiment without Preemphasis Compensation

After the adjustment, all FID‘s should have almost the identical shape and integral. Often it is
impossible to adjust the first 2 FID‘s to perfection, so some compromise has to be accepted. The
following figure shows typical FID data after the adjustment.
Preemphasis Experiment after the Adjustment. 

Figure 7.13: Preemphasis Experiment after the Adjustment. 

In the figure above the first 2 FID‘s are still a bit smaller than the others.

However, even this result might not be reachable by adjusting the x/y/z-preemphasis. If this as
the case, the gradient system might need cross preemphasis. This means that switching, for ex-
ample, a gradient along the x-direction causes an eddy current in the y-direction. To compensate
for these effects, the cross preemphasis terms need to be adjusted in the same way as the direct
preemphasis was done. In the above example, the ‘x → y cross preemphasis’ would need to be
adjusted. This can be done by selecting ‘X→Y Cross Preemphasis’ in the blue marked (see set-
pre figure) pull down menu.

After the adjustment, all parameters must be stored using SetPre →File →Write default.

See also

 Loop Regulation Adaptation [92]
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7.5 B0 Adjustment

The B0 and preemphasis adjustments are very similar. As opposed to the preemphasis, where
first order field distortions need to be compensated, the B0 adjustment compensates for zero
order field distortions, what are identical to a field shift and thus in a shift of the NMR signal
phase.

The recommended setup parameters for the preemphasis adjustment are shown in the table be-
low. Be sure to have the correct system status selected in ‘Edit & Save Config’.
Parameter Setup for the Great B0 Adjustment

Table 7.6: Parameter Setup for the Great B0 Adjustment

This protocol will load a parameter set, which runs a 50 msec gradient with 33% of the maximum
current on the X/Y/Z gradient channels every 450 msec. The time between gradient and RF is
incremented 8 times from 300 µsec to 300 msec to visualize the effect of shifted magnetic fields
by eddy currents on the FID. As a consequence, it takes 8*450 msec to shows the full result of
the measurement. The only difference to the preemphasis experiment in the section Preempha-
sis Adjustment [96] is that the signal is observed on-resonance.
B0 Experiment with Varying Delays Between Gradient and RF-Detection.

Figure 7.14: B0 Experiment with Varying Delays Between Gradient and RF-Detection.

In the figure above, the difference to the preemphasis experiment is that the signal is observed
on-resonance.

NMR Sample: 5 or 10 mm NMR tube filled with 20% H2O, 
80% D2O, and 1g/l CuSO4 or another T1 
shortening relaxant. Filling height 40...50 mm.

Data Set Name: Great Setup

Protocol Name: m_installation/ 
mic_preemp_50msec_33pc_X/Y/Z

Recommended Coil Routing: Transceiver 1H 100W.

Frequency BF1: On resonance.

Shim: Line width <20 Hz at 50% amplitude.

RF Gain: <<90°

Receiver Gain: ---
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As a prerequisite, the loop parameters of the gradient system/amplifier must be set correctly for
the B0 adjustment (see Loop Regulation Adaptation [92]).
1. Open ‘setpre’ by selecting Spectrometer Control Tool →Tools → Adjust Preemphasis Val-

ues.

2. Check the system status in setpre to be the same as the select system status in ‘Edit & Save
Config’ (green mark in the figure below).

3. Check the Ramp and Rise Time parameters of the selected gradient coil by opening SetPre
→Edit →Ramp parameters and set the values to the value listed in Typical Gradient-Setpre
Parameters [179].

4. When the values need to be modified, be sure to save them by SetPre →File →Write de-
fault.

The setpre’ in TopSpin for the B0 Adjustment

Figure 7.15: The setpre’ in TopSpin for the B0 Adjustment

When the “micro-imaging Addon CD” is installed as described in the section Micro-imaging
Add-on CD [81], the parameters already have their default values.
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5. Check and modify the B0 values as necessary in the first 6 lines of the ‘setpre window’, see
yellow mark in the figure above, when the B0 is selected in the blue marked (in the figure
above) drop down window of ‘setpre’. B0 selections are X→B0 (the effect of an x gradient
on B0), Y→B0 (the effect of a y gradient on B0), and Z→B0 (the effect of a z gradient on B0)
but not B0→X/Y/Z!

Two lines always form the parameters which describe an exponentially decaying current, which
is added to the H0 coil current by the B0-2 compensation unit (see the following figure). In this
configuration, three exponentially decaying currents (if GRADRES is ≥10.0 µsec (see Setup of
the Gradient Timing Resolution [81]) 6 time constants are available) with individual amplitudes
and time constants can be added to the H0 coil, to compensate for eddy currents with different
amplitude and decay behavior. The ‘Time Base’ in front of each amplitude/current slider pair lim-
its the longest possible time constant for this exponential decay. For example, a compensation
term with “Time=1msec” and “Gain=10%” adds an exponentially decaying current with an am-
plitude of 10% of the maximum. The 10% amplitude is decayed to 1/e (approx. 36%) after 1
msec.
A Gradient Shape (black) and the Generated B0 Compensation Terms (red) that are Added to the H0 Coil 

Figure 7.16: A Gradient Shape (black) and the Generated B0 Compensation Terms (red) that are Added to the H0 Coil 

The goal of this adjustment is to have the phase of all 8 FID‘s acquired identical with the above
experiment. It can be said, that after 300 msec no eddy current is present any longer. So the far
right FID shows the reference phase, to which all other phases need to be adapted. To see the
phase difference clearly, the acquisition display should be set to unshuffled.

Select a B0 channel to adjust in the blue marked (see setpre figure) pull down menu (x/y/z→B0),
be sure to have the protocol with the same gradient direction loaded and start the setup proce-
dure by the GSP button.

Since all FID‘s are acquired after different delays behind the gradient, the influence of the resid-
ual eddy currents effecting the phases of the FID‘s after different times can be observed. In this
protocol, the FID‘s are acquired after exponentially increasing delays which are 0.3 ms, 0.8 ms,
2.15 ms, 5.8 ms, 15.5 ms, 41.7 ms, 111.8 ms, and 300 ms. So if, for example, the first 4 FID‘s
show a different phase compared to the FID phase acquired after 300 msec, the compensation
term might need a ‘Time’ of about 4-5 msec. To find the correct amplitude of the compensation
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term, the ‘Gain’ value is modified in small steps and the influence of the term to the phase of the
FID is observed (even small steps can make a huge effect on the signal). Be aware that the new
B0 values are only uploaded into the hardware, when all 8 FID‘s have been acquired.

Unfortunately, there is no numerical criterion like the integral in preemphasis adjustment, so the
adjustment really has to be done ‘by eye’. At the beginning of the adjustment, the differences in
the phase might be large (see the following figure), but on very good gradient systems the phas-
es might be already (almost) identical with zero settings.
B0 Experiment without B0 Compensation (unshuffled display).

Figure 7.17: B0 Experiment without B0 Compensation (unshuffled display).

After the adjustment, all signals should have almost identical phases. Often it is impossible, to
adjust the first 2-3 FID‘s to perfection, so some compromise has to be accepted. The following
figure shows typical data after the adjustment.
Signal after B0 Compensation (unshuffled display).

Figure 7.18: Signal after B0 Compensation (unshuffled display).

In the figure above, the first FID‘s are still show a slightly different phase.

After the adjustment, all parameters must be stored using SetPre →File →Save as Default.
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7.6 Gradient Calibration

In order to provide images with correct field of view (FOV), slice thickness (SLTH), slice position
and diffusion coefficients, ParaVision needs information about the gradient sensitivity and the
maximum current, which are supplied by the gradient amplifiers. Other parameters for correctly
scaled images are the relative gradient sensitivities between the X, Y and Z-gradients, caused
by differences in design and production of the gradient system and the amplifiers.

The calibration must be performed when:

▪ the probe and gradient amplifiers are installed the first time,

▪ when the gradient system or an amplifier is exchanged, or

▪ when another output gain stage at the Great amplifiers is selected.

Like all other gradient parameters, the calibration parameters are entered in ‘setpre’ and the sys-
tem specific status stored in the file <$PvHome>/exp/stan/nmr/parx/preemp/<SystemStatus>/
default. The parameters from this file are loaded automatically every time a new data set is cre-
ated and/or an acquisition is started in ParaVision.

The calibration values are determined by imaging objects with a well defined geometry, for ex-
ample a LEGO or nylon screws. These objects are acquired in an axial, sagital and coronal im-
age. From the acquired images the dimensions in the phase direction are extracted, since this
direction doesn’t show any image distortions caused by bad shimming.

Two experiments must be setup to acquire the images for the geometry measurement.

1. Create two data sets.

2. Set up the recommended parameters for the imaging experiments in the following table.

3. Adapt the FOV of the protocol to be slightly larger than the object by the help of the ‘Geom-
etry Editor’.

Parameter Setup for Gradient Calibration

Table 7.7: Parameter Setup for Gradient Calibration

After the two data sets are acquired, the images must be transferred into XTip. The
‘mic_gradcalib_xy’ protocol acquires 2 axial images, where the mic_gradcalib_z acquired one
coronal image. From these images, the dimensions have to be measured in XTip by the tool:

Be sure to have the correct system status selected in ‘Edit & Save Config’.

NMR Sample: Geometrically well defined object in an NMR 
tube filled with 20% H2O, 80% D2O, and 1g/l 
CuSO4.

Data Set Name: Great Setup.

Protocol Name: m_installation/mic_gradcalib_xy
m_installation/mic_gradcalib_z

Recommended Coil Routing: Transceiver 1H 100W.

Frequency BF1: On resonance.

Shim: As good as possible.

RF Gain: Auto Reference Gain must be defined.

Receiver Gain: Auto Receiver Gain.
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Example images of the LEGO are shown in below:
Calibration Images of the LEGO. 

Figure 7.19: Calibration Images of the LEGO. 

In the figure above:

Left image: Image 1/2 acquired by mic_gradcalib_xy to measure the x dimension (left-right) .

Middle image: Image 2/2 acquired by mic_gradcalib_xy to measure the y dimension (top-bot-
tom).

Right image: Image 1/1 acquired by mic_gradcalib_z to measure the z dimension (top-bottom).

The sizes of the above 2x2 LEGO is 15.8 mm in x and y direction. The height of each individual
LEGO is 9.55 mm.

Another sample for smaller RF coils is a M4 nylon screw in a 5 mm NMR tube where it fits in
smoothly. An example of the image series acquired from the M4 nylon screw is shown in the
figure below:
Fig. 5-20: Calibration Images of a M4 Screw. 

Figure 7.20: Fig. 5-20: Calibration Images of a M4 Screw. 

In the figure above:

Left image: Image 1/2 acquired by mic_gradcalib_xy to measure the x dimension (left-right).

Middle image: Image 2/2 acquired by mic_gradcalib_xy to measure the y dimension (top-bot-
tom).

Right image: Image 1/1 acquired by mic_gradcalib_z to measure the z dimension (top-bottom).

The inner diameter of the above selected 5mm NMR tube is 4.1 mm in x and y direction. The
distance between the tips of a M4 screw is 0.75 mm, so 10 tips (to increase the accuracy) should
have a distance of 7.5 mm.
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Of course any other sample with well defined geometry can be used to calibrate the gradients.

When the “micro-imaging Add-on CD” is installed as described in Micro-imaging Add-on CD
[81], the gradient calibration parameters already have their default values, which are typically
less than 3% of from the correct values. The default values can be found in Typical Gradient-
Setpre Parameters [179].
When the measured values from the NMR images differ from the real geometry (what they typ-
ically do), the calibration constants for the amplifier/gradient system combination need to be cal-
culated. The easiest way to do this is to load the protocol m_installation/mic_gradcalc and enter
the appropriate values, see the figure below.

REAL: Enter the physical sizes of the object.

MEASURE: Enter the sizes of the object measured in the NMR image.

CURRENT: The current gradient calibration parameters.

CALCULATED: The new gradient calibration parameters, calculated from the entered 
REAL and MEASURE parameters.
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The mic_gradcalc Method Interface

Figure 7.21: The mic_gradcalc Method Interface

After selecting Save Calc Data →Save Now the values are automatically stored. The file location
can be checked in the ParaVision startup console.

The values can also be calculated manually. For a triple axis gradient system a gradient calibra-
tion constant (of the weakest gradient) and the scaling values for the stronger gradients must be
calculated to equalize the gradient output in all directions.

In order to calculate the values determine the real geometry in x/y/z (realx/y/z) and the measured

geometry (measx/y/z) from the calibration object.

Calculate the ratios by:

ratiox = measx / realx
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ratioy = measy / realy

ratioz = measz / realz

From these values calculate the relative scaling using:

scalex = minimum_of (ratiox, ratioy, ratioz) / ratiox

scaley = minimum_of (ratiox, ratioy, ratioz) / ratioy

scalez = minimum_of (ratiox, ratioy, ratioz) / ratioz

Then calculate the new gradient calibration constant:

GCCnew = GCCold * minimum_of (ratiox, ratioy, ratioz)

These values have to be entered into setpre:

1. Open ‘setpre’ by Spectrometer Control Tool →Tools →Adjust Preemphasis Values.

2. Select ‘SetPre →Edit →Gradient parameters.

3. Enter the above calculated values.

4. Store the values using ‘SetPre →File →Write as default’.

Gradient Calibration Parameters Dialog.

Figure 7.22: Gradient Calibration Parameters Dialog.

After the calculation of the new calibration of the gradients, the calibration should be checked.
Perform the same experiments as above, and check if the correct geometry is shown in XTip.

RF Probe Routing Setup

In ParaVision 5 the routing is realized in a different way, as compared to previous ParaVision
versions. Each probe has to be specified separately, which causes a bit of work during the in-
stallation, but makes it much easier during the experiment setup, since only the connected
probe and a valid ‘Operation Mode’ have to be selected. Valid operation modes are modes that
correspond to the set-up routing and allow the transmit and receive chain to handle the selected
frequencies. For more detail, refer to Quick Introduction to Coil Configurations [151].

Note: Create new scans to check the calibration. Don’t clone the old scans. If ‘Clone Scan’ is
selected, the old values are copied and the new entered values have no effect!

Note: The ParaVision method only allows the selection of valid nuclei in the selected operation
mode.
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7.7 Select an Existing Probe

During ‘cf’ ParaVision automatically creates a few standard configurations, basically for single
tuned 1H and X coils (the corresponding command in the TopSpin command line is “pvdefcoil-
confs”). If a coil configuration for a probe is already setup, it is very convenient to load them and
have all the routing and power parameters immediately set up. To activate an existing probe
configuration:

1. Create a new scan or new study.

2. Select the probe from the ‘Probe’ pull down menu (red mark in the figure below) in the ‘Study
Editor.

Study Editor with Probe Selection Pull Down Menu.

Figure 7.23: Study Editor with Probe Selection Pull Down Menu.

3. Select the desired operation mode for the probe (red mark in the figure above) in the proto-
col.

For a single tuned 1H volume probe, most likely the only operation mode will be “[1H] Rx/
Tx”, which indicates a 1H coil for transmit and receive.

For double tuned coils there are typically more operation modes, at least “[1H] Rx/Tx” and
e.g. “[13C] Rx/Tx”.

When the “[1H] Rx/Tx”, the ParaVision method will only allow 1H experiments. When “[13C]
Rx/Tx” is selected the method only allows 13C experiments.
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Protocols Dialog with ‘Operation Mode’ Selection

Figure 7.24: Protocols Dialog with ‘Operation Mode’ Selection

4. Verify that the currently connected coil setup is registered as the connected probe in Para-
Vision. Open "ScanControlTool->Set Connected Probes..." and select the connected coil
from the list of available probe configurations. It must match the setting for the probe (see
the figure above). When the system and the coil are equipped with automatic hardware de-
tection (HWIDS), the selection is made automatically.
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7.8 Setup New Probes 

For various probes that are not created automatically, the coil configurations have to be set up
manually.
Main GUI Window for the Coil Configuration.

Figure 7.25: Main GUI Window for the Coil Configuration.

1. Login to the system as nmrsu.

2. Start ParaVision 5.

3. Open the Macro Manager (Magic Hat icon in the System Control Window) and start the mac-
ro ‘EditCoilConfs’ in the category ‘Bruker’.

4. Set up the coil configurations in the upcoming TCL user interface by copying an existing coil
configuration or creating a new configuration. It is recommended to create a new configura-
tion rather than copying an existing one.
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Coil Edit Sub Menu For the Coil Configuration (Coil 1→Edit)

Figure 7.26: Coil Edit Sub Menu For the Coil Configuration (Coil 1→Edit)

7.8.1 Definition of an Individual Value for the Reference Gain Adjustment 

The default parameters in the auto adjustment protocols are selected to match the most RF
coils. When very small coils are used, for example, the start value for the auto adjustment can
be too high to find the best match.

To improve the protocol for the RF amplitude adjustment, the starting point for the RF pulse am-
plitude (parameter “Initial Attenuation”, which is one of the most critical parameters) can be set
manually. Pref is the power in watt of a 90 degree 1 msec block pulse under standard load con-

ditions, Pmax is the peak power in Watt of the RF amplifier and Aref is the attenuation in dB of

the maximum power (note, no attenuation means -6dB). The relation between reference atten-
uation and reference power is shown by the following equations:
Equation: Relation Between Reference Attenuation and Reference Power

Figure 7.27: Equation: Relation Between Reference Attenuation and Reference Power
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For systems without hardware detection, the value of Pref can be stored in a coil configuration

file using the coil configuration editor (field “Reference Power”).

Dual Tuned Probe (1H/
X)

Dual Tuned Probe (1H/
19F), 19F via 1H Am-
plifier and XBB19F 
Preamp

Quadrature Coil (1 
Coil Tx, 2 Coils Rx; 1H)

Surface Coil 
(Tx/Rx)

Name Dual Resonance 1H/X 
Probe

Dual Resonance 1H/
19F Probe

1H Quadrature Probe 
(1Tx/2Rx)

Surface Probe
(Tx/Rx)

Coil1→Edit→ Multiple Resonance Coil Multiple Resonance Coil Array Coil Linear Coil

Name

Manufacturer

Part Number

Serial Number

1H/X Volume Coil

e.g. Bruker

e.g. H9813

e.g. 0100

1H/19F Volume Coil

e.g. Bruker

e.g. HZ16483

e.g. 0100

Quadrature Parallel Coil

e.g. Bruker

e.g. H9541

e.g. 0103

Surface Coil
e.g. Bruker
e.g. H6737
e.g. 0105

Layout Volume Coi Volume Coil Volume Coil Surface Coil

Elements 2 2 2 1

Element 1

1H

Receive 
Cap.

Transmit 
Cap.

Tuneable

Connected 
to Preamp 
LNA[x] 1H

Element 2

e.g. 13C

Receive 
Cap.

Transmit 
Cap.

Tuneable

Connected 
to Preamp 
LNA[x] 
XBB

Element 1

1H

Receive 
Cap.

Transmit 
Cap.

Tuneable

Connected 
to Preamp 
LNA[x] 1H

Element 2

19F

Receive 
Cap.

Transmit 
Cap.

Tuneable

Connected 
to Preamp 
LNA[x] 
XBB19F

Element 1

1H

Receive 
Cap.

Transmit 
Cap.

Tuneable

Connected 
to Preamp 
LNA[x] 1H

Element 2

1H

Receive 
Cap.

Tuneable

Connected 
to Preamp 
LNA[x+n] 
1H

Element 1

1H
Receive Cap.
Transmit Cap.
Tuneable

Connected to 
Preamp 
LNA[x] 1H

Tip: Instead of creating an element with one fixed nucleus (frequency), a nucleus (frequency) range for the 
element can be defined. Element 2 of the ‘Dual Tuned Probe’ for example could be defined from ‘3He-197Au’ 
(use this notation without the quotes, always from high to low frequency), so this element covers the full X 
range the AVANCE III X-channel hardware supports. As a result, this “Dual Tuned Probe” configuration can 
used for all 1H-X probes (except for 1H-19F probes), and for single and dual frequency experiments.
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Parameters for Different Coil Types

Table 7.8: Parameters for Different Coil Types

For service purposes the routing for one scan can be setup manually, but only for the selected
scan.

In the single parameter windows (Spectrometer Control): 

1. Set  ACQ_routing = RouteAsDefined [3].

2. In ParaVision ScanControl select Advanced -> Command Sender.

3. In the command sender select:
Server = …pvScan/CmdDispatcher.
Name =  pvcreaterout

4. Click on the little arrow in the menu bar to set up the desired routing.

This routing is only valid for the current data set, so it doesn’t replace the coil configurations set-
up described above.

The following figures show the 1H-19F coil setup with 1H-19F RF amplifier and XBB19F pream-
plifier:

Dual Tuned Probe 
(1H/X)

Dual Tuned Probe 
(1H/19F) 19F via 1H 
Amp and XBB19F Pre-
amp

Quadrature Coil (1 
Coil Tx, 2 Coils Rx)

Surface Coil (Tx/Rx)

Rout-
ing

AutoCreate/Update or 
manual setup by select-
ing ‘New’

Manual Setup: Create 2 
modes.

1st mode “1H/[X]”: Set-
up the routing for 1H on 
F1 and any X nucleus 
(e.g. 31P) on F2.

2nd mode “X/[1H]”: Set-
up the routing for X 
(e.g. 31P) nucleus on 
F1 and 1H nucleus on 
F2.

This setup enables sin-
gle (1H or X) and dual 
frequency (1H/x and X/
1H) experiments with 
this dual frequency coil

AutoCreate/Autoup-
date

Select the 19F Opera-
tion mode, click ‘Recon-
nect Transmitters’ and 
route the 1H amplifier to 
the XBB19F preamp 
and Save.

Select the 19F Opera-
tion mode, click ‘Setup 
Routing’, and route F1 
via SGUx to the 1H am-
plifier (which is routed 
to the XBB19F). See 
the figure below.

For the 1H operation 
mode no manual 
changes need to be 
performed.

For other setups please 
contact Bruker at mic-
diff@bruker.de.

AutoCreate/Update or 
manual setup by select-
ing ‘New’

Manual Setup: Create 1 
mode.

Mode: “1H Quadra-
ture”:
Setup the routing for 1H 
on F1 and don’t setup 
any routing for F2. F2 
Will be automatically 
switched to observe 
during the experiment, 
so no setup is neces-
sary.

AutoCreate/Update or 
manual setup by select-
ing ‘New’

Manual Setup: Create 1 
mode.

Mode: “1H Surface”:
Setup the routing for 1H 
on F1.
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Reconnect Transmitters Dialog for 1H.

Figure 7.28: Reconnect Transmitters Dialog for 1H.

Reconnect Transmitters Dialog for 19F.

Figure 7.29: Reconnect Transmitters Dialog for 19F.
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Setup Routing Dialog for 1H.

Figure 7.30: Setup Routing Dialog for 1H.

Setup Routing Dialog for 19F

Figure 7.31: Setup Routing Dialog for 19F
Z33075_00_001 117



Gradient System and Amplifier Setup
118 Z33075_00_001



Signal to Noise Ratio and z-B1 Tests for the RF Probes
8 Signal to Noise Ratio and z-B1 
Tests for the RF Probes

The imaging tests have to be performed for all 1H coils and for those X coils, where samples
delivering high sensitivity are available. These checks for the probe performance, and depen-
dent on the imaging system and including all components (spectrometer, imaging rack, gradient
system), are signal to noise and a B1 homogeneity (z direction) test for the resonator.

8.1 SNR Imaging Test

The Signal to Noise Ratio (SNR) test is based on a multi slice experiment with a standard sam-
ple and with standard parameters, which are identical on all systems. The parameters don’t take
care of varying T1 or T2 of the samples at different frequencies, but if the same experiment is
used at the same field strength, the results are comparable. The SNR from the images, acquired
with well defined parameters, is automatically calculated and stored by a macro. These values
can be used in later tests as a base for comparisons of the system performance.

SNR tests are mostly performed for 1H coils, since the sensitivity of X nuclei for X nuclei imaging
tests is typically low. The samples and imaging parameters defined for different nuclei can be
found in the table in chapter Information Final Test Protocol for RF Probes on Form [161], (for
1H D2O is added in order to avoid radiation damping effects). The defined liquids are filled in an

NMR tube, which fits tightly into the RF coil to investigate and the filling height should at least
cover the full coil length.

The protocols for the SNR and test can be found in the protocol location ‘m_installation’. In order
to acquire SNR test images with the correct parameters, the FOV of the slices must be adapted
to 1.2 times the resonator inner diameter. The number of slices can be modified to cover the full
z-range of the resonator.

Parameter Setup for SNR tests

Table 8.1: Parameter Setup for SNR tests

Note: The receiver gain must be set to 101. If the signal is clipped with this receiver gain set-
ting, reduce the slice thickness so that the signal is no longer clipped. If the receiver gain is
lower, the SNR values are no longer comparable.

NMR Sample: See Chapter Information Final Test Protocol for RF Probes on 
Form [161].

Data Set Name: <$probe name>

Protocol Name: m_installation/mic_msme_snr_<$NUC>

Recommended Coil Routing: Probe specific coil routing.

Frequency BF1: On resonance.

Shim: As good as possible.

RF Gain: Auto Reference Gain must be defined.

Receiver Gain: 101
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The above protocol acquires axial images with defined timing. The calculations for the SNR from
these images are performed using the macro BRUKER/mic_rfTest, which needs the z-B1 profile
as described in Processing of the SNR and z-B1 Data Sets  [122]as additional input. Refer to
this chapter for more information. Basically, the macro generates 2 ROIs, one in the signal and
the other in the noise, to calculate signal to noise and homogeneity values.
Signal and Noise ROIs Created by the mic_rfTest Macro in an Axial 1H SNR Image

Figure 8.1: Signal and Noise ROIs Created by the mic_rfTest Macro in an Axial 1H SNR Image

From these two ROI‘s, the macro calculates the SNR of all acquired images out of the mean

values and standard deviations, scales it to 1 mm3, and stores the result on disk.
Equation 7-1: SNR per mm^3 Calculation.

Figure 8.2: Equation 7-1: SNR per mm^3 Calculation.

The factor 0.85 adapts the results to previous ParaVision versions.

Equation 7-2: Calculation of the Homogeneity.

Figure 8.3: Equation 7-2: Calculation of the Homogeneity.

In some cases, the signal ROI does not fit the sample very well and has to be shifted or modified
in size. In this case, modify the ROI with the ROI tool from XTip and uncheck the ‘Default ROI’
option in the macro BRUKER/mic_rfTest to run the calculation of the SNR values again.

When the execution of the macro is successful, the result is stored in the csv file data/<$USER>
/nmr /<$dataset> /<$expno> /pdata /<$procno> /SNR_homogeneity.txt. An example of such a
file is shown below. This data is automatically imported into the test form (see below).
120 Z33075_00_001



Signal to Noise Ratio and z-B1 Tests for the RF Probes
The results for 1H coils can be compared to the specification values in the table found in the
chapter Signal to Noise Ratio for 1H RF-Coil Elements [164], to verify that the RF coil matches
the specifications. If this is not the case, the spectrometer parameters need to be rechecked (ref-
erence pulse, shim, frequency,…), when the SNR values still cannot be reached, the coil may
be returned for optimization. The acquired values should be stored safely. If at any time the user
has the feeling, that the system has a SNR problem, the tests can be redone and the values
compared to the values during the installation.

See also

 Test Sequences and Samples [162]

8.2 The z B1 Test

The B1 homogeneity along z is measured by a single slice msme sequence. Take care that the
sample is longer than the RF coil, so that the image length along z is only limited by the coil, e.g.
FOV approximately 25 mm for a 10 mm coil or 50 mm for a 30 mm coil. The type of sample does
not matter, thus a NMR tube filled with water or ‘Sample A’ is recommended.

The protocol for the z-B1 test can be found in the protocol location ‘m_installation’.
Parameter Setup for SNR tests

Table 8.2: Parameter Setup for SNR tests

The parameter to be noted is the length of the profile, whereas the amplitude is higher than 85%
of the maximum profile amplitude. This value can be taken from a 1D profile plot, generated by
the macro mic_rfTest, which is described in the following section.

Fra-
meNr;

Sig-
nal.Mean;

Signal.Std-
Dev;

Noise.Me
an;

Noise.Std
Dev;

Slice.Po-
sition;

Homoge-
neity;

SN per 
mm3

1; 20428; 10459; 20428; 10459; -5.250; 100.0; 7111.55

2; 20756; 10763; 20756; 10763; -3.750; 100.0; 7021.07

3; 20755; 10808; 20755; 10808; -2.250; 100.0; 6991.70

4; 20412; 11333; 20412; 11333; -0.750; 100.0; 6557.52

5; 21110; 10713; 21110; 10713; 0.750; 100.0; 7174.35

6; 20441; 10709; 20441; 10709; 2.250; 100.0; 6949.45

7; 20602; 10898; 20602; 10898; 3.750; 100.0; 6882.81

8; 21844; 11142; 21844; 11142; 5.250; 100.0; 7138.25

NMR Sample: A long NMR tube filled with water or doped water. The filling 
height must be higher than the length of the RF coil.

Data Set Name: <$probe name>

Protocol Name: m_installation/mic_msme_zB1prof

Recommended Coil Routing: Probe specific coil routing.

Frequency BF1: On resonance.

Shim: As good as possible.

RF Gain. Auto reference gain must be defined.

Receiver Gain: Does not matter.
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8.3 Processing of the SNR and z-B1 Data Sets 

The macro mic_rfTest is a small GUI-macro, which supports the generation of a test report. After
starting the macro a small GUI shows up, where expno and procno of the SNR and z-B1 data
sets can be entered. The macro contains only minimal checks, so the user has to be sure to
provide the correct numbers. As long as the results are not calculated, the ‘Calc’ buttons are
shown in red. When the data is calculated, the color changes to green. As soon as both ‘Calc’
buttons show green, the test report sheet can be generated by clicking ‘Create Test Sheet’.
The mic_rfTest with Both Data Sets Processed (green color of the ‘Calc’ buttons)

Figure 8.4: The mic_rfTest with Both Data Sets Processed (green color of the ‘Calc’ buttons)

In case the default ROIs for the SNR calculation do not fit the sample, the ROIs can be rear-
ranged using the ROI tool, ‘DefaultROI’ must be unchecked and the calculation can be restarted
by pressing the ‘Calc’ button.

8.4 Spectroscopic Test

The sensitivity of X nuclei in imaging experiments is often not sufficient to acquire a 2D image
and to perform the imaging test, described in SNR Imaging Test [119]. To test the sensitivity
and the shim performance of coils for such nuclei, 5 mm samples are used (see Test Sequences
and Samples [162]). For the ease of use, the experiment should be performed in TopSpin. The
sample should be shimmed well and the 90 deg pulse needs to be measured first (paropt,
popt…). After the acquisition the sensitivity of the coil can be calculated using the formula:
Equation 7-3: Signal to Noise Calculation from a Spectrum

Figure 8.5: Equation 7-3: Signal to Noise Calculation from a Spectrum

The ‘Sino’ (Signal to Noise) is the TopSpin build-in signal to noise calculation result. To perform
the calculation, select TopSpin Analysis -> Signal/Noise Calculation and define the signal and
noise region as noted in the upper left corner of the spectrum window. The actual calculation
can then be started by a right mouse button click→ Start S/N Calculation. This value has to be
multiplied by the line width of the selected peak measured at 50% of the maximum amplitude.
The width can be measured manually or by the command ‘peakw’ (it might be necessary to de-
fine the plot region where the peak should be searched by the command ‘dpl1’). The multiplica-
tion of ‘Sino’ by the line width should compensate for imperfect shimming.

Since some standard samples show multiple peaks, the peak/range to be used for the SNR test
is marked in the spectra database in chapter Reference Spectra [165].
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9 Gradient Amplifier Blanking 
Modes

The Great amplifiers can operate in 2 different blanking modes, soft and hard blanking. A low
level (TTL) at the ‘Gate’ input of the Great amplifiers enable their outputs; a high level (TTL) dis-
ables the outputs. In imaging experiments the amplifiers are often unblanked during the com-
plete experiment (realized in the include file MRI.include) due to 2 reasons:

▪ The experiments are quite fast, so there is almost no time to blank the amplifiers.

▪ The current to gradient ratio is not as high compared to the diffusion gradient systems.

Blanking is essential for experiments with diffusion gradient systems (Diff 30/60), since they
have a high current to gradient ratio, so even weak amplifier noise introduces strong effects to
the spin system.

9.1 Hard Blanking

On previous instruments, there was only one blanking mode available which is now called “hard
blanking”. This blanking mode is controlled by a ‘setnmr’ command in the pulse program, which
enables or disables the amplifier output exactly at that moment, when it is executed, indepen-
dent from any residual gradient current. This can be well controlled if all preemphasis values are
set to zero, but if the preemphasis compensation adds an exponential decaying current to the
gradient shape, it can hardly be predicted in the pulse program when the current will be dropped
down to zero and blanking can be switched. In this case, the preemphasis compensation current
will be cut off and doesn’t produce the desired effect. The gating input of the Great amplifiers is
directly connected to the IPSO T0 connector for the hard blanking mode. For the T0 pin connec-
tions please refer to the table in the section Trigger Signals at the T0 Connector [149].
To blank all amplifiers in this mode, bit 32, 33 and 34 of nmrword0 have to be set to 1 (5V at the
T0 connector) using the command ‘setnmr0^32^33^34’ in the pulse program. To unblank the
amplifiers, the bits have to be set to 0 (0V at the T0 connector) using the command
‘setnmr0|32|33|34’, where bit32 is for AmpX, bit33 for AmpY, and bit34 for AmpZ.

The following lines show a pulse program example for the hard blanking:

…

15µ setnmr0|32|33|34

1m grad { (10) | (t0) | (0) }

200µ groff

2m ; time for the preemphasis current to decay

10µ setnmr0^32^33^34

…

Note: The amplifier needs about 10 µsec to enable its output. The blanking command must be
executed minimum of 15 µsec before the ‘grad’ command in the pulse program. Shorter times
can lead to unforeseeable effects.
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Hard Blanking Parameters.

Table 9.1: Hard Blanking Parameters.

D = amplifier disabled (blanked), E = amplifier enabled (unblanked)

The following figure visualizes the behavior of the hard blanking:
Hard Blanking of a Gradient Pulse with Preemphasis Components.

Figure 9.1: Hard Blanking of a Gradient Pulse with Preemphasis Components.

9.2 Soft Blanking

The Master Unit BGMUI-E used on AVANCE III systems can generate so called ‘soft blanking’
pulses. The ‘soft blanking’ is controlled in the pulse program by ‘ctrlgrad’ commands. If a ‘ctrl-
grad’ command to blank an amplifier is executed in the pulse program the master unit checks
the digital data of the amplifier to be zero. As long as the input data is not zero, the amplifier
stays enabled (unblanked). As soon as the input becomes zero, the master unit generates the
blanking signal for the amplifier. The big advantage of the ‘soft blanking’ is that residual currents
from the preemphasis are not clipped anymore. If e.g. all preemphasis values are zero, the am-
plifier is blanked immediately when the ‘ctrlgrad’ command is executed. If the preemphasis com-
pensation adds an exponentially decaying current, the amplifier is first blanked when the
compensation current is fully decayed. The gating input of the Great amplifiers has to be con-
nected to master unit, refer to the section Blanking Pulses [22].
The following is a pulse program example for the soft blanking:

…
15µ ctrlgrad 7
1m grad { (10) | (t0) | (0) }
200µ groff
2m ctrlgrad 
0 ; blanking stays open for preemphasis decay
…

setnmr ppg command AmpX AmpY AmpZ

setnmr0^32^33^34 D D D

setnmr0^32^33|34 D D E

setnmr0^32|33^34 D E D

setnmr0^32|33|34 D E E

setnmr0|32^33^34 E D D

setnmr0^32|33^34 D E D

setnmr0|32|33^34 E E D

setnmr0|32|33|34 E E E
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The ‘soft blanking’ of the amplifiers is executed using the keyword ‘ctrlgrad <value>’ in the pulse
program. To unblank the amplifiers, the <value> bits must be set. To blank the amplifiers, the
bits must be reset to 0, where bit0 = AmpX, bit1 = AmpY, and bit2 = AmpZ. 
Soft Blanking Parameters.

Table 9.2: Soft Blanking Parameters.

D = Amplifier disabled (blanked), E = Amplifier enabled (unblanked)

The figure below visualizes the behavior of the soft blanking.
Soft Blanking of a Gradient Pulse with Preemphasis Components

Figure 9.2: Soft Blanking of a Gradient Pulse with Preemphasis Components

Typically all amplifiers are blanked/unblanked at the same time. Therefore, the macros BLK-
GRAD and UNBLKGRAD are defined in the include file pp/Grad.incl. These macros execute a
‘soft’ and a ‘hard’ blanking event, so the behavior of the amplifier depends on where the gating
input is connected.

Value (bin) ppg Command X Y Z

000 ctrlgrad 0 D D D

001 ctrlgrad 1 D D E

010 ctrlgrad 2 D E D

011 ctrlgrad 3 D E E

100 ctrlgrad 4 E D D

101 ctrlgrad 5 D E D

110 ctrlgrad 6 E E D

111 ctrlgrad 7 E E E

Note: The command ctrlgrad opens the amplifier at the next gradient command in the pulse
program. If a ‘ctrlgrad 7’ isn’t followed by a grad{…} command, the amplifiers remain blanked.
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10 Digital Data Filtering and Analog 
Sampling

10.1 Digital Filtering

The signal received by the RF coil is first amplified by the HPPR preamplifier. A second ampli-
fication stage is in the RXAD, the combined receiver and digitizer board. In the RXAD the signal
is mixed to the intermediate frequency (720 MHz), in a second step to the so called DQD fre-
quency and then digitized by 2 digitizers running at 20 MHz. During this time, only a smooth an-
alog filter with a bandwidth of 10 MHz is applied to the signal to avoid signal folding. The
digitizers run continuously to minimize transient behavior and settling time artifacts after starting
the acquisition. The over-sampled signal, with a time resolution of 50 nsec (over-sampling dwell
‘2*dwov’), is finally filtered and decimated in the DRU (Digital Receiver Unit).
The Signal Path in the RXAD and the DRU

Figure 10.1: The Signal Path in the RXAD and the DRU

Digital filters modify the signal after the analog to digital conversion. They are mathematical op-
erations, which enables the signal to be folded with any function or shape, and increase the sig-
nal to noise ratio of the spectrum by reducing the quantisation noise of the ADC.

After the analog signal is digitized with a dwell time ‘dwov’ in the RXAD, it is digitally filtered in
the DRU. First, it is decimated 2 times by a factor of 2 using build-in hardware filters, resulting
in a signal with a dwell time of 200 nsec. By adding more filter and decimation stages, which are
under software control, the final signal with the desired spectral bandwidth is generated 

The influence of the complete filter chain is described by the filter kernel. In frequency domain
the filter function would have to be multiplied with the spectrum. Since the digital filter is applied
in time domain, it’s a convolution with the filter kernel. The over-sampled FID is multiplied by this
filter kernel point by point. 
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Every Individual Point of the Oversampled FID is Multiplied by the Filter Kernel.

Figure 10.2: Every Individual Point of the Oversampled FID is Multiplied by the Filter Kernel.

When the first digital data point enters the digital filter, all other filter elements are zero. As a
result, the first output point is almost 0. When the second data point enters the filter, it already
has the previous point to be convolved with, so the second output point already contains the in-
formation from 2 input values, the third from 3 input values and so on. As a result, the out signal
of a digital filter looks as if it starts with 0. In reality all these points contain signal, which can be
seen if the Y-scale of the FID display is increased. The “real” signal “seems to appear” after a
time, which is defined by the half width of the filter kernel. This time is called “group delay” in
digital filtered signals.

Example of a Digital Filter with a Kernel Length of 8

Table 10.1: Example of a Digital Filter with a Kernel Length of 8

Filter Kernel f7 f6 f5 f4 f3 f2 f1 f0

0.2 -0.5 1 3 3 1 -0.5 0.2

Sample FID Data 4;  6; -3; 1…

Each FID data point is multiplied by the filter kernel and summed up

Input Data Point i7 i6 i5 i4 i3 i2 i1 i0 Output Data Value

1st 4 0 0 0 0 0 0 0 0.8

2nd 6 4 0 0 0 0 0 0 -0.8

3rd -3 6 4 0 0 0 0 0 0.4

4th 1 -3 6 4 0 0 0 0 19.7

…

nth n n-1 n-2 n-3 n-4 n-5 n-6 n-7
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Filtered FID with lEss Noise and the Group Delay”

Figure 10.3: Filtered FID with lEss Noise and the Group Delay”

The group delay which is introduced by the digital filter can be checked by entering ‘GRPDLY’
in the single parameter editor of ParaVision, or by entering “1s grpdly” in the TopSpin command
line when a TopSpin data set is selected. The result of this input is the shift of the signal in com-
plex points, which means the real signal is shifted by GRDPLY points and the imaginary signal
as well. The group delay in seconds is then GRPDLY/SWH = GRPDLY*2*DW (Bruker dwell is
half of the real dwell time).

Since the filtered signal in the previous figure now contains many more data points than required
to describe the signal, the number of points in the signal can be reduced by eliminating data
points that are not required.
Decimated Final FID

Figure 10.4: Decimated Final FID

10.1.1 Handling of the Digitally Filtered FID in TopSpin

The shift of the FID by the group delay of the digital filter causes a first order phase shift of the
data. When the phase correction of the spectrum is started, a first order phase correction calcu-
lated from the GRPDLY parameter (phc1=GRPDLY*360°) is automatically applied by the soft-
ware (pknl = ‘true’).
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When the FT should be performed by an external program the ‘convdta’ command can be used.
This command runs an FT followed by an IFT. The result is that the leading points of the original
FID can now be found at the end. The end is then cut and added to the beginning of the FID.
The result is an FID which looks like an analog one (no group delay at the beginning), but the
size of the FID is td-2*GRPDLY.

10.1.2 Handling of the Digital Filtered FID in ParaVision

The handling of spectroscopic FID data in ParaVision is identical to the handling of the data in
TopSpin. To enable this acquisition mode, the parameter ACQ_scan_shift must be set to 0.

Since echo signals are typically much shorter than spectroscopic FID data, they are handled in
a different way. The length of an echo can easily be in the same range as the group delay. When
the data is handled identically as the FID data, many more data points will need to be acquired
than required (causes long acquisition times and an ‘apparent’ pixel resolution in the image), or
the echo may be outside the acquisition window.

When echoes in ParaVision are acquired the leading GRPDLY points are deleted. At the end of
the acquisition the filter is flushed to get the remaining data points out of the filter memory. This
mechanism is controlled by the parameter ACQ_scan_shift. If ACQ_scan_shift is set to -1 its
value is automatically replaced by the number of points to be deleted at the beginning of the
echo signal (ACQ_scan_shift is typically -2*GRPDLY because its value is RE+IM).

Note: Spectroscopic data must be acquired with ACQ_scan_shift = 0.
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Gradient Echo (256 cplx data points) 

Figure 10.5: Gradient Echo (256 cplx data points) 

The gradient echo in the figure above was acquired with ACQ_scan_shift = 0 (top) and
ACQ_scan_shift = -1 (bottom). The -1 was automatically replaced with -136 (GRPDLY =
67.998).

As soon as the last point of the echo is acquired, the filter memory is flushed to get the final
points out of the queue. The optimum time required to flush the DRU memory can be found in
the Digitizer Class of each method in the parameter PVM_DigEndDelOpt, refer to the figure be-
low. If this additional time is too long for the sequence to run, the additional time can be reduced
to PVM_DigEndDelMin. But then the scan shift is reduced to a lower number of points and the
echo no longer appears in the center of the acquisition window.
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Digitizer Class of a Method

Figure 10.6: Digitizer Class of a Method

The automatic handling of the scan shift depends on the available time and is controlled by the
parameter DEOSC (in µsec) inside ParaVision. The optimum value for DEOSC is equal or lon-
ger to PVM_DigEndDelOpt + PVM_DigDur (PVM_DigDur =aqq).

The value for DEOSC is calculated using the time difference between ACD_START and
ADC_END in the pulse program. Thus, there should always be a delay between the ‘real’ acqui-
sition time and the ADC_END command in the pulse program

Example from the FLASH pulse program:

…
ADC_INIT_B(NOPH, ph2)
aqq ADC_START 
d11 grad{(t6)|r2d(t7)|r3d(t8)} ; 2nd and 3rd dims
d12 grad{(t6)| (0) | (0) }
d3 groff
d0 ADC_END
…

In this example DEOSC = 1e6*(aqq+d11+d12+d3).

10.2 Analog Sampling

The analog mode on the DRU is no longer realized by selecting a proper dwell time. Instead,
the DWL_CLK macro (AVANCE III: setrtp1|0 setrtp1^0) is used. The data points are always
sampled with 20 MHz (50 nsec). To avoid the increase of noise in this acquisition mode (variable
analog filters are no longer available), a predefined number of successive oversampling data
points are averaged by a simple box filter to form one “analog” output data point. The number
of data points to be averaged is controlled by the value of ‘anavpt’ (must be 2^n with 9>n>0) in
the pulse program.
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Analog Data Sampling with anavpt=4

Figure 10.7: Analog Data Sampling with anavpt=4

This type of acquisition is a special kind of external address advance. The command “dwell-
mode explicit” must be added in the header of the pulse program to allow the analog digitizer
setting.

DWL_CLK Timing, anavpt is set to 8.

Figure 10.8: DWL_CLK Timing, anavpt is set to 8.

Note: For each group of anavpt points, the DWL_CLK must be switched on and off again be-
fore you can acquire the next one.
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Be sure to watch for any timing problems (lower right drawing in the figure above).

Sample pulse program for analog acquisition:

;zganav2
;1D sequence
;
;$CLASS=HighRes
;$DIM=1D
;$TYPE=
;$SUBTYPE=
;$COMMENT=

#include <Avancesolids.incl>

;"dwellmode explicit" -> digmod must be set to analog
dwellmode explicit

define loopcounter count
"count=td/2"
define delay acqu
"acqu=0.050u*l11"
define delay dwrest
"dwrest=dw-(acqu/2)"
define delay rest
"rest=aq-(td*dw)"

;l1 : 9>l1>0, number of packages of averaged points
"l11=pow(2,l1)"
"anavpt=l11"

1 ze
2 30m
   d1
   (p1 ph1):f1
   STARTADC     ; 1u sync 1u adc ph31 syrec
   RESETPHASE    ; (1u ph30:r):f1
   de
3  dwrest   setrtp1^0^5     ; REC_BLK and DWL_CLK_OFF
   acqu     setrtp1|0|5     ; REC_UNBLK and DWL_CLK_ON
   dwrest
   lo to 3 times count
  rest setrtp1^0^5   ; REC_BLK and DWL_CLK_OFF
  rcyc=2
  30m mc #0 to 2 F0(zd)
exit

ph1=0 2 3 1
ph30=0
ph31=0 2 3 1

Note: DWL_CLK must be toggled ON/OFF TD times.
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11 Animal Triggering Unit

The animal triggering unit (SA Instruments) used for micro-imaging is the same unit used for hor-
izontal bore animal scanners by Bruker. The only differences are the cables for the connections
between the probe and the unit, and from the unit to the AVANCE III console.

For general information about the triggering unit and the control software, refer to the manual
delivered with the unit.
Schematic of the Console – Triggering Unit Wiring.

Figure 11.1: Schematic of the Console – Triggering Unit Wiring.

11.1 Connection from the Probe to the Triggering Unit

All current RF probes with animal support offer a connector for direct connection of the probe to
the ECG/temperature preamplifier of the triggering unit, including support for ECG and temper-
ature signals. The connection is established by one single cable, leading from the probe base
connector (‘LEMO’ connector labelled BTAM) to the 2 inputs of the preamplifier:
Z33075_00_001 135



Animal Triggering Unit
Connection of the RF Probe to the ECG/Temperature Preamplifier

Figure 11.2: Connection of the RF Probe to the ECG/Temperature Preamplifier

In addition to the electrical connections, the probes are equipped with 2 ‘Luer’ connections,
leading from the probe base to the upper part of the probe. One of the connections can be used
for the anaesthesia gas, the other connection for the respiration balloon that is placed on the
animals’ belly. For further information about the animal handling refer to the ParaVision ‘Appli-
cations Manual’.

11.2 Connection from the Triggering Unit to the Console

The ‘Gate’ output of the ‘Control Gating Module’ of the triggering unit must be connected to the
AVANCE III console via the IPSO T0 connector. This output delivers a configurable TTL signal,
which indicates different stages in the animal‘s physiology to trigger the NMR experiment to
these events. For details how to configure trigger events and timings refer to the unit manual.

The connection is established using a BNC-BNC cable, leading from the gate output to the
TRIG_IN1 (ECG_TRIG) connector of the IPSO T0 connector (‘Coax’ Adapter HZ10124 re-
quired).

For a jitter free triggering (relative to the gradient switching), the style of the triggering is changed
at the AVANCE III. The synchronization is made using an additional trigger command
GRAD_SYNC (for details see the pulse programs and include files). This synchronization only
works, if an additional connection is made between the Z1 and the E1 pins of the IPSO T0 con-
nector. If the T0-Z connector already has a free BNC connector at Z1, this can be connected to
T0-E1 using a HZ10124 coax adapter. If there no free BNC available, an additional coax to BNC
cable must be plugged into the T0-Z connector housing. If no coax to BNC is available, the T0-
Z connector (Emergency Stop) can be removed and another HZ10124 coax adapter can be
plugged in during the time of the workaround.

Note: When the case triggering still doesn’t work, open the file uxnmr.par in $PvHome/conf/
instr/spect/ and check the value for SYNCTRIG. The value for SYNCTRIG must be 11.
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Optionally, the STAMP1 (ECG_STAMP) output of the IPSO T0 connector and the AUX input of
the control gating module of the triggering unit can be connected. This enables the triggering
unit, to detect and record events in the pulse program, e.g. to synchronize the pulse program
timing with physiological parameters of the animal during post processing or to record external
events (e.g. fMRI) in the experimental data.

Refer to the section Trigger Signals [149] for the pin numbers for the IPSO T0 connector.
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12 Tips, Tricks and Troubleshooting

12.1 Creating RF Shapes for ParaVision

The ParaVision RF shape files can be stored in the directory <$PvHome>/exp/stan/nmr/lists/
wave with the TopSpin files. These files can be created using the TopSpin Shape Tool, by enter-
ing the command ‘stdisp’ in the TopSpin command line. Before the files can be used they need
to be modified manually to be accepted by ParaVision as correct shape files. 

The shape file must first have the extension of the file type it should act as, for example: 

.exc for excitation,

.rfc for refocusing,

.inv for inversion, or

.sat for saturation.

The wave files are ASCII files that can be opened and edited by any text editor. 
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Differences in TopSpin and ParaVision Shape Files

Table 12.1: Differences in TopSpin and ParaVision Shape Files

As indicated in bold in the table above, four lines in a TopSpin (or ‘stdisp’ created) shape need
to be modified manually to allow ParaVision to recognize the shape.

##$SHAPE_EXMODE:

In ParaVision this parameter must correspond to the file type indicated by the file extension, e.g.
‘Excitation’ for an .exc file, or ‘Inversion for an .inv file.

##$SHAPE_TYPE:

Must be ‘conventional’ or ‘adiabatic’ in ParaVision.

Header of a ParaVision Shape Header of a TopSpin Shape Info

##TITLE=nmr/lists/converted/gauss

##JCAMP-DX= 5.00 Bruker JCAMP li-
brary

##DATA TYPE= Shape Data

##ORIGIN= Bruker Analytik GmbH

##OWNER= <mawi>

##DATE= 101/09/20

##TIME= 15:31:06

##MINX= 1.036651e+00

##MAXX= 1.000000e+02

##MINY= 0.000000e+00

##MAXY= 0.000000e+00

##$SHAPE_EXMODE= Excitation

##$SHAPE_TOTROT= 9.000000e+01

##$SHAPE_TYPE=conventional

##$SHAPE_REPHFAC=50

##$SHAPE_BWFAC= 2.740000e+00

##$SHAPE_INTEGFAC= 4.150688e-01 

##$SHAPE_MODE= 0

##NPOINTS= 1000

##XYPOINTS= (XY..XY)

1.036651e+00, 0.000000e+00

1.074475e+00, 0.000000e+00

…

##END

##TITLE= 90° pulse

##JCAMP-DX= 5.00 Bruker JCAMP li-
brary

##DATA TYPE= Shape Data

##ORIGIN= Bruker BioSpin GmbH

##OWNER= <demo>

##DATE= 2004/09/06

##TIME= 18:56:10

##$SHAPE_PARAMETERS= Type: 
Gauss ; Truncation Level [%] 1.0

##MINX= 1.036651e+00

##MAXX= 1.000000e+02

##MINY= 0.000000e+00

##MAXY= 0.000000e+00

##$SHAPE_EXMODE= Universal

##$SHAPE_TOTROT= 9.000000E01

##$SHAPE_TYPE= Excitation

##$SHAPE_USER_DEF= 

##$SHAPE_REPHFAC= 

##$SHAPE_BWFAC= 2.122000E00

##$SHAPE_BWFAC50= 

##$SHAPE_INTEGFAC= 4.115776E-01

##$SHAPE_MODE= 0

##NPOINTS= 1000

##XYPOINTS= (XY..XY)

1.000000E00, 0.000000E00

1.018591E00, 0.000000E00

…

##END=

Comment

Comment

Comment

Comment

Comment

Comment

Comment

Comment

Min Amp Val in [%]

Max Amp Val in [%]

Exitation Mode

Pulse Flip Angle

Shape Typ

Rephase Factor 

1s Pulse BandWidth

Rel. to a rec shape

#Points in shape

Amplitude, Phase

Amplitude, Phase

End of shape file
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##$SHAPE_REPHFAC=50:

This parameter defines the length of the pulse in percent to be re-phased in a gradient experi-
ment, e.g. during the slice selection. It cannot left blank in a ParaVision shape file.

##END=: 

A known bug in ParaVision. The ‘=’ needs to be added to the END label.

If all the parameters are set correctly, the wave file only needs to be copied to the wave directory
and after a ParaVision restart, the shape will be available in the shape selection drop-down
menu of the method GUI.

12.2 Image Display Scaling

The Image Display & Processing routine (Xtip) allows the user to specify the way images are
scaled during display. 

The default is automatic scaling. Each individual frame (e.g. of a T2 sequence) will be displayed
with its full dynamic range. Each frame is mapped between its individual minimum and maxi-
mum.

The alternative is the Global User scaling. All frames will be scaled between the minimum and
maximum of the whole series of images.
T2 Images Series Displayed with Automatic Scaling

Figure 12.1: T2 Images Series Displayed with Automatic Scaling

T2 Images Series Displayed with Global User Scaling

Figure 12.2: T2 Images Series Displayed with Global User Scaling
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For automatic scaling add the line to the file <$PvHome>/exp/stan/nmr/ProcStatPref/xtip.1/Ip-
Status to specify the mode for all users:

pvcmd tImRescale a

For global user scaling add the line to the file <$PvHome>/exp/stan/nmr/ProcStatPref/xtip.1/Ip-
Status to specify the mode for all users:

pvcmd tImRescale uGlobal

If the scaling should be set for a particular user only, add the same entries to <$PvHome>/prog/
curdir/<user>/ParaVision/ProcStat/xtip.1/Pref.ips/IpStatus instead of the above file.

12.3 Providing Display Memory for Large Data Sets

In case large 3D data sets should be displayed, e.g. as MIP, the size of the working memory in
XTip needs to be set to at least the size of the data set (8 bit/pixel). If the working memory is set
too low, the full 3D data set cannot be displayed and the images are cropped. A typical solution,
which should cover all applications, is to set the size of working memory in XTip to 256 MByte.
To set this value:

1. Select File-> Configure in XTip.

2. Set the value as shown below.
Working Memory Setting

Figure 12.3: Working Memory Setting

3. Restart XTip.

Important: This value should be set as default on all systems.
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12.4 Hardware ON/OFF Procedures

This section describe the ways to switch the hardware on or off.

12.4.1 Turning the AVANCE III Console ON

 The console and computer are both off.

1. Power the console up and turn the IPSO unit on.

2. Boot the computer. This is required to start the DHCP server correctly.

3. Once the computer is booted, log in and reset the IPSO unit so that it boots.

4. When the POST code (2 7-segment LEDs on the IPSO front) gets past the stop at ‘C0’ and
starts to load the IPSO operation system, turn the AQS, BSMS, Imaging Rack, and RF am-
plifiers on. Units without ethernet connections can be turned on any time.

When this procedure is finished, the SYNC LEDs on all SGU/2’s should be green.

If not, type ‘ii restart’ in the TopSpin command line.

If they are still not green, access the DRU service Webpage (‘ha’ in TopSpin), and reset the DRU
(takes ~1minute).

12.4.2 Turning the AVANCE III Console OFF

1. Enter the service Webpage of the ISPO (‘ha’ command in TopSpin) unit.

2. Shut down the IPSO (‘ha’ (TopSpin command line)→ IPSO→ Administration→ Power Off).

3. Switch off all other units in any order.

12.4.3 Turning the Imaging Rack ON

1. Switch on all Great amplifiers.

2. Switch on the B0-2 compensation unit (if available).

3. Switch on the water cooling unit BCU20.

4. Switch on the master unit BGMUI-E.

 The master unit only recognizes the amplifiers connected during the boot process. If an
amplifier is switched on after the master unit has booted, the master unit must be restart-
ed to enable the amplifier.

 The master unit will display a ‘C01’ message in the display until the ‘Safety Parameters’
for the gradient coil are loaded manually or automatically (refer to Gradient Safety Pa-
rameters [89]).

12.4.4 Turning the Imaging Rack OFF

Switch off the devices in any order.
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12.5 Different Software (TopSpin) Versions on the System

It is possible to have multiple versions of TopSpin/ParaVision installed on the same system.
They are all located in the /opt directory of the system, and each installation has to be in a sep-
arate subdirectory, e.g. /opt/TopSpin2.1, /opt/TopSpin2.2, and /opt/ParaVision5.

The only requirement for problem free operation of the different versions is to always have the
newest DISKLESS installed.

If one version is stopped and another one started, the first command in the newly started version
must be ‘ii restart’.

12.6 Disable the HPPR Build-in Power Check

The LNA HPPR modules have a build-in power check, which is sometimes a bit too sensitive for
imaging systems. To disable the power check feature open the UniTool (‘UniTool’ in a shell), and
select HPPR, address 80, option P, 1H (option 5) and there disable the emergency stop.

12.7 Disabling the ‘External Enable’ and PT100 Check for the Master 
Unit

The ‘External Enable’ and ‘PT100’ security features can be temporarily be disabled in the mas-
ter unit.

To disable them: open ‘ha’ (TopSpin command line)→ BGAU→ BGA Configuration→ Bruker Ac-
cess (scroll down):

Login: BRUKER

Password: BGMUI12215

The security features can be re-enabled in the same menu. They are automatically enabled after
a reboot of the master unit.

12.8 Signal Instabilities

Instabilities of the signal can be caused by the magnet itself or any other hardware component.
They result in jittering of the echo position in GSP mode or ghost artefacts in images. To find the
reason for the instabilities is often a time consuming task. In rare cases it even occur, that the
instabilities where caused by movements of the building, causing the magnet to move, which
changes the magnetic field. Since the lock cannot be used in imaging, this is a very serious prob-
lem. Some other reasons found in the past are listed below.

Note: After a HPPR reset (power up) the power check is activated by default.
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Jittering of the Echo Position Due to Instabilities

Figure 12.4: Jittering of the Echo Position Due to Instabilities

A very sensitive test for instabilities is a spin echo sequence (MSME) with an echo time of >20
msec. If the system is not stable for any reason, this can often be observed directly at the time
signal. As a test, the MSME sequence can be used with a low bandwidth to view the echo po-
sition and the phase of the real and imaginary signal. Both the position and the phase should be
stable (apart from some noise which is always there).

The MSME sequence can also be acquired using the GOP command. Periodic instabilities re-
sult in ghost artifacts, which clearly become visible if the look-up table is modified to show weak
intensities.

Here is a list of reasons, which have been found to cause instability in the past:

▪ 50(60) Hz hum of the gradient amplifier: Ground loops caused a 50(60) Hz hum of the NMR
signal. This should be eliminated by the digital signal distribution in the Great imaging rack.
To check this, a spectroscopic spin echo sequence can be set up and the amplifiers can be
connected/ disconnected during the experiment to see, if the signal behavior changes when
the amplifiers are connected.

▪ Helium valve of the magnet: The helium valve on top of the magnet opens/closes in a peri-
odic way. To check this, simply remove the valve for a short period of time to see, if it affects
the signal.

▪ Vibration dampers: Check if the magnet is on vibration dampers and all dampers are on the
air cushion.

▪ Shim regulator of the BSMS/2: Check the influence of the shim regulator by setting it to a
slow mode. ‘ha’ (TopSpin command line)→ BSMS→ SHIM→ Shim Board Service Functions
SCB [1]→ Regulator Settings→ ‘Very Slow’. 

At the moment is not clear, if this setting affects e.g. the digital lock for HR applications!

▪ GRADRES Timing: The gradient resolution (GRADRES) must be set to 8 in <$PvHome>/
conf/instr/spect/uxnmr.par.
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▪ DPP ECL: The ECL for a DPP F1 board (H12513F1) must be ≥05, the ECL for a DPP F2
board (H12513F2) must be ≥01. To check this, open ‘ha’ (TopSpin command line)→ IPSO→
Administration→ Read BIS→ IPSO DPP→ DPP1. If the ECL is lower, the board has to be
returned to Bruker for upgrading (only in case of ghosting along the phase direction in the
images and if all other symptoms can be excluded).

▪ In case of strong spikes which may even be heard during the experiment (strong non peri-
odic clicks) a hardware modification in the Great amplifiers is required (only valid for
W1211690, W1215322ECL0, W1209612, W1215323 ECL0). In this case, a trained person
has to open the amplifier and replace the cable shown in the figure below, with a cable with
part number W118210. As a work around, the wire #10 of the existing cable can be removed
(the red wire marks #1). Replace the flat cable with the modified cable W118210 or remove
wire #10 of the existing cable:

GREAT 1/40 or GREAT 1/60 with the New Cable W118210

Figure 12.5: GREAT 1/40 or GREAT 1/60 with the New Cable W118210

12.9 External Trigger Doesn’t Work

When the external triggering of the console doesn’t work as expected, refer to chapter Connec-
tion from the Triggering Unit to the Console [136].
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13 Diffusion Coefficients

13.1 Diffusion Coefficient D of Various Liquids at 25°C
Diffusion Coefficients D in 10-9m2s-1.

Table 13.1: Diffusion Coefficients D in 10-9m2s-1.

Source: Bruker Almanac 2007.

13.2 Diffusion Coefficient D of Special Bruker Samples at 25°C
Diffusion Coefficients D in 10-9m2s-1

Table 13.2: Diffusion Coefficients D in 10-9m2s-1

Liquid D Liquid D Liquid D

Water (H2O) 2.299 Acetonitrile 4.37 Cyclopentane 3.09

Water (H2O) 1.872 Pyridine 1.54 Cyclooctane 0.55

Methanol 
(CH2OH)

2.415 Nitromethane 2.39 n-Penthane 5.72

Methanol 
(CH2OD)

2.30 Tetrahydrofu-
ran

2.84 n-Hexane 4.26

Methanol 
(CH2OH)

2.21 Benzene 2.21 n-Heptane 3.12

Methanol 
(CH2OD)

2.11 C6H5F 2.39 n-Octane 2.35

Ethanol 1.08 C6F6 1.46 n-Nonane 1.77

t-Butanol-d1 0.28 Toluene 2.27 N-Decane 1.37

Formamide 0.55 Carbon Disul-
phide

4.32 n-Undecane 1.07

N, N-Dimeth-
ylformamide

1.63 Carbon Tetra-
Chloride

1.30 n-Dodecane 0.81

N, N-Dimeth-
ylacetamide

1.35 Chloroform 2.35 n-Tridecane 0.70

Dimethylsul-
phoxide

0.73 Acetic Acid 1.08 n-Tetradec-
ane

0.52

Dioxane 1.09 Formic Acid 1.08 Pentan-1-ol 0.29

Acetone 4.57 Cyclohexane 1.42 Octan-1-ol 0.14

Liquid D Liquid D Liquid D

“Doped Wa-
ter” 1% H2O 
in D2O

1.91 1% PEG 
20000
0.1% CuSO4 
in D20
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13.3 Temperature Dependence of the Self Diffusion Coefficient D of 
Water (H2O)
Diffusion Coefficients of H2O at different temperatures. D in 10-9m2s-1

Table 13.3: Diffusion Coefficients of H2O at different temperatures. D in 10-9m2s-1

Source: Bruker Almanac 2007

T [°C] D T [°C] D T [°C] D T [°C] D T [°C] D

-5 0.913 20 2.023 45 3.588 70 5.615 95 8.111

0 1.099 25 2.299 50 3.956 75 6.078 100 8.667

5 1.303 30 2.594 55 4.344 80 6.557

10 1.525 35 2.907 60 4.748 85 7.056

15 1.765 40 3.238 65 5.127 90 7.574
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14 Trigger Signals

14.1 Trigger Signals at the T0 Connector
T0 Trigger Signals

Table 14.1: T0 Trigger Signals

T0 Name Description/Label ppg Command Connection Point

Signal Outputs

TTL1 TTL Out 1 TTL1_LOW
TTL1_HIGH
(nmrword 3#28)

T0 / I1

TTL2 TTL Out 2 TTL2_LOW
TTL2_HIGH
(nmrword 3#29)

T0 / I2

TTL3 TTL Out 3 TTL3_LOW
TTL3_HIGH
(nmrword 3#30)

T0 / I3

TTL4 TTL Out 4 TTL4_LOW
TTL4_HIGH
(nmrword 3#31)

T0 / I4

STAMP1 ECG_STAMP STAMP1_LOW
STAMP1_HIGH
(nmrword 3#6)

T0 / C1

NV_CLOCK DPP NV_CLOCK T0 / Z1

BlankXAmp nmrword0#32 T0 / A4

BlankYAmp nmrword0#33 T0 / A5

BlankZAmp nmrword0#34 T0 / A6

Signal Inputs

TRIG_IN1 ECG_TRIG
see chapter 10.2 
[136]

trig[np][le]1 T0 / C5

TRIG_IN2 TTL IN 1 trig[np][le]2 T0 / C6

TRIG_IN3 GRAD_SYNC trig[np][le]3 T0 / E1

TRIG_IN4 TTL IN 2 trig[np][le]4 T0 / E2
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15 Quick Introduction to Coil 
Configurations

Thanks to Ulrich Heinen for this part of the manual.

15.1 Preface: Nomenclature

The NMR and the MRI community have adopted different naming conventions for RF antennae
systems. As a consequence, ParaVision uses a different terminology than the TopSpin software
package. Users working with both packages should be aware of these differences.

In ParaVision, the physical unit bearing one or more RF resonant loops is termed a Coil (NMR/
Topspin terminology: probe or probe head). An individual resonant loop is called Coil Element
(NMR/Topspin: coil). ParaVision supports the operation of linear and quadrature coils, array
coils and multi-resonance coils as well as cryo-cooled variants of these types. Up to four differ-
ent coils may be connected to the scanner at any time. Such a combination of multiple coils is
called a Coil Configuration. The connected set of coils is termed the Active Coil Configuration.

In ParaVision 5.0, the scope of a coil configuration is tied to a study. In other words: all scans
within a study use the same coil configuration that has been specified during study setup. This
Study Coil Configuration does not need to be identical to the active coil configuration (to allow
preparation of scans before the coils are installed), but the scans cannot be executed until the
configured coils are installed.

When multiple coils are installed together, they may take up different roles in an experiment. For
example, if a transmit/receive resonator is installed together with a receive-only array, the reso-
nator can act both as the transmitting and receiving coil, or it may be used for transmission only
while the array is used for signal detection. Such different experiment situations are referred to
as (Coil) Operation Modes. Since they do not require the addition or removal of coils, operation
modes can be freely switched for each scan within a study.

The relationships between coils, coil configurations, and operation modes are visualized in the
figure below:
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Coil Handling and Routing Infrastructure in ParaVision 5.0

Figure 15.1: Coil Handling and Routing Infrastructure in ParaVision 5.0

15.2 Purpose and Scope of the Present Documentation

The present text is meant to bridge the gap until the corresponding chapter in the ParaVision
manual is complemented. It does not document the full capabilities of the coil handling but re-
stricts itself to the typical needs on NMR spectrometers with micro-imaging accessories.

The micro-imaging systems (AVANCE/AVANCE II/AVANCE III) are typically not equipped with
an Active Detuning Module (ADM), with the MRI coil interface (ODU sockets and plugs), or with
HWIDS. Likewise, systems with parallel receive extensions (RF splitter/pulse splitter) are not
discussed (yet).

Furthermore, it is assumed that typically only a single coil is mounted, which is often equipped
with multiple coil elements for different frequencies (nuclei). The configuration of multiple coils
used together, and the configuration of quadrature and array coils are not discussed.

15.3 Generation of Coil Configuration Files

For each micro-imaging probe used for ParaVision acquisition, an appropriate coil configuration
file must exist. Coil configuration files are created:

▪ During 'cf' (subcommand pvdefcoilconfs). These configuration files only cover very simple
cases; they are appropriate for initial.

▪ Automatically, if HWIDS and (ideally) the MRI socket interface are available and the coils
support it.

▪ Manually using the Coil Configuration Editor. This third option is described more closely in
the following notes.
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15.4 The Coil Configuration Editor

The coil configuration editor is technically part of pvScan (Scan Control Tool/Spectrometer Con-
trol Tool), but is not accessible from its menus as it is only needed for the initial configuration of
a new probe/coil but not for daily work afterwards. The editor window contains several distinct
sections referring to the different management/editing tasks.
The Coil Configuration Editor

Figure 15.2: The Coil Configuration Editor

15.4.1 The Coil Configuration Management Section

The top most section of the Coil Configuration Editor provides functionality for managing the ex-
isting coil configurations. On the left, an existing coil configuration can be selected, the content
of which is then displayed in the lower sections of the editor, and to which the command buttons
on the right of the configuration management section apply. Buttons exist:

▪ To save the presently displayed configuration, if it has been changed.

▪ To create a new, initially empty configuration. ParaVision asks for a name for the new con-
figuration when this button is clicked.

▪ To copy the selected configuration. This is essentially the same as the “New” button, but the
new configuration is initialized with the contents of the copied configuration, which can then
be modified (e.g. by adding further coils).

▪ To delete the presently displayed configuration from the ParaVision installation.
Z33075_00_001 153



Quick Introduction to Coil Configurations
15.4.2 The Coil Management Section

A single coil configuration may consist of up to four coils, although only a single coil (probe) is
present in micro-imaging systems. The four panels in the editor are equivalent if no MRI socket
interface is present, thus, as a general rule, only the “Coil 1” panel is used to configure micro-
imaging probe. The “Name” button can be used to load a coil known from another coil configu-
ration into the panel, below the manufacturers name, the part number and the serial number are

shown which together provide an unambiguous characterization of a coil/probe1. Clicking “Ed-
it...” opens a new editor window where the properties of the coil can be manipulated. This will
be discussed later in this chapter.

1 If the actual probe has exchangeable coils, it is recommended to keep the different setups in
separate coil configurations and use the part number of the mounted coil for registration.

15.4.3 The Spectrometer Management Section

The spectrometer management section consists of a single button “Modify spectrometer con-
nections....”. Normally, the spectrometer wiring (transmitter to preamplifier, preamplifier to re-
ceivers, LO supply from SGU‘s to receivers) is defined once during 'cf' (subdialog edasp
setpreamp). Nevertheless, for certain coils it may be necessary to rewire the spectrometer to
some degree to allow the desired experiments to be carried out. The button “Modify spectrom-
eter connections...” invokes edasp setpreamp and stores the defined connections within the coil
configuration file.

15.4.4 The Operation Mode Section

The operation mode section is further divided into a management and an editing area. The man-
agement area is similar to the coil configuration management section in so far as the operation
mode to be edited can be selected here, and buttons “New”, “Copy”, “Delete” are also provided,
performing the obvious tasks.

The button “AutoCreate / AutoUpdate” provides access to ParaVisions automatic routing gen-
erator. Based on the given coils, their properties and connectivity, the spectrometer configura-
tion and its wiring, this Autorouter is able to determine all possible routing and create operation
modes for them. After changes in the spectrometer electronics (addition/removal/exchange of
AQS boards, transmitters, or preamplifiers), the Autorouter tries to update existing operation
modes to adapt to a possibly changed routing situation. In standard situations, clicking this but-
ton should generate all operation modes needed for acquisition. If this is not the case, you may:

▪ Modify the generated modes by clicking “Setup routing...” and correct the routing paths.

▪ Add new modes by clicking first “New...”, then enter a unique name for the new mode and
finally by clicking “Setup routing...” to define the routing path.

▪ Use the button “Reconnect transmitters...” to invoke edasp setpreamp for defining a devia-
tion in the transmitter-preamplifier connections for this particular mode.

Note: The button “Reconnect transmitters...” is not yet available in current Beta versions. On
current versions, you may use the “Modify spectrometer connections...” button between setting
up the routing for different operation modes. Only the transmitter connections may differ be-
tween different operation modes. Note that current Beta versions will display routing errors
when operation modes use deviating transmitter connections by this workaround.
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One operation mode may be marked as “Default”. If a coil configuration contains multiple oper-
ation modes, this is the one preselected initially when the first scan of a study is created.

In some cases, the AutoRouter may create modes, which are technically feasible but neverthe-
less not useful for practical experiments. Rather than deleting such modes, it is recommended
to mark them as “hidden” using the corresponding button. Otherwise, such modes may reappear
when the Autorouter is rerun either manually or automatically when ParaVision detects a
change in the hardware configuration that potentially invalidates the routing.

Below these buttons, the operation mode section contains a message area which may contain
textual information about special properties of an operation mode. Currently, two such special
properties may appear:

▪ If an operation mode contains receive routing for more than one channel, it can only be used
in conjunction with ParaVisions Multi Scan Control Tool.

▪ If an operation mode has been generated manually, or if an automatically generated mode
has subsequently been modified, and a spectrometer configuration change is detected later,
such modes cannot be updated automatically. Instead, a warning message appears, stating
that the mode requires manual inspection. “Setup Routing...” has to be clicked to inspect
and potentially correct the routing. After edasp has been completed with “Save”, this warn-
ing disappears, and the operation mode will be available again for setting up scans.

15.4.5 The Coil Editor Subdialog

When clicking on the “Edit...” button of one of the coil panels, the Coil Editor dialog appears. As
an exception, if the panel previously contained no coil, then ParaVision will first ask what type
of coil is to be configured, as the layout of the coil editor depends on this. ParaVision supports
four basic types of coils:

▪ Linear coils with a single element.

▪ Multiple resonance coils with multiple elements resonant at different frequencies.

▪ Quadrature coils with an internal or external splitter/combiner.

▪ Coil arrays.

The first two types are relevant for micro-imaging setups.

Furthermore, the layout of the editor varies depending of the availability of an Automatic Detun-
ing Module (ADM) and the MRI RF socket interface.

The editor contains 4 or 5 sections as shown in Coil Type Section [156] (the section “Coil Ele-
ments” is only shown for array coils and multiple resonance coils).

15.5 Identity Section

The section “Identity” contains the name, manufacturer, part number, and serial number of the
coil. This information unambiguously identifies each coil. It is displayed in the main coil config-
uration editor, and is also used to generate an initial file name for the coil configuration.

The actual file name is not relevant to ParaVision but must not be changed, since the file is re-
ferred to from the created scans. However, creating the file name from part and serial number
eases identification of the files by an administrator.
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15.5.1 Coil Type Section

The section “Coil Type” displays the basic type of the coil being edited. You may further specify
the coarse geometry of the coil (Volume/Surface/...), although “Volume” is probably appropriate
for typical micro-imaging coils. The information is used by the Autorouter mostly for naming op-
eration modes. Finally, a coil may be marked as a cryo coil. This ensures that the connected
HPPR module is forced into cryo mode during acquisition.
The Coil Editor 

Figure 15.3: The Coil Editor 

In the figure above, the system is without ADM and socket interface, editing a multiple reso-
nance coil.

15.5.2 Coil Elements Section

The section “Coil Elements” (available only for array and multiple resonance coils) is used to
define the number of individual elements in the coil operating at the same frequency (array) or
at possibly different frequencies (multiple resonance coils). Below, the coil element to be edited
in the remaining sections can be selected.

15.5.3 Properties Section

This section applies to the entire coil except for multiple resonance coils where it applies to each
coil element individually (i.e. its contents change when a different coil element is selected). Most
importantly, the nucleus or nuclei supported by the coil element(s) can be specified. You can ei-
ther enter a single nucleus, or multiple nuclei written as, for example ”1H/19F”, or an entire nu-
cleus range like “13C-127I” for broad-band tunable coil elements. Note that nucleus lists or
ranges should always be written with the highest-frequency nucleus in the front.
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Below the nucleus field, two panels exist for transmit and receive properties of the coil. For mi-
cro-imaging purposes, coils are typically both transmit and receive capable. You may specify
simple power limits for the pulse and cw case; these are taken into account by ParaVision‘s PVM
method framework during pulse optimization. Certain receive-only coils may require a DC sup-
ply via the RF line, e.g. for an integrated preamplifier. It is recommended to leave this feature
switched off, unless you are sure that your coil requires it. Finally, if a coil element cannot be
tuned or matched, you can activate the corresponding button. The ParaVision wobble function
will then not consider this coil element.

15.5.4 RF Connections Section

If no ADM and no MRI socket interface are present, and if the coil being edited is not a quadra-
ture coil, the section “RF connections” consists of a single selection box by which you may spec-
ify where the current coil element is connected. While coil elements are normally connected to
the “Probe” connector of an HPPR/2 module, ParaVision also supports some unorthodox con-
nection options:

▪ Probe output of the HPPR/2 module.

▪ HPPR/2 channel bypass (rf_in socket at side of HPPR/2, possibly available by an adaptor
module).

▪ Directly to an amplifier/switchbox output.

▪ Directly to a receiver input.

Typically, micro-imaging coil elements are connected to the “probe” connectors in the standard
manner, thus you only have to select the correct module here.

15.6 Final Remarks

If a certain coil (probe) appears in multiple configurations, and you edit its properties within one
of the configurations, the changed properties will not apply to other configurations, since the ed-
itor only modifies the local copy of the coil description contained in the edited coil configuration
file.

15.7 Workflow for Changing Coils

When a new coil (probe) has been inserted into the magnet, the first task with ParaVision should
be to invoke “Scan Control Tool / Scanner / Change Active Coil Configuration...” to make the
currently installed configuration known to the software. On a system with installed hardware de-
tection (HWIDS), this is done automatically. If the coil is being used for the first time, it may be
necessary to create the coil configuration manually using the editor as described previously.

15.8 Working with Studies, Scans, and Operation Modes

The study concept of ParaVision relies on the idea that during a study the object of investigation
is held fixed within the magnet. This implies that adjustment results remain valid for the entire
study. Consequently, coils cannot be changed within a study, and the coil configuration is a prop-
erty of the study.
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15.8.1 Creating a Study

When creating a new study, you can use the field “Coils” to select the coil configuration that will
be used for all scans in the study. By default, the active coil configuration is preselected, but you
may also choose a different configuration, e.g. if you need to prepare a sequence of scans in
advance before the coil/probe is mounted in the magnet. This choice cannot be changed at a
later time.

15.8.2 Scan and Operation Modes / PVM

For each scan, you can choose any of the operation modes provided by the study. ParaVision‘s
method framework PVM will evaluate the routing of this operation mode and select the channel
nuclei according to the routed coil elements. Unless the coil element itself supports multiple nu-
clei (by broad-range tuning capabilities), the nucleus cannot be changed in the method editor.
Instead you will typically use the “Edit Scan” button of the spectrometer control tool, the scan
editor contains a selection box where you may choose a different operation mode that targets a
different coil element, and hence causes other nuclei to be selected.

If an operation mode has more than one channel routed on the transmit side, PVM will allow
decoupling to be activated, and the nuclei are correctly predefined for the decoupling channel.
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16 Part Numbers

DPP

DPP Board H12513F1

DPP Board (lead free) H12513F2

Master Unit

PT100 Master Unit Dummy W1214954

External Enable Master Unit Dummy W1500332

Cable Set Upgrade Master Unit -> BGMUI-E W1214823

Gradient Systems

O-Rings Micro 2.5 W3302019

O-Rings Mini 0.5/0.75 W3302248

O-Rings Diff 60,Micro 5,Diff 30 40178

BCU20

10 Filter Elements for the BCU20 water filter

- old version with white ‘paper’ filter H9531 or 68443

- new version with plastic filter 79671

Water Conditioner (Algae Stop) for BCU20 Art. 9025.1 ROTH

SA Instruments Triggering Unit

ECG Cable for Probe->SA Trig connection HZ13044

ECG Electrodes 85003

Respiration Sensor Pad 85004

IPSO

‘Coaxi’ Adapter (Coaxi to 6 BNC) HZ10124

LVDS Cable 0.5m 88201

LVDS Cable 1m 86868

LVDS Cable 2m 87925

LVDS Cable 5m 87940

HWIDS

Hardware Detection Unit (HDU) in HPPR/2 H14175

Hardware Detection Unit (HDU) in 19’’ H14179

Hardware Detection Interface (HDI) H14176
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Cable HDU-Memory Board 1.2m T12321

Cable HDU-Memory Board 2.5m T12322

Cable HDU-HDI: Standard SBS 15P.

Cable ST/BU
160 Z33075_00_001



RF Probe Parameters and Final Test Information
17 RF Probe Parameters and Final 
Test Information

17.1 Information Final Test Protocol for RF Probes on Form

This chapter gives information to some points of the form ‘Final Test Protocol for RF Probes on
AV3 Systems’. For detailed information about the signal to noise measurement procedures refer
to section Signal to Noise Ratio and z-B1 Tests for the RF Probes [119].

17.1.1 RF Insert Details and RF Performance Tests

Peak width of selected peak

Shim the sample as good as possible and acquire a single pulse spectrum (e.g. with zg in Top-
Spin or SINGLEPULSE in ParaVision). Measure the line width at 5% and 50% of the maximum
peak amplitude.

90 degree hard pulse

Run a paropt (or popt) with fixed RF pulse amplitude and vary the RF pulse length until you
reach at least a 360° RF pulse angle. Be sure that the peak of interest is on resonance. Calcu-
late the 90 degree pulse from the 360° pulse length (1/4 of the 360 degree pulse length). If pos-
sible, add a print out of the paropt to this report. The real power in watt should be noted (i. a.).

SNR from Spectrum

The sensitivity of X nuclei in imaging experiments is often not sufficient to acquire a 2D image.
Measure the spectrum with the parameters noted in the table for X nuclei in Test Sequences
and Samples [162]. Measure the sino value of the peak (area) marked in the spectra in the sec-
tion Reference Spectra [165], and multiply it with the line width at 50% of the maximum peak
amplitude. The sample should be shimmed well and the sensitivity is calculated by the formula:
Equation A-1: Signal to Noise Calculation from a Spectrum

Figure 17.1: Equation A-1: Signal to Noise Calculation from a Spectrum

The same spectroscopic test can be performed for the 1H samples as well.

ParaVision Reference Gain

Start ParaVision, execute Auto Reference Gain Adjustments and note the value for PVM_RefAtt
(enter PVM_RefAtt in the ‘Single Parameter Editor’ to get the value). This typically only work for
1H signals and can be skipped for X-nuclei.
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S/N per mm3 and B1 Homogeneit in xy Planes, z-Homogeneity

For proton coils (and for X if the test sample delivers a sufficient signal for imaging), run the se-
quence as described in the table for 1H in Test Sequences and Samples [162]. (e.g.
mic_msme_snr*).

Create a new scan and load the protocol mic_msme_zB1prof. This is actually a single xz-slice
spin echo sequence, where the isotropic FOV should be larger than the length of the RF coil. If
this experiment is set up, the correctly adjusted FOV could be checked in the Reco window while
GSP is running. Correctly adjusted in this case means, that there is a plateau in the center of
the Reco display which goes down toward 0 at the window borders (e.g approx FOV of 25 mm
for a 10 mm coil, or 50 mm for a 30 mm coil).

After the axial and the sagital data sets are acquired, start the macro ‘mic_rfTest’. Enter the ex-
pno and procno number of the 2 experiments and finally press ‘Create Test Form’ to generate a
test report print out.

From this test report, the S/N and xy-homogeneity values can be extracted. Note the z-B1 inter-
val where the profile doesn’t go below 85% of the maximum amplitude. For more details refer to
chapter Signal to Noise Ratio and z-B1 Tests for the RF Probes [119].

17.1.2 Test Sequences and Samples

Experiments with the parameters and samples from the table below are performed to acquire
parameters for signal to noise ratio and if possible homogeneity of an RF coil. 

Until now, only a 1H image signal to noise data base is available (see the table in Signal to Noise
Ratio for 1H RF-Coil Elements [164]) but X data bases will be added when they are available.
The 1H coils are tested with an imaging sequence, where the signal to noise is normalized to a

volume of 1 mm3 with the help of a post processing macro to be able to compare different coil
diameters and coil performances at different field strengths. Additionally, the coil homogeneity
is calculated using the same post processing macro. Test samples are containers, filled with the
appropriate liquid for the nucleus of interest. The container should tightly fit into the RF coil, e.g.
a 10 mm NMR tube for a 10 mm coil, or a 34 mm tube/cylinder for a 34 mm coil.

Signal to noise tests for X coils are performed on 5 or 10 mm test samples. Their size is not
adapted to the RF coil. These samples do not provide enough signal for an image test. Imaging
tests to check the homogeneity can be performed on different samples with higher concentration
but are not part of the acceptance test. However, the homogeneity tests should be performed
during the Bruker final test to ensure a good coil quality and the print out should be added to the
final test forms.
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Standard Parameters for Imaging Signal to Noise Ratio Tests (1H) and Homogeneity Tests

Table 17.1: Standard Parameters for Imaging Signal to Noise Ratio Tests (1H) and Homogeneity Tests

1H 2H 13C 19F 23Na 31P 129Xe

Sample 20% H20, 
80% D20, 
g/l CuS04

20% H20, 
80% D20, 
1g/l CuS04

10g 13C 
99% en-
riched 
methanol + 
17ml D20

Fomblin y 
LVAC 06/6 Al-
drich 31,792-6 
average MW 
1800

18g/l NaCl 
in H2O

85% Phos-
phoric Ac-
id, doped ca 
1g/l GdCl3

Sample 
Spectrum

Imaging Sequence

Method mic_msme mic_msme mic_msme mic_chess mic_msme mic_msme

Matrix 256 64 64 256 64 128

SW_h 100 kHz 100 kHz 50 kHz 100 kHz 100 kHz 100 kHz

TE 7 msec 7 msec 7 msec 10 msec 7 msec 7 msec

TR 1000 msec 1000 msec 5000 msec 1000 msec* 
NSlices

200 msec 500 msec

Rf pulse Sinc3 Sinc3 Sinc3 Sinc3 Sinc3 Sinc3

Pulse BW 3 kHz 3 kHz 3 kHz Exc: 2.0 kHz
Rfc: 3.0 kHz

3 kHz 3 kHz

NA 1 4 4 1 16 16

FOV 1.2*CoilID 1.2*CoilID 1.2*CoilID 1.2*CoilID 1.2*CoilID 1.2*CoilID

SliceOrient Axial Axial Axial Axial Axial Axial

SlThick 1 mm 2 mm 10 mm 1 mm 5 mm 3 mm

NSlices Ca. 15 Ca. 11 Ca. 3 Ca. 10 Ca. 3 Ca. 5

Protocol mic_msme
_snr_1H

mic_msme
_

mic_msme
_snr_13C

mic_msme 
_23Na
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Standard Parameters for Spectroscopic Signal to Noise Ratio Tests (X nuclei)

Table 17.2: Standard Parameters for Spectroscopic Signal to Noise Ratio Tests (X nuclei)

17.1.3 Signal to Noise Ratio for 1H RF-Coil Elements

Data base for signal to noise ratio of proton coils at different frequencies. The acquired images
are processed by the macro mic_rfTest to normalize the SNR to 1 mm^3.
SN Ratios for 1H Coils, acquired with Sample 20% H2O, 80% D20, and 1g/l CuSO4

Table 17.3: SN Ratios for 1H Coils, acquired with Sample 20% H2O, 80% D20, and 1g/l CuSO4

1H 13C 19F 23Na 31P

Sample 20% H20, 80% 
D20, 
1g/l CuS04

“Temp Calibra-
tion” 80% Gly-
col DMSO-d6 
5 mm Z10129 
10 mm Z10130

1 molar TFT in 
CHCl3

1 molar TPP in 
Acetone

Sample T1 1.13 sec at 9.4T 1.63 sec at 11.7T 1.9 sec at 9.4T

Imaging Sequence

Pulse Program mic_msme Zg Zg Zg

td 256 16 k 8 k 16k

swh 100 kHz 30 kHz 10 kHz 10 kHz

NS 7 msec 32 4 4

DS 1000 msec 0 0 0

P1 PL1 Sinc3 90° 90° 90°

D1 3 kHz 5s 5s 5s

No lock, no decoupling

WDW 1.2*CoilID No No No

lb Axial 0Hz 0 Hz 0 Hz

Si 1 mm 16 k 8 k 16 k

ID (mm) 200 MHz 300 MHz 400 MHz 500 MHz 600 MHz 700 MHz 750 MHz 800 MHz 900 MHz

2.5 10301 38277 61590 64277

5 5246 15509 24141 27055 30950 45900

8 8405

10 370 2672 6284 9463 11388

15 1800 3704 5471 6865 21380

20 1361 2546 3709 4793 5325

25 1095 1903 2744 3628

30 917 1501 2144 2889

34 812 1275 1811 2471

38 728 1103 1558 2151

64 170 439 559 770 1122
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17.1.4 Reference Spectra

13C

The standard sample for 13C SNR tests is the HR standard sample “Temp. Calibration”, which
consists of 80% Glycol in DMSO-d6. The 5 mm sample has the part number Z10129, the 10 mm
sample part number Z10130.
13C Spectrum of the Temp. Calibration Sample.

Figure 17.2: 13C Spectrum of the Temp. Calibration Sample.

The spectrum above was acquired at 400 MHz with a 25 mm 1H/13C birdcage resonator. The
figure shows the S/N comparison for a 5 mm and 10 mm sample. The acquisition and process-
ing parameters are noted in the X Nuclei table in Test Sequences and Samples [162].

19F

The standard sample for 19F SNR tests is 1 molar TFT (Trifluorotoluene) in CHCl3, 5 mm or 10
mm samples.
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19F Spectrum of the 1 Molar TFT Sample.

Figure 17.3: 19F Spectrum of the 1 Molar TFT Sample.

The spectrum above was acquired at 400 MHz with a 25 mm 1H/19F birdcage resonator. The
acquisition and processing parameters are noted in the X Nuclei table in Test Sequences and
Samples [162].

23Na

Not available.

31P

The standard sample for 31P SNR tests is 1 molar TPP (Triphenylphosphine) in Acetone, 5 mm
or 10 mm samples.
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31P Spectrum of the 1 Molar TPP Sample.

Figure 17.4: 31P Spectrum of the 1 Molar TPP Sample.

The sample above was acquired at 500 MHz with a 20 mm 1H/31P birdcage resonator. The ac-
quisition and processing parameters are noted in the X Nuclei table in Test Sequences and
Samples [162].
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17.2 Final Test Protocol for RF Probes

System Order Number

Customer Name & Location

System / 1H Frequency

Test Engineer / Date

Test Equipment

Test Equipment

TopSpin Software Version

ParaVision Software Version

Passed Passed with restric-
tions

Not Passed

Overall Test

Information:

Create one copy for each probe type.

Send a copy of the filled in form to micdiff@bruk-
er.de

Signed: ……………….…………

Name:………………………...

Date: ………………………….
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17.2.1 Hardware Components

Record part numbers, ECL‘s, serial numbers of the individual components.

17.2.2 Details and Integrity

In this part of the test procedure the RF system should be checked for completeness, mechan-
ically correct assembly and proper appearance. Additionally, some details of the probe base are
recorded.

Type of Probe (Mini, Micro, AHS…)

Probe Base

Part Number/Serial Number

1H Amplifier of Test System

1H Preamplifier LNA HPLNA HPHPPR

X-Amplifier of Test System

X Preamplifier LNA HPLNA HPHPPR

Quad Combiner (i.a.)

Part Number/Serial Number

Test System Final Test System Customer System

Description OK Not OK Not Req.

All components are properly manufactured and assembled

All parts are labelled correctly (part numbers…)

Technical manual included?

RF system contains HWIDS? Yes No

→ if ‘Yes’ All cables included?

Probe base has build-in slip clutches? Yes No

Probe base has animal support? Yes No

→ if ‘Yes’ Head holder available and anaesthesia hose fixed?

Cable to connect trigger device to probe base?

ECG extension leads required and available?

Rf connectors BNC-Type N-Type

Dewar is delivered and has correct length?

Heater and heater BVT cable delivered and has correct length?

Comments on this tests:
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17.2.3 RF Insert Details and RF Performance Tests

In this section, the details and RF performance of the inserts should be tested. Check the details
of the insert record the position of the RF centre and determine the RF properties (90° pulse,
SNR and homogeneity (1H), pulse power).

To determine the RF properties, a fully functional ParaVision with a calibrated gradient system
is mandatory.

Test samples are defined in the section Test Sequences and Samples [162].
Nomenclature:

▪ “RF Coil” is the physical resonator, which can be an exchangeable insert or a fixed coil.

▪ “Coil Element” is the oscillating circuit in an RF-Coil. A double tuned RF coil for example con-
tains 2 coils elements, one for each frequency.
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This test form can be found as PDF form on the uImag-Addon CD or in $PvHome/prog/docu/
english/uimag/FormSystemtest.pdf when the Addon CD (version created after 09.09.2010) is in-
stalled. The completed form can only be printed as hardcopy or printed to file as postscript or
PDF (if appropriate software is installed).

In case the file can only be printed to file as postscript file, it can be converted to PDF by the
console command:  ps2pdf <name>.ps

 Two pdf files can be combined by:
gs –dBATCH –dNOPAUSE –q –sDEVICE=pdfwrite 
–sOutputFile=<outfile>.pdf <pdf1>.pdf <pdf2>.pdf ...
(doesn’t work for pdf forms!)
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18 Gradient System Parameters and 
Final Test Information

18.1 Information Final Test Protocol Gradient Systems Form

This chapter gives information on some points of the form ‘Final Test Protocol Gradient Sys-
tems’. For detailed information on the individual adjustments, refer to chapter Gradient System
and Amplifier Setup [87].

18.1.1 Gradient System Adaptation and Strength

Loop Adaptation

First of all, the loop parameters of the amplifiers need to be adapted to the gradient coil. 

1. Run a preemphasis experiment (mic_preemp in ParaVision or ‘diff config’ in TopSpin) to
generate gradient pulses with a length of 1 msec and an amplitude of 33%.

2. Adjust the loop parameters in setpre in that way, that there is no or a minimum (<<5%) over-
shoot of the gradient current.

 There must be no negative dip and no oscillation following the gradient current over-
shoot.

3. Measure the current at the current monitor output of the gradient amplifier or (better) with a
current probe.

For this test, all preemphasis values must be set to 0! 

For details refer to the section Loop Regulation Adaptation [92].

Preemphasis Adjustment

1. Run a preemphasis experiment with gradient amplitude of 33% and a length of 50 msec.

2. Observe the FID‘s between 300 µsec...300 msec, each FID should be at least 50msec long.

3. Adjust the preemphasis in such a way, that the integrals of the FID‘s are within a 15% peak-
peak range.

Pay attention to have a well shimmed sample and avoid radiation damping (low flip angle) or
saturation effects (add CuS04 or another T1 shortening substance). 

For details refer to the section Preemphasis Adjustment [96].

B0 Adjustment

1. Adjust the B0 shift compensation (if available) running the same experiment as for the pre-
emphasis adjustment, but be sure to be on resonance.

2. Unshuffle the acquisition display to see the signal phases and adjust all FID‘s to have the
same phase and frequency.
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For details refer to the section B0 Adjustment [101].
Preemphasis adjustments and B0 adjustments can also be automatically adjusted, but should
be checked manually.

18.1.2 Gradient Strength and Linearity

Gradient Strength

1. Measure spin echo (MSME) images of the sample and compare the physical geometry of
the sample with the geometry displayed in the MRI images.

2. Calculate the gradient strength manually or use the protocol m_installation/mic_gradcalc to
calculate them.

 Be sure to determine the dimensions in the images only in phase direction, since shim
distortions do not affect the geometry in phase direction.

 Use the protocols m_installation/mic_gradcalib_xy (measure the values for x in the 1st
image from left to right (“B”), the value for y in the second image from top to bottom (“A”))
and m_installation/mic_gradcalib_z (z from top to bottom).

3. Adapt the ‘Field of View’ of the protocols to the calibration sample size (Geometry Editor).

For details refer to section Gradient Calibration [105].

Gradient Linearity

1. Measure the linearity of the gradient.

2. Load the protocol m_installation/mic_gradlin_xy.

3. Adapt the ‘Field of View’ of the protocol to the calibration sample size and the number of
slices to its length (Geometry Editor).

4. Measure the values for x in the first half of the image series from left to right (“B”), in the sec-
ond half of the series measure y from top to bottom (“A”) (e.g. if you acquire 24 images mea-
sure x in the images 1...12 and y in the images 13...24).

Nylon Screw Sample

Figure 18.1: Nylon Screw Sample
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XY and YX Images Used to Determine the Linearity of the Gradient System in X and Y of a Nylon Screw Sample

Figure 18.2: XY and YX Images Used to Determine the Linearity of the Gradient System in X and Y of a 
Nylon Screw Sample

XY and YX Images Used to Determine the Linearity of the Gradient System in X and Y of a Nylon Screw Sample

Figure 18.3: XY and YX Images Used to Determine the Linearity of the Gradient System in X and Y of a 
Nylon Screw Sample

5. Load the protocol m_installation/mic_gradlin_z Adapt the ‘Field of View’ of the protocol to
the calibration sample size (Geometry Editor). 

6. Measure the z distance at different positions in the image to get the linearity information.
XZ Image of a Nylon Screw.

Figure 18.4: XZ Image of a Nylon Screw.

7. Measure the distance between the tips with the help of a caliper and compare it with the dis-
tance, measured in the MRI image. 
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In the center is should be precise, the further you move away from the center, the stronger
the deviation will be. 

The deviation is calculated using:

Deviation = Dimension of Sample / Dimension in Image

18.1.3 Typical Gradient Coil Parameters 

Typical gradient coil parameters and maximum power specifications.
Typical Gradient Coil Parameters

Table 18.1: Typical Gradient Coil Parameters

Micro 
5

Micro 
2.5

Mini 
0.5

Mini 
0.75

Diff 30 Diff 50 Diff 60

Part Number M81111 M81112 M81171 M81113 W1223
05

M81163

PV Status S019 S040 S057 S057

Maximum DC Current on 1 
Channel (1.2*I(3 channel))

14.4A 14.4A 14.4A 10.5A 6.2A 6A 5A

Maximum DC Current on all 
Channels

3*12A 3*12A 3*12A 3*8.8A 6.2A 6A 5A

Typical L[µH] 18 100 45 80 180 540 850

Typical R[Ω] X:0.11
Y:0.18
Z:0.17

X:0.39
Y:0.48
Z:0.36

X:0.72
Y:0.78
Z:0.53

X:1.24
Y:1.45
Z:1.19 Z:1.04 Z:0.67 Z:1.6

Resistor for HWIDS Encod-
ing [Ω]

1k
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18.1.4 Typical Gradient-Setpre Parameters

Typical parameters to set up the gradient systems in the software.
Setpre Parameters for the Different Gradient Systems

Table 18.2: Setpre Parameters for the Different Gradient Systems

Amplifi-
er

Micro 5 Micro 2.5 Mini 0.5 Mini 0.75 Diff 30 Diff 50 Diff 60

Safety Parameters in setpre → ‚gradsafe’

Maximum 
Voltage

100 V 100 V 100 V 100 V 100 V 100 V 100 V

Maximum 
Current  

Great 40 
Great 60 

40 A 
60 A 

40 A 
60 A 

40 A 
60 A 

40 A 
60 A 

40 A 
60 A 

40 A 
60 A 

40 A
50 A

Coil Resist x/
y/z [Ω]

0.11/
0.18/0.17

0.39/0.48/ 
0.36

0.72/
0.78/
0.53

1.24/1.45/
1.19

1.04 0.67 1.6

Power Sum 66 W 177 W 300 W 300 W 40 W 25 W 40 W

Mean Power x/
y/z [W]

23/37/35 80/100/75 150/161/
110

136/160/
13

40 25 40

Adjustable Int. 
Time

1 s 1 s 1 s 1 s 1 s 1 s 1 s

Integ. Time 
Power Sum

66 W 177 W 300 W 300 W 40 W 25 W 40 W

Integ. Time 
Mean Power

23/37/35 80/100/75 150/161/
110

136/160/
131

40 40 40

Loop Parameters in setpre

Resistors 50 10 75 x:28.2 
y:28.2 
z:19.3

30 0 10

Capacitors 5 16 13 x:4.3 
y:4.3 
z:4.2

11.8 27 27

Gradient Parameters in setpre

Typ. Ramp 
Time[usec]

80 100 100 100 300 500 900

Typ. Rise 
Time[usec]

120 150 150 160 600

Calib.. Con-
stant [Hz/cm]

Great 40
Great 60

808 000
1 212 000

404 000
606 000

80 000
121 000

120 000
180 000

5 023 000
7 535 000

8 000 000
121 00 000

10 133 000
12 660 000
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18.2 Final Test Protocol for Gradient Systems

System Order Number

Customer Name & Location

System / 1H Frequency

Test Engineer / Date

Test Equipment

Test Equipment

TopSpin Software Version

ParaVision Software Version

Passed Passed with restric-
tions

Not Passed

Overall Test

Information:

Create one copy for each individual gradient system.

Send a copy of the filled in form to micdiff@bruker.de

Signed: ……………….…………

Name:………………………...

Date: ………………………….
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18.2.1 Hardware Components

Record part numbers, ECL‘s, and serial numbers of the individual components.

Gradient Coil Type

Part Number/ECL/Serial Number

Gradient Holding

Part Number/ECL/Serial Number

Gradient System Length l

Bottom of shim system to magnet center

____________________mm

Gradient System contains HWIDS ? Yes No

Imaging Rack Final Test System Customer System

Gradient Interface (Master Unit,…)

Part Number/ECL/Serial Number

x-Amplifier

Part Number/ECL/Serial Number

y-Amplifier

Part Number/ECL/Serial Number

z-Amplifier

Part Number/ECL/Serial Number

B0-2 Compensation Unit (i.a.)

Part Number/ECL/Serial Number
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18.2.2 Gradient Global Check

In this part of the test procedure the gradient system should be checked for completeness, me-
chanically correct assembly, proper appearance and the correct spare parts.

18.2.3 Gradient System Adaptation and Strength

In this section, the gradient system has to be connected to the imaging rack. ParaVision must
be running and at least a default preemphasis file has to be installed on the system. Be sure to
run all experiments with GRADRES=8.0µsec. ($XWINNMRHOME/conf/instr /spect/uxnmr.par)

Loop Adaptation

Table 18.3: Loop Adaptation

Description OK Not OK Not Re-
quired

All components are properly manufactured and assembled?

All parts are labelled correctly (part numbers…)?

All necessary screws and tools are delivered?

Mini Systems: Allen key to mount the gradient coil on the holder and in the 
magnet Micro 2.5 system: Brass screw/disk combination for tool free fitting.

Spare o-rings for cooling?

Manual for the gradient system?

Assembled gradient system is water tight (connect to chiller)?

Gradient System can be fixed tightly in the magnet?

Comments on this tests:

Description OK Not OK Not 
Required

Loop Adaptation

Typical values with ‘Ramp Time = 100 µsec’ (80 µsec for Micro 5):

Adjusted loop values for each direction:

X:  Resistors: _________ Capacitors:_________ Imp: HIGH
Y:  Resistors: _________ Capacitors:_________ Imp: HIGH
Z:  Resistors: _________ Capacitors:_________ Imp: HIGH
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Preemphasis

Table 18.4: Preemphasis

Description OK Not OK Not 
Required

Preemphasis Adjustment: The integrals of the FIDs between 300 µsec 
and 200 msec are within a 10% peak-peak range?

X→X Amplifier Offset Coarse:__________________ Fine:__________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Y→Y Amplifier Offset Coarse:__________________ Fine:__________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Z→Z Amplifier Offset Coarse:__________________ Fine:__________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Are strong cross preemphasis values necessary to reach the 10% pre-
emphasis criteria? If yes, please add values on a separate form.
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B0 Compensation

Table 18.5: B0 Compensation

Description OK Not OK Not 
Required

B0 Adjustment: The FIDs between 300 µsec and 200 msec show (al-
most) the same and frequency during the experiment?

X→B0 Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Y→B0 Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Z→B0 Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Time Base

_________ 
msec

Time [msec]: _________________________________

Gain[%]: ____________________________________

Comments on this tests:
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18.2.4 Gradient Strength and Linearity

During these tests, the calibration of the gradients is performed. Prerequisite for this test is an
adapted preemphasis and (i.a.) B0 compensation. All tests run in ParaVision and a geometrical-
ly well defined sample (well defined in all 3 dimensions) must be used. The sample can be e.g.
a nylon screw, a LEGO, a connector enclosure or something similar.

18.2.5 MAPSHIM (on final system during installation)

Run the MapShim calibration during the installation of the final system as described in the step
to step MapShim manual (available on the micro-imaging add-on or from micdiff@bruker.de).
Mark the position (mounting angle) of the gradient system on the magnet bottom.

18.2.6 Miscellaneous and Notes

Description OK Not OK Not Re-
quired

Gradient Strength within Specifications?

Value: _________________________ Hz/cm

Gradient Scaling Factors:

Gradient Scaling Factor X: _____________

Gradient Scaling Factor Y: _____________

Gradient Scaling Factor Z: _____________

Gradient Linearity Test:
Specified Value: The deviation should be 0.9 < Deviation < 1.1

Max. Deviation along x: _____________

Max. Deviation along y: _____________

Max. Deviation along z: _____________

Range along z:               ______________ mm

Comments on this tests:

MapShim calibrated successful-
ly?

Position marked on magnet:

Comments on this tests:
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19 Imaging Rack Final Test 
Information

19.1 The Final Test Protocol Imaging Racks Form

This chapter gives information to some points of the form ‘Final Test Protocol Imaging Racks’.

19.1.1 Setpre and Web Interface Functionality

Setpre after ‘ii restart’

1. Open setpre (type ‘setpre’ in the TopSpin command line) and close it.

2. Enter ‘ii restart’ in the TopSpin command line to restart the ipso server.

3. Open setpre again.

 Does it start properly?

Open Web Interface

Open the Web interface by:

1. Entering the ‘ha’ command in TopSpin.

2. Selecting ‘Open BGAU’.

Internal Blanking:

1. Start the protocol m_installation→mic_blankcheck in GSP mode.

2. Observe the gradient current output (monitor) and the blanking output of the Master Unit on
a scope.

 If all preemphasis values for the selected channel are 0, the blanking must be opened
(low) at the start of the gradient pulse and stay open for approx. 10 msec after the gra-
dient is switched off.

3. Set a time constant of 2 msec for the selected channel in setpre and increase the gain.

 With increasing gain the low period (open) of the blanking signal must become longer.

Offset

To observe any offset changes:

1. Start the protocol m_installation→mic_ampoffset in GSP mode with a well shimmed sample
in the system.

2. See whether the integral (shape) of the FID changes if the offset value is modified.

For details refer to the section Great Offset Adjustment [91].
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Auto Offset

When the internal blanking is connected simply start the “Auto Offset” procedure by clicking on
the button.

When the external blanking is connected disconnect the blanking cables first, then start the ‘Au-
to Offset’.

The auto offset adjusts only the fine offset. The coarse offset has to be set beforehand. On new
systems (Great 1/60 with ECL≥9, Great 1/40 with ECL≥5) the coarse offset is typically set to 0.

For older Great amplifiers, the coarse offset must be set manually (typical values are between
-4 and -6, but certain amplifiers might need different values). 

For details refer to the section Great Offset Adjustment [91].

Loop Adaptation:

1. Control the gradient current shape on an oscilloscope, which is connected to the current
monitor, using a current probe.

2. Use the protocols m_installation→mic_preemp_50msec_33pc_X/Y/Z to generate the gradi-
ents.

19.1.2 ParaVision Tests

Automatic Safety Parameter Download

Safety Parameter Setting:

1. Switch Master Unit Off and On. It stops with a C01 in the display.

2. Start ParaVision Experiment with GSP or GOP.

 The safety parameters must be set automatically.

 The experiment must start without any delays or missing scans.

Preemphasis Adjustment

1. Run the protocol m_installation→ mic_preemp_50msec_33pc_<XYZ> on a well shimmed
sample.

 Be sure that external blanking is disabled in the pulse program, or use internal blanking.

 “GS_typ” must be set to “Preemphasis” (check/set in the Single Parameter Editor) to al-
low any preemphasis/B0 shift changes.

FLASH sequence

1. Load protocol uImag_xmm/mic_flash_ortho and start it with the traffic light.

2. Scale up the look up table to see the noise.

Note: During the auto offset process it might happen, that the I2C communication between the
Master Unit and the Great amplifiers break down (error message in setpre and I2C error mes-
sage in the web interface). The Master Unit has to be restarted to get rid of this error. This prob-
lem can show up during the ‘Auto Offset’ process and was never observed in any other
situation.
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 There should be no ghost image of the original object visible then.

Multi Slice Multi Echo sequence

1. Load protocol uImag_xmm/mic_msme_8e_ortho and start it with the traffic light.

2. Scale up the look up table to see the noise.

 There should be no ghost image of the original object visible then.

Duty Cycle Tests

1. Load protocol m_installation/duty_cycle_x and start it with GOP, so that it runs for 30 sec-
onds.

2. On Great 60 amplifiers, the 15A fuses in the filter box must be replaced with 20A fuses.

This test should only be performed at a Bruker Final Test Site!!!

Field modulation

 Be sure that the B0 shift compensation unit is switched on in setpre.

1. Put a 20...100% H2O with 1g/l CuS04 sample to the magnet and shim it roughly.

2. Put the Tx0 slider to 60 dB, set the receiver gain to 64 and run the protocol m_installation→
mic_magtest.

3. Enter the experiment data directory of the selected data set and display the file PhiPlot.ps
(kghostview PhiPlot.ps).

 In the upcoming spectrum, the peak amplitude of the 50 Hz resonance must be ≤0.15
Hz (or. ≤0.75 Hz on a standard bore system).

There are 2 reference lines visible at 5 Hz and 70 Hz with amplitudes of 0.2 Hz. It may be nec-
essary to run the macro Service/SvMagTestAuto to process the acquired data manually when
the scan has finished.

19.1.3 Enhanced Resolution Tests

These tests are only required if a new DPP software or a new Master Unit firmware is involved
in the tests.

Enhanced Current Resolution:

Connect a load of ~1 Ohm/50W to the output of a Great amplifier. Set the loop parameters Re-
sistor/Capacitor to 50% and disconnect the blanking connector. Measure the voltage at the 1
Ohm resistor by a multi meter in ~200 mV range.

telnet <IPSO IP Adresse>, login root:IPSO and start ./ipsotest

In ipsotest enter ‘d’ (for DPP1) and change the value and the addresses 

address 3000=x, address 3004=y, address 3008=z.

wm <address> 4 <value> <value> = 20 Bit hex value. 
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If ‚Enhance Resolution = OFF’ the voltage value measured by a multimeter should only change,
when the figth lowest bit changes. This means a change from 0x00 → 0x07 does not change
the voltage; a change from 0x07 → 0x08 changes the voltage. Then the voltage must be stable
from 0x08 → 0x017 and a change appears from 0x17 → 0x18.

If ‚Enhance Resolution = ON’ the voltage value measured by the multimeter should change ev-
ery 2 second bit. This means a change from 0x00 → 0x01 does not change the voltage, a
change from 0x01 → 0x02 changes the voltage, no change from 0x02 → 0x03, a change from
0x03 → 0x04 and so on…

Amplitude Stability

1. Put a 20 to 100% H2O with 1g/l CuS04 sample in the magnet and shim it roughly.

2. Load the protocol uImag_xmm/mic_flash_ortho. 

3. Enter the parameter ‘ACQ_scaling_phase’ in the field ‘Spectrometer Control Tool → Edit
Single Parameter’. 

4. Set this value to 0.0. 

5. Run this experiment. 

6. Clone it. 

7. Set “Enhance Resolution==OFF” in the setpre tool. 

8. Run the experiment again.

 The images should only show a vertical or horizontal line in the center of the image. The
images should not have visible sidebands, and more importantly, no differences in the
side band amplitudes between the 2 images when the lookup table is scaled up.

Images Acquired as Described in ‘Amplitude Stability’.

Figure 19.1: Images Acquired as Described in ‘Amplitude Stability’.

The left image in the figure above shows a good stability, the right image shows a modulation of
the FID signals.
190 Z33075_00_001



Imaging Rack Final Test Information
19.2 Final Test Protocol Imaging Racks

System Order Number

Customer Name & Location

System / 1H Frequency

Test Engineer / Date

Test Equipment

Test Equipment

TopSpin Software Version

ParaVision Software Version

Diskless Version
/tftpboot/version.txt

Passed Passed with restric-
tions

Not Passed

Overall Test

Information:

Send a copy of the filled in form to micdiff@bruker.de Signed: ……………….…………

Name:………………………...

Date: ………………………….
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19.2.1 Hardware Components

Record part numbers, ECL‘s, serial numbers of the individual rack components.

Master Unit Version

W1522066

BGMUI-E

Part Number/ECL/Serial Number W1522066/

x-Amplifier Great ____/____

Part Number/ECL/Serial Number

y-Amplifier Great ____/____

Part Number/ECL/Serial Number

z-Amplifier Great ____/____

Part Number/ECL/Serial Number

B0-2 Compensation Unit (i.a.)

W1214106

B0-2 Compensation Unit

Part Number/ECL/Serial Number W1214106/

Gradient Filter Cable

Part Number/ECL/Serial Number

W1212109 ECL ≥ 02

W1212172 ECL ≥ 03

W1213554 ECL ≥ 02

Mains 230V/32A 380V/16A 380V/32A
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19.2.2 Master Unit Global Check

In this part of the test procedure the global like completeness and mechanically correct assem-
bly should be performed. No software or test hardware is required for this section.

Sequence to switch on the imaging rack:

1. All gradient amplifiers

2. The B0 compensation unit (i.a.)

3. The Master Unit

Description OK Not OK Not
Required

All components are labelled with the correct number?

All cables mounted and fixed properly, cables leaving the rack on the 
backside are not squeezed?

Technical manual for the Master Unit (printed or BASH)?

Technical manual for the Amplifiers (printed or BASH)?
The Great manual Z31659 can be found on the BASH

All components are assembled correctly and fixed tightly?

A plug is connected at the 220V control cable?

External Enable Dummy Connector is available?

External Blanking Cable is available? (HZ14004)

B0 Compensation Unit Cable is available? (HZ12200)
SCB20 adapter Z108181 is required to connect to BSMS/2

The 6 monitoring coax cables are connected?

Master Unit boot process stops with a C01 display message?

Connection for Gradient Synchronization and external Trigger?
IPSO T0 Connector E1-Z1 (by 2xHZ10124 or HZ10124 and HZ16260)

Comments on this tests:
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19.2.3 Basic Functionality

The basic functionality of the imaging rack is tested in TopSpin. A TopSpin version ≥2.1 or a Top-
Spin version coming with ParaVision 5 is required for this test. A standard, or already optimized
setpre parameter file including safety parameters, is the precondition for this test. Make sure that
the Master Unit BGMUI-E W1522066 GRADRES ($XWINNMRHOME/conf/instr/spect/
uxnmr.par) is set to 8.0.

During the boot process, the Master Unit may stop and display a C01 message. This indicates
that the safety parameters are not set, and you will need to use setpre to load the safety param-
eters to the unit. These parameters are stored in the gradsafe menu in setpre and are loaded
automatically to the Master Unit, when ‘Read Default’ is selected, or alternatively, when ‘Apply’
is selected in the (password protected) gradsafe menu page.

Description OK Not OK Not
Required

Master Unit and DPP are correctly detected by ‘cf’?

Check the Application Firmware Version in the web interface
Application Version (Firmware): 20080205?

Are all amplifiers shown ‘enabled’ by the Master Unit LED‘s?

Master Unit changes status from C01 to temperature display when 
‘Read Default’ is executed in setpre?

Master Unit shows correct temperature of gradient coil (+/- 1K)?

Master Unit shows E03 if PT100 connector is disconnected?

Master Unit shows E02 if ext. enable connector is disconnected?

Master Unit can be reset by red button?

Comments on this tests:
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19.2.4 Setpre and Web Interface Functionality

Check the functionality of the web-interface and the setpre features. The communication be-
tween both programs is checked and the offset for the Great amplifiers is adjusted. 

Description OK Not OK Not
Required

Master Unit: Ethernet is detected by ‘ha’ in TopSpin?
Ethernet Address: _______._______._______._______

Does setpre recognize the amplifiers and B0 correctly?

Does setpre restart correctly after ‘ii restart’?

Is the BIS data in the web-interface correct (BIS content)?

Are the same amplifier stages displayed in setpre and the web-interface 
(Channel X, Y, Z → Gain) for x, y, and z?

Are the same loop parameters displayed in setpre and the web-inter-
face (Channel X, Y, Z → Res, Cap, Load) for x, y, and z?

Is the internal blanking threshold set to 0 in the web-interface?
See “BGA Configuration→Change Blanking Threshold…”

Is the internal blanking changing when the time constant for the preem-
phasis is changed?

Is a change of the ‘Enhance Resolution’ parameter in setpre detected by 
the web interface (BGA Configuration→Bruker Access, only if pass-
word available) and the opposite way?

Which gradient system is connected to test the amplifiers?
Name: _________________________ Part Number/Serial Number: ______________________

Description OK Not OK Not
Required

Can the coarse offset be changed from setpre (x, y, z)?

Is the same coarse offset value displayed in the web-interface (Channel 
X, Y, Z → Coarse Offset)?

Can the offset be changed from setpre (x, y, z)?

Is the same offset value displayed in the web-interface (Channel X, Y, Z 
→ Fine Offset)?

Execute AutoOffset in setpre for X, Y, and Z.
X-Channel: Coarse Offset_________ (Fine) Offset___________ 
Y-Channel: Coarse Offset_________ (Fine) Offset___________ 
Z-Channel: Coarse Offset_________ (Fine) Offset___________

Can the loop parameters be adjusted for all (x, y, z) directions? 

X-Channel: Resistor _________ Capacitor___________ 
Y-Channel: Resistor _________ Capacitor___________ 
Z-Channel: Resistor _________ Capacitor___________
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19.2.5 ParaVision Tests

These tests indicate the communication between ParaVision and the imaging racks. It also
shows the stability of the gradient current (periodic errors) and the 50 Hz hum behavior of the
B0 compensation unit. A standard or already optimized setpre parameter file including safety
parameters is the precondition for this test. Be sure, that for the Master Unit BGMUI-E
W1522066 GRADRES ($PvHome/conf/instr/spect/uxnmr.par) must be set to 8.0.

Does a change of the preemphasis values in setpre change the integral 
of the FIDs in a preemphasis experiment (x, y, z)?

Does a change of the B0 values in setpre change the phase of the FIDs 
in a preemphasis experiment (x, y, z)?

Comments on this tests:

Description OK Not OK Not
Required

Does a GSP/GOP in ParaVision load the safety parameters?

Does ParaVision-Setpre (Spectrometer Control Tool→Tools→ Adjust 
Preemphasis Values) recognize Greats and B0?

Can the preemphasis values (x, y, z) and B0 be changed from ParaVi-
sion Setpre?

Does a “flash” sequence run without artefacts?

Does a “multi slice multi echo” sequence run without artefacts?

Duty Cycle Test on X (trained personal only!)?

Duty Cycle Test on Y (trained personal only!)?

Duty Cycle Test on Z (trained personal only!)?

Is the ‘FIELD’ current passed through the B0 compensation unit, inde-
pendent of whether the B0 is enabled or not?

Is the B0 field distortion strength with a frequency of 50 Hz less than 
0.15 Hz (WB shim system, or 0.75 Hz on a SB shim system) when the B0 
compensation unit is switched on?
Field modulation with 50 Hz: _______________________ Hz

Comments on this tests:
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19.2.6 Enhanced Resolution Tests

These tests only have to be performed on newer software and/or firmware version as the follow-
ing:

ParaVision, BGMUI-E Application Firmware: 20100419

Be sure, that for the Master Unit BGMUI-E W1522066 GRADRES in ($PvHome/conf/instr/spect/
uxnmr.par) must be set to 8.0.

Description OK Not OK Not
Required

Enhanced current resolution?

Amplitude Stability?

Comments on this tests:
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20 Velocity Imaging and Rheology in 
Material Science

20.1 Introduction

Velocity maps of simple or complex liquids, emulsions, suspensions and other mixtures in vari-
ous geometries provide valuable information about macroscopic and molecular properties of
materials in motion.

The hardware of the experiments for investigating the velocity distributions covers arrange-
ments, where tubes or hoses, a NMR rheology accessory, or containers with motor driven stir-
rers are mounted in the magnet.

2D and 3D spin echo velocity imaging methods are used, where two dimensions contain spatial
information and the third dimension, or the image intensity contains the information of the dis-
placement of the spins during an observation time ∆. This information is used to calculate the
velocity vectors and the dispersion at each position in 2D spatially resolved slices. The range of
observable velocities depends mainly on the time the spins stay in the RF-coil, the T2 relaxation
time and the available gradient strength.

The properties of the methods are explained and demonstrated in the workshop and some ap-
plications are shown and discussed.

20.2 Theory of Velocity Imaging

The presence of coherent motion, flow, in an MRI experiment leads to phase changes of the sig-
nal. These phase changes cause artefacts in the images, so they can be used to measure the
velocity of the flow.
Simple Gradient Echo Experiment Applied on a Volume Element in Tube Filled with Water

Figure 20.1: Simple Gradient Echo Experiment Applied on a Volume Element in Tube Filled with Water
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Let’s use a simple experiment, applying a pair of gradient pulses with opposite signs on the FID
of a tube filled with water, as shown in the figure above. The gradient direction is the same as
the long axis of the tube. If the water does not move, the net phase shift is zero.

In the formula above Φ1 stands for the phase shift during the first gradient pulse and Φ2 for the
phase shift during the second gradient pulse. The other parameters are used as usual, γ is the
gyromagnetic ratio, gz the gradient strength in z direction, z0 is the position of the volume of in-
terest, and δ stands for the gradient pulse length.

If the velocity vz is not equal to zero, there will be a change of the position of the volume of in-
terest during the evolution time ∆. For simplicity the motion during the gradient pulses is neglect-
ed, also diffusion effects are not taken into account. Similar treatment as in the static case now
leads to a non zero phase shift, proportional to the velocity, the gradient strength, the time be-
tween the gradient pulses, and the gradient pulse length.

Obviously this behavior allows us to measure the velocity. On the other hand, in a conventional
imaging experiment, this motion will lead to artefacts.

20.2.1 Generalized Approach

In a more generalized approach we have to look at the time evolution of the spin phase as a
function of the time dependent gradients and the time depended position of the spin.

A standard trick to simplify such a problem is to apply a Taylor expansion on the position vector:

This can be rewritten:

Assuming we have a constant flow we can simplify equation (3):

This way we get 2 terms, one describing the position, and the other describing the motion with
constant velocities. The time integrals over the gradient have been replaced by the so called
moments.
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M0 stands for the zero order gradient integral, i.e. the integral of the gradient itself. This is the

most important parameter for imaging: At the echo center M0 must be equal to zero, except for

the phase gradient. M0 in phase encoding must correspond to the required k-space position.

M1 stands for the first order gradient integral, i.e. the integral of the gradient times the time. Ac-

cording to equation (6) this is the relevant parameter for flow. For clean images in the presence
of flow, M1 must be equal to zero at the echo position. In order to get a well-defined flow depend-

ing phase shift M1 must be calculated accordingly.

To get undistorted images in the presence of flow one has to fulfil equation (7), except for the
phase gradient:

The moment calculations for different orthogonal gradient directions are independent from each
other. 

Coming back to the example at the beginning, we can see: In the static case the second com-
ponent of equation (6) vanishes, because v = 0. Comparing this to equation (1) leads to the con-
clusion, that in that experiment M0 = 0. 

In the case where v is not equal to zero, we can see, that M1 is not equal to 0, M1 = gzδ∆. M0

stays zero, because it is only a function of the gradient. In order to remove flow artefacts, we
have to modify the pulse sequence in order to fulfil equation (7) at the position of the echo.

20.2.2 Flow Compensation

In order to learn how to fulfil equation (7) we have to review the simple experiment shown in the
previous figure. In practice we often use spin echo experiments in this context, see the upper
part of the figure below. Because the 180 degree pulse reverses all phases, M0 is still equal to

zero.

At least one more gradient pulse is required to fulfil equation (7). Easier to handle is actually to
introduce a pair of additional gradients, of duration δc, with an amplitude of gc, and a distance

of ∆c, see the lower part of the figure below. Looking at the symmetry of the pulse sequence,

one can see directly, that M0 is equal to zero. The second condition can then be fulfilled by:

The example described here corresponds to the read gradient of a standard spin echo se-
quence. The other gradient directions are calculated similarly and will not be discussed in detail.
Z33075_00_001 201



Velocity Imaging and Rheology in Material Science
Spin Echo Experiment with Velocity Encoding and Flow Compensation Gradients

Figure 20.2: Spin Echo Experiment with Velocity Encoding and Flow Compensation Gradients

20.3 Velocity Imaging Modes

To measure the velocity we have to review equation (6). For a practical experiment there is one
term missing, there is an additional time constant but position dependent phase shift. This phase
shift is due to field inhomogeneity, susceptibility changes. In other words additional, usually un-
known field gradients. This phase shift is described in equation (9) as an additional Φ0.

There are two experimental ways to measure the velocity under such conditions:

▪ The first is to introduce an additional dimension to the experiment, incrementing the value
of M1. Fourier transform in this direction will directly give the velocity, independent of the oth-

er phase shifts. We call this mode “Fourier Flow Imaging”. The advantage of this mode is
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the feasibility to measure spatially resolved velocity distributions (propagators). The disad-
vantage is the relatively long acquisition time since the experiment dimensionality is the spa-
tial dimensionality + one dimension for flow.

In an “Fourier Flow Imaging” experiment there are 1 to 3 spatial dimensions, plus one veloc-
ity dimension. In order to measure the whole velocity, vector 3 experiments with the same
spatial parameters have to be performed. In the velocity direction the image shows the ve-
locity distribution within one pixel.

In many cases it is useful to derive a so called velocity map out of such a data-set (e.g. by
the macro mic_VelocityFromFourierflow). This is done by calculating the mean value of the
velocity for each pixel and assigning this value to the amplitude of the pixel, see equation
(10). The index i runs over all pixels in the velocity direction.

Having the velocity map, spatial derivatives needed for the shear rate, can be easily calcu-
lated, e.g. by the macro mic_CalcShearRates.

▪ The second way is to measure images, with different M1. The phase difference ∆Φ between

the images can then be used to calculate the average velocity:

This mode is called “Velocity Mapping”. In this mode only the velocity can be calculated,
but the experiment time is only defined by the spatial resolution and dimension. Additionally,
the Bruker sequences support Hadamard encoding, thus only 4 images have to be acquired
to calculate the flow in all 3 dimensions.

Velocity maps can be directly calculated in different directions. In order to get a 3D velocity
vector, 4 Hadamard encoded slices have to be acquired, from which the velocity can be cal-
culated from the phase differences:

IM stands for the imaginary, RE for the real components of the complex image. Depending
on the calculated phase differences and the encoding times, the velocity for each individual
pixel can be calculated.

20.4 Applications

A wide range of applications exists, where velocity distributions are investigated by NMR meth-
ods in material science and in process engineering. Common to these applications are the spe-
cial arrangements and construction of the samples or sample containers in the magnets. Liquids
or pastes are pumped through hoses and tubes in the probe inside the magnet, sometimes flow-
ing through filters or extruders, or they are filled into Couette and Cone & Plate cells for rheology
studies.
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Rheo Cell

Figure 20.3: Rheo Cell

20.4.1 Rheology

The combination of rheology and NMR spectroscopy exists since several years. But the combi-
nation of rheology and NMR imaging is relatively new. The most important advantage and the
unique feature of the combination with NMR imaging methods is the possibility to visualize spa-
tially resolved shear rates and spatially resolved strain distributions in the rheometer cells (Cou-
ette or Cone & Plate types). Therefore shear banding and material slipping along the cell walls
can be visualized, even in cases, where the samples are not optically transparent. These effects
are of significant importance for the correct interpretation of the rheology experiments.
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Cone & Plate Rheo Cell

Figure 20.4: Cone & Plate Rheo Cell

Maps of the Velocity and Rate of Strain Distribution on a Cone & Plate Cell with Shear Banding (lower right)

Figure 20.5: Maps of the Velocity and Rate of Strain Distribution on a Cone & Plate Cell with Shear Banding 
(lower right)

An introduction to rheology and nmr imaging is given in: 

“Rheo-NMR: a New Application for NMR Microscopy and NMR Spectroscopy“ from Paul T. Cal-
laghan and Elmar Fischer, Institute of Fundamental Sciences-Physics, Massey University,
Palmerston North, New Zealand

More information can be found in: 
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P. T. Callaghan, Rheo-NMR: Nuclear magnetic resonance and the rheology of complex fluids.
Reports on Progress in Physics 62, 599-670 (1999).

A lot of additional information can be found on the Internet. Some useful addresses include:

http://www.rheo-nmr.com

http://www.bruker-biospin.de/NMR/microimg/img_rheo.html

http://www.iop.org/EJ/abstract/0034-4885/62/4/003

20.4.2 Flow in Complex Geometries

The velocity distributions of simple and complex liquids in almost any type of geometries can be
studied by NMR imaging methods using the Rheo NMR accessory with small modifications. The
Couette cells, or Cone & Plate cells for rheology, have to be replaced by other cell types. Models

of dedicated cells or extruders of even very complicated structures1 can be connected to the
drive shaft of the Rheo motor. Examples that were tried recently are the study of the flow behav-
ior in a stirring design made from a liquid filled tube containing a paddle and from another tube

containing a propeller2. For such applications the data are acquired in a position triggered style
to get undisturbed images, because the paddle or propeller is continuously rotating while the ex-
periment is running.
Paddle for Rheo Cell and Vector Display of the 3D Velocity Field

Figure 20.6: Paddle for Rheo Cell and Vector Display of the 3D Velocity Field

1 S.Laukemper-Ostendorf, K.Rombach, P. Blümler and B. Blümich, RWTH Aachen, Germany,
Bruker Application Note NMR/1200/2/97/8-HA

2 Joachim Götz, University of Munich
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20.4.3 Mixing Processes and Chemical Reactions

The velocity distribution contains information about mixing and segregate properties in dedicat-
ed cells. The velocity vectors indicate, whether the constructions of the mixing cells are support-
ing a convenient transport of the material. The material should, for example, not undergo a
sedimentation process caused by gravitational forces. This means that the velocity distribution
must have significant components in the vertical direction within the entire mixing cell. Observ-
ing the spatially resolved velocity vectors may help to develop and optimize stirrer types for ma-
terials of different properties, e.g. viscosities, particle sizes and particle shapes.

In addition, it may be possible to study the temporal evolution of chemical/physical reactions of

mixing materials in process engineering, e. g. mash process or fermentation1.

Combining chemical shift selective imaging and spectroscopy (separation of different com-
pounds, OH, CH2, CH3, ...), multinuclear imaging and spectroscopy (1H, 23Na, 13C, 7Li, ...) or
T2 relaxation measurements (information about changed mobility of molecular groups due to
shear motion) with the velocity imaging method may give further insight into the mixing process-
es and reaction of materials.

1 Joachim Götz, University of Munich, private communication.

20.5 Methods

In this section, the method specific parameters for the two velocity measurement methods in
ParaVision 5.1 are described. The official method FLOWMAP, delivered with ParaVision 5.1 is
a gradient echo based sequence, where mic_seflow is a spin echo based sequence (derived
from FLOWMAP) which is available from the MicroImaging add-on CD (micdiff@bruker.de).

20.5.1 FLOWMAP

The official FLOWMAP method has the same parameter layout as all other Bruker sequences.
Therefore, only the special flow parameters will be described here. Also refer to the methods
manual in the Spectrometer Control Tool -> Help. The sequence is calculated in a way, that gra-
dients compensate each other, so there are no special timing parameters that define the maxi-
mum or minimum flow velocity. If the velocity constrains don’t fit the desired values, then the
echo time or the spectral bandwidth may need to be changed.
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FLOWMAP Velocity Parameter

Figure 20.7: FLOWMAP Velocity Parameter

The above figure shows the special parameters of the sequence FLOWMAP. Echo time and rep-
etition time are common to (almost) all sequences, so the first “special” parameter is the “Flow
Encoding Mode”. This mode can be “Phase Contrast Angiography”, ‘Velocity Mapping” or “Fou-
rier Flow Imaging” as described in the previous chapter. Phase Contrast Angiography doesn’t
deliver quantitative results; it only generates high image intensities in areas of high flow.

“Flow Encoding Direction”, “Flow Encoding Steps” and “No. of Flow Encoding Directions” are
related parameters. The flow encoding direction defines the direction, in which the velocity will
be measured (in RPS coordinates). It can be a single direction (Flow Encoding Steps = 2) or all
three directions in space (Flow Encoding Steps = 4).

The “Maximum Velocity (Venc)” defines the maximum detectable velocity in the object and
must be selected very carefully. If the value is too high, the resolution in flow direction is not op-
timal. If the value is too low (lower than the velocity in the object) the final data set will show
phase wraps which result in signal folding in the flow direction (Fourier Flow Imaging) or in steps
from positive to negative values (Velocity Mapping). The velocity is defined as absolute number,
e.g. a parameter value of 10 cm/sec. defines a range from -10cm/sec..+10 cm/sec.

“Min Venc” shows the minimal velocity that can be resolved.

“Twister Gradient” ###

During the post processing, all velocities in pixels with an intensity below a certain level will be
set to zero. This level can be set by “Signal Mask Threshold” in percentage of the maximum
pixel intensity.

Note: If you find the threshold to be misadjusted after the experiment clone reco, enter ‘Signal-
Mask’ in the “Single Parameter Window”, modify the value and select Reco.
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20.5.2 mic_seflow

The velocity parameter mic_seflow is based on the official FLOWMAP method, but it is a spin
echo sequence which is advantageous for inhomogeneous samples. Since it’s based on FLOW-
MAP, some parameters are identical, but it also has some additional parameters.
The mic_seflow Velocity Parameter

Figure 20.8: The mic_seflow Velocity Parameter

The “FlowEnc Grad Time (d)” and the “FlowEnc Grad Separation (D)” are the parameters δ and
∆ as shown in Flow Compensation [201]. They are independent parameters to adjust the min-
imal resolvable flow velocity. They will of course affect the echo time. The longer the δ or ∆, the
slower the velocity can be measured.

All the other parameters shown in the figure above are identical to the FLOWMAP parameters.

A new sub menu is the “Flow Compensation”. Since δ and ∆ can be set independently, there are
no constrains for other gradient amplitudes. Since the calculation of the flow compensation pa-
rameters is quite complicated, it cannot be guaranteed through the method, that no gradient am-
plitude exceeds 100%.

If a gradient amplitude exceeds 100%, it will generate an error at the experiment start. In this
case the “Flow Compensation” parameters need to be checked. If the gradient that exceeds
the 100% is identified, parameters like e.g. δ, ∆, or “Read FC Grad Time” need to be modified
to get all gradient amplitudes below 100%.
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The mic_seflow Flow Compensation Parameter

Figure 20.9: The mic_seflow Flow Compensation Parameter

20.6 Hands on: Rheology Experiments

This section explains the setup of a rheology study since it differs a bit from ‘typical’ micro-im-
aging experiments. For more details about the hardware and programming for the components
please refer to the dedicated Rheo manual.

The Rheo controller has a serial connection that is controlled by the spectrometer hardware. In
ParaVision 5 there is no possibility of defining the serial port during cf, so the Rheo controller
needs to be set up manually. To do so, create the file $PvHome/conf/instr/spect/rs232_device/
rheo as shown in the example below and set the correct values for host (IP address of the IPSO)
and device (selected TTY connection).

unit   = Rheo unit

host   = 149.236.99.250

device = /dev/tty05

type   = RS232

stty = 9600 time 5 cs8 cread clocal istrip

Example of the file $PvHome/conf/instr/spect/rs232_device/rheo

After ParaVision is restarted, the Rheo controller, and thus the speed of the Rheo motor can be
controlled by the macro ‘mic_rheo’ in ParaVision, or the command ‘rheo’ on the TopSpin com-
mand line.

Note: Take care that the magnetized spins do not leave the RF-coil before the magnetization
is acquired.

Note: Take care that the magnetized spins did not leave the excited slice before the refocusing
pulse is applied. It’s often a good idea to use a rectangular shaped 90 degree pulse and a
shaped (slice selective) refocusing pulse. 
210 Z33075_00_001



Velocity Imaging and Rheology in Material Science
20.6.1 Hardware and Setup

The Rheo kit consists of various parts, which can be divided into 2 groups:

▪ Drive group.

▪ Cell group.

The drive group consist of all parts which remain in/at the magnet during the complete rheo
experiment. 

The cell group consists of the different cell types, that have to be selected properly depending
on the desired sample and shear rate.
Cables, Motor, Gear Box, Drive Shaft and Interface

Figure 20.10: Cables, Motor, Gear Box, Drive Shaft and Interface
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Cells and Drive Adaptation

Figure 20.11: Cells and Drive Adaptation

The rheo drive hardware must first be mounted at the magnet. This will not be described in detail
here, refer to the rheo manual for detailed information.

When the modified shim upper part is mounted in the magnet, all rheo drive accessories can be
mounted from the top of the magnet.

Important: To mount the rheo drive hardware you must have a wide bore upper shim stack
with a short turbine, since the Micro 2.5 gradient system is longer than a standard wide bore
RF probe.
212 Z33075_00_001



Velocity Imaging and Rheology in Material Science
Rheo Drive Hardware, Fixed with 2 Screws (blue arrow) on Top of a Magnet

Figure 20.12: Rheo Drive Hardware, Fixed with 2 Screws (blue arrow) on Top of a Magnet
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20.6.2 Selection and Filling of the Rheo Cells

The rheo kit offers 2 different cell choices, Cone & Plate and the Couette cell.

There is no rule, as to which cell is the better one for a dedicated application. Basically, the de-
sired shear rate for the experiment has to be known in advance, and then the cell and the rota-
tion speed can be determined from that value. The table below shows some typical values for
the shear rates.
Typical Shear Rates (P. Callaghan, E. Fischer)

Figure 20.13: Typical Shear Rates (P. Callaghan, E. Fischer)

For small angles in the Cone & Plate cell, the shear rate γ can be calculated using 

Where ω is the rotation speed and α is the angle of the Cone & Plate. 

In the Couette cell, the shear rate can be calculated using:

Where r is the radius of the rotor cylinder and s is the gap between rotor and chamber.

If it turns out that the system requires a very low rotation speed, a gear box should be used. This
allows the motor to run at higher speed, since slow stepper motor speeds might introduce vibra-
tions to the sample.

It is very important to fill the cells without air bubbles. Unfortunately, there is no simple rule how
to do this. It’s easier with samples with low viscosity, but the higher the viscosity the higher the
chance of having air bubbles in the cells. During the imaging experiment, the bubbles will move
and create image artifacts.

After filling the cell, it has to be mounted to a 25 mm MicWB40 (Micro 2.5) resonator and (de-
pending how tight the cell already is) needs to be fixed by screws.
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Rheo Cell Mounted in a 25 mm MicWB40 Probe

Figure 20.14: Rheo Cell Mounted in a 25 mm MicWB40 Probe

When the probe is shifted into the magnet, it may happen that it cannot be shifted in to its stan-
dard position. The reason is that the horizontal carrier pin at the cell doesn’t slip into the gap of
the drive shaft. The probe has to be rotated until it can be moved to its standard position. Now
the probe can be fixed as usual.
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20.6.3 Imaging Experiments

For the first experiments, switch the rheo motor off. After tuning, setting the frequency, shimming
and detection of the auto reference gain, a gradient echo experiment with three orthogonal
planes should be acquired to check for the correct position, geometry and for air bubbles.
Three Orthogonal FLASH Planes Showing Air Bubble

Figure 20.15: Three Orthogonal FLASH Planes Showing Air Bubble

If the cell contains air bubbles, for example as shown in the figure above, the cell has to be taken
out of the magnet and refilled.
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Three Orthogonal FLASH Planes Without Bubbles

Figure 20.16: Three Orthogonal FLASH Planes Without Bubbles

Once all the preparation is finished, it is time to start with some real velocity experiments. One
should start with a standard FLOWMAP sequence. Since it’s based on a gradient echo se-
quence, it is a much faster experiment than a mic_seflow experiment that is based on spin echo.

A good starting point for the Cone & Plane experiments is the protocol FlowMap_ConePlate
from the rheo location in S040 (Micro 2.5). It defines one velocity map image in slice direction
with 4 averages. In Cone & Plate experiments we are interested in the velocity orthogonal to the
sagittal (or coronal) plane. If we look at the sagittal image (upper right) in the figure above, we
assume, that nothing is flowing from left to right and nothing is flowing from top to bottom. But
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we know, that the inner cylinder is rotation and the outer chamber is static. In an ideal Newtonian
fluid we would expect, that on the surface of the cylinder the fluid has the same velocity and flow
directions as the cylinder, and on the static chamber wall the velocity should be 0.

So the only flow direction we are interested in is the slice direction. In the two other directions
there should be no flow.
Typical FLOWMAP Data for a Cone & Plate Experiment

Figure 20.17: Typical FLOWMAP Data for a Cone & Plate Experiment

Since FLOWMAP is a pretty fast experiment, it is recommended to acquire a few averages to
improve the signal to noise ratio and to cancel remaining flow artefacts. There might still be
some remaining flow artefacts since we only compensate for the first momentum, the laminar
flow, but not for turbulent flow which we might have in the circular Cone & Plate cell.

As a result of the experiment, 2 images are obtained, one shows the velocity image, the other
should show the magnitude image. However, due to ParaVision 5 scaling problems, the magni-
tude image always appears with an incorrect scaling. This problem should be fixed in the next
ParaVision version.
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Velocity Data with Different Lockup Tables

Figure 20.18: Velocity Data with Different Lockup Tables

The figure above shows the result of the Cone & Plate FLOWMAP experiment. Both images
show the same data, the left one in standard black and white, the right in colour coded with the
lockup table mic_flow_black, showing high positive velocities in red, high negative velocities in
blue and no flow in black.

The velocity values can be checked by the Cross Hair Tool in the Image Display Tool of ParaVi-
sion, or the 2D image data can be exported as scaled ASCII file by the help of the macro
mic_convert_2dseq2csv_scale.

The shear rate of the acquired data can be calculated by the macro mic_CalcShearRates. It will
calculate the shear rate along x (left to right in the velocity image) and along y (top-bottom) and
store these data in new processing numbers.

It is often required, to adapt the image intensities of the shear rate data to a reasonable range.
This can be done in the Image Display Tool -> View -> Window Image Intensity. Set this to user
defined and enter a symmetrical interval e.g. -900 to +900 for the range.
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Shear Rate Data Along x (left) and y (right) with Different Image Intensities

Figure 20.19: Shear Rate Data Along x (left) and y (right) with Different Image Intensities

The setup of a fourier flow imaging experiment is identical to the previously described proce-
dure, the only difference is 1 additional parameter in the method GUI, which defines the number
of flow encoding steps in the flow dimension. The result of the experiment is a data set that con-
tains typically 2 spatial dimensions and additionally a flow dimension. The only post processing
offered for this type of data set currently is to calculate the velocity images, to get results like in
the previous Velocity Map FLOWMAP experiments. This calculation can be done by the macro
mic_VelocityFromFourierflow.

The mic_seflow experiments are similar, but are based on a spin echo sequence, which requires
longer acquisition time with the advantage, that it is less sensitive to sample and magnetic field
in homogeneities.

Note: Take care that the magnetized spins did not leave the excited slice (or even the sample)
before the refocusing pulse is applied. It’s often a good idea to use a rectangular shaped 90
degrees pulse and a shaped (slice selective) refocusing pulse.
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Manufacturer:

Bruker BioSpin NMR

am Silberstreifen

D-76287 Rheinstetten

Germany

Phone: +49 721-5161-0

http://www.bruker-biospin.com

NMR Hotlines

Contact our NMR service centers.

Bruker BioSpin NMR provide dedicated hotlines and service centers, so that our specialists can
respond as quickly as possible to all your service requests, applications questions, software or
technical needs.

Please select the NMR service center or hotline you wish to contact from our list available at: 

http://www.bruker-biospin.com/hotlines_nmr.html
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